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Lesson 1: Introduction

When you complete this lesson, you will be able to:
O Describe the relationship between Parts, Assemblies and Drawings.
Q Identify the principal components of the SolidWorks user interface.

0 Download and extract the required companion files.

SolidWorks SAE Design and Analysis Project 1



Lesson 1: Introduction

Using This Book

The SAE Design and Analysis Project with SolidWorks Software
helps you learn the principles of assembly design and structural analysis using SolidWorks
and SolidWorks Simulation as an integral part of a creative and iterative design process.

For this project, you will “learn by doing” as you complete modeling and structural
analysis lessons.

What is SolidWorks Software?

SolidWorks is design automation software. In SolidWorks, you sketch ideas and
experiment with different designs to create 3D models using the easy to learn Windows®
graphical user interface.

SolidWorks is used by students, designers, engineers and other professionals to produce
single and complex parts, assemblies and drawings.

Prerequisites

Before you begin the SAE Design and Analysis Project with
SolidWorks Software you should complete the following tutorials that are
integrated in the SolidWorks software:

O Lesson 1 - Parts
0 Lesson 2 - Assemblies
QO Lesson 3 - Drawings

You can access the tutorials by clicking Help, SolidWorks Tutorials. The tutorial resizes
the SolidWorks window and runs beside it.

As an alternative, you can complete the following lessons from CAD Student Guide:
Q Lesson 1: Using the Interface

O Lesson 2: Basic Functionality

Q Lesson 3: The 40-Minute Running Start

O Lesson 4: Assembly Basics

QO Lesson 6: Drawing Basics

2 SolidWorks SAE Design and Analysis Project



Lesson 1: Introduction

Conventions Used in This Book

This manual uses the following typographical conventions:

Convention Meaning

Bold Arial SolidWorks commands and options appear in this style.
For example, Insert, Boss means choose the Boss
option from the Insert menu.

Courier Feature names and file names appear in this style. For
New example, Sketchl.

17 Do this The steps in the lessons are numbered in Bold Arial.
step.

Before You Begin

If you have not done so already, copy the companion files for the lessons onto your
computer before you begin this project.

1 Start SolidWorks.
Using the Start menu, start the SolidWorks application.
2 SolidWorks resources.
Click the SolidWorks Resources tab 4 and click Student Curriculumai.

« SOLIDWORKS Resources =

»

Getting Started Ea
D Mew Document

I,E Open a Document

ﬁ Online Training

@jé What's New

@ Introducing SOLIDWORKS

Jep|

ET

£y
\ 1) General Informaticn

Sre

SOLIDWORKS Curriculum La
ﬁTLtorials
ﬁ[?m Student Curriculum

2
@j Instructors Curriculum

m
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Lesson 1: Introduction

3 SOlidWOI'kS Contel’lt. & Design Library =
Expand the SolidWorks Educator Curriculum | © ruw LY
fOldeI‘. ﬁ > ? Toolbox -
X @ 5 @ 3D ContentCentral
Expand the proper Curriculum <year> folder. 7] « & SOUDWORKS Content
. . . . . Blocks
Click Design Library @ to open the design library g Robotics
task pane. . [ Routing
. — 4 @ SOLIDWORKS Educator Curriculum
Click the SAE Car Design Project folder. = , [ Curriculum 2012
The lower pane will display an icon representing a i g S -
Zip file that contains the companion files for this 4 [ Curiculum 2015

b Bridge Design Project

@ CAD Tutorials for Electrical Engin
@ C02 Car Design Project

b Detailed Drawing Exercises

B Hands On Test Drives

b Mountainbeard Design Project
B Race Car Project

@ Robotics Projects

@ SAE Car Project

@ Simulation Student Guides

@ SOLIDWORKS Student Guide
@ SOLIDWORKS Tutorials Technolo
r:; Sustainability Projects -

] T b

project.

-

il
SAE Car
Project
4 Download the Zip file.
Press Ctrl and click the icon. NSRS (sl
. . . Please select a folder to download the ZIP file ko
You will be prompted for a folder in which to save the
le file. | SOLIDWYORKS Data (3) -
. * . SOLIDWYORKS Data (4)
Ask your teacher where you should save the Zip file. | SOLIDWORKS Data (5
Usually the C: \Temp folder is a good location. ' SOLIDWORKS Data (6)
4 [ temp (]
Click OK. L FLasH
. tmp E
. Users
s Windows =2
Tip: Remember where you saved it. ‘ :
Folder: temp
h . f’l { Make Mew Folder ] [ QK ] l Cancel
5 Open the Zip file.

Browse to the folder where you saved the Zip file in step 4.
Double-click the SAE Project Files.zipfile.
6 Click Extract. Extract

Click Extract and Browse to the location where you want to save the files. The system
will automatically create a folder named SAE Project ENG in the location you
specify. For example, you might want to save it in My Documents. Check with your
teacher about where to save the files.

You now have a folder named SAE Project Files on your disk. The data in this
folder will be used in the exercises.

4 SolidWorks SAE Design and Analysis Project



Lesson 1: Introduction

Tip: Remember where you saved it.

Analyzing a Structure Using SolidWorks and SolidWorks Simulation

During this session, you will learn how to analyze a structure using SolidWorks and
SolidWorks Simulation.

Once you have had a chance to see how easy it is to use SolidWorks solid modeling
software, you will use an assembly to check whether components fit properly.

SolidWorks SAE Design and Analysis Project 5
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Lesson 2: Using Assemblies

When you complete this lesson, you will be able to:

O Understand the difference between edit assembly and edit part modes.
Q Create a virtual, in-context part.

O Open a part from the assembly.

O Create a new instance from an existing instance.

O Set the materials in a part.

O Use pack and go to manage the files.

SolidWorks SAE Design and Analysis Project 7



Lesson 2: Using Assemblies

Creating Parts In-Context

A thorough knowledge of how to work with assemblies is
critical to success with SolidWorks.

In this example, you will create a virtual part and use in-
context techniques to model a brake pad using geometry from
both the Rotor - Cast IronandBrake Caliper
components.

The component will copied to create a second instance and it
will be mated into the assembly.

Opening an Assembly with Quick View
Clicking the Quick view / Selective open when you open an assembly allows you to
view only the components that you want to view.
1 Open Brake&Wheel.

Click File, Open and select the assembly Brake&Wheel from the Lesson
2\Brake&Wheel folder. Select Mode: Large Design Review and click Open.
Click OK on the Large Design Review page.

£ Open B3
e L « SAE » Lessond » BrakeliWheel - |+ Segreh BrakediWhes! p'
i 5
Organize « MNew folder = ~ [ '393'
't Favorites Documents library ) i
_ Arrange by:  Folder ~
Bl Desktop Brake8:Wheel
& Downloads
= Recent Places % s
6, ®_ ©_ ¢
=l Libraries = w m - w w
3 Docurments Brake Rotor Brake&\Wheel SL Huhb Upright
B bolusi Assembly SLDAS DASh Assembly SLDAS Assernbly -
@ Music M M Mirrar.SLDASM
= Pictures
B videos @
M) L5 CORA-SWK S v
&L, WINDOWS (Ct) Wheel
= ; Bssernbly.SLDAS
-0 DWD RMY Drive (D ¥

Quick Filter:

File name: Brake&theel SLDASK - |Assemb|y(“'.asm;*.s|dasm) v|

Open - Cancel
|

Note: Atthe message: Graphics data might be out of date for the
flagged components because these components reference
inactive configurations, click OK.

8 SolidWorks SAE Design and Analysis Project



Lesson 2: Using Assemblies

Hiding and Showing Components

Components can be hidden or shown at any time to create an uncluttered display and make
working on the assembly faster.

In addition, components that are hidden before opening the assembly are not loaded into
memory, further decreasing the load on the machine.

Tip: The Quick view / Selective open settings are stored in a Display State.

There are many ways to hide and show components. Here are a few useful methods and
where they are best used.

Hiding Components

Showing Components

Many
Components

Hide Others- Hides all
visible components but the
selected component(s).

Show Hidden
Components-

Shows all the hidden
components for selection.

Single or Few
Components

Hide/Show Components-
Hides the selected visible
components.

Hide/Show Components-
Shows the selected hidden
components.

2 Orientation.

The assembly opens in an Isometric orientation. Click in the graphics area and
press Shift+Arrow Up to change the view orientation.

Where to Find It
a Shortcut Menu: Right-click a component and click Hide Others

3 Hide others.
Right-click the Rotor - Cast Iron and select Hide Others.

SolidWorks SAE Design and Analysis Project 9



Lesson 2: Using Assemblies

Where to Find It
0 Shortcut Menu: Right-click and click Show Hidden Components &

4 Show hidden. Show Hidden =)
Right-click in the graphics area and select Show Hidden [t showsHiaden]
Components. Click the Brake Caliper component as shown. [l show Hidden Envelopes

Click Exit Show-Hidden to complete the command.

Where to Find It e
Selective
Open
0 CommandManager: Large Design Review > Selective Open . > Selective
Open *=
5 Selective open. Slectve Open
Click Selective Open *=. Components to
. . . -:- Selected components _
Click All components displayed and click Open. © &l components displayed

[using display states and showyhide tools)

These are the only components that we need to
view right now.

6 Message.

A message appears.
Because you used “Selective Open”, hidden components are not
loaded into memory. Therefore, when you first show a hidden
component you might notice a delay while it is loaded. Also,

a new Display State is created corresponding to the
“Selective Open” state. Click OK.

10 SolidWorks SAE Design and Analysis Project



Lesson 2: Using Assemblies

7 Display state. @ B R[S
The changes are stored in the original display state Configurations
. ~ @ Brake&Wheel Configuration(s)
Default Display State-1.

[f® & Default [ Brake&Wheel |

Display States (linked)
° Default_Display State-1

8 Save.
Click File, Save [ to save the assembly and parts.

9 Orientation changes.

Orientation =]
Press the Spacebar and click the orientation LY ER @ -
Isometric from the dialog. Middle t @[
(wheel)+click and drag the edge of the Rotor 0 @0 @ Tomettic (Cte?)
- Cast Iron asshown to rotate the &
geometry. O80H8

Rotates and zooms the model
o the isometric view
orientation,

10 Zoom.

Click the Brake Caliper componentinthe
FeatureManager design tree and click Zoom to
Selection #.

SolidWorks SAE Design and Analysis Project 1"



Lesson 2: Using Assemblies

The Assembly FeatureManager design tree

The assembly is comprised of components and mates. The components can be either part
components or assembly components (sub-assemblies). The assembly FeatureManager
design tree shows an accurate snapshot of the assembly using icons and text to describe
the current settings.

Sub-assembly_/

Component

Part

Component

Mates

Folder\

Where to Find It

(8 Brakeaheel (Default<Default Display State-1)

4 History

4 Annutatiuns
@ Sensors
\ Front Plane
\ Top Plane
\ Right Plane

L Origin

Hidden Sub-assembly
Component

v N @ 7 Upright Assembly - Mirror<3> (Defautt<Di
» N @ () Hub Assembly<1> (Default<Default Displ
« (@B () Broke Rotor Assembiy <1 (Defoult<Defau

Mates in Brake®Wheel
History
Annotations
@ Sensors

\ Front Plane
\ Top Plane
N Right Plane
L, QOrigin
N

71> (Default<<Default>_Dis

H|dden_/' @ 78 Rofor- Castlion<1> (Default< <Defaultz

N () Rotor Washer<L> (Defey

Part Component

Component
Instance

Ult=_Dis|

Ny B (-) Rotor Washer<27> (Chamfer< <Cham

4 @@ Mates

4 B,[; LocalCirPattern]

- @@ Mates

A o

N B () Rotor Pin<6 (5¢<.5> Display State 1

Mate

v N @ () Wheel Assembly<1> (Default<Default Dis
v @ B () Brake Caliper<L> (Default< <Default> Disy
4 %Evakeﬂadd» > (Default< <Default>_Display Stat

@ Concentric3 (Upright Assembly - Mirror<3> }
ST

&

Performance
Evaluation

0 CommandManager: Evaluate > Performance Evaluation

O Menu: Tools, Evaluate, Performance Evaluation

11 Performance Evaluation.

Click Performance Evaluation & . The dialog lists the number of parts, unique parts,
sub-assemblies and unique sub-assemblies among other things.

Click OK.

12

B Performance Evaluation - Brake8Mheel SLDASM ==
(@ Tetal Of Com In B 48 m
Parts: 44
Unigue Part Documents: 17
Unigue Parts: 16
Subassemblies: 4
Unigue Subassemblies: 4
Unique Subassembly Documents: 4
Maximum Depth: 2
Number Of Top Level Components: 7
Resolved Companents: 48
Resolved Documents: 21
Lightweight Components: o
Suppressed Components: o =
Hidden Components: 29
Virtual Components: o
Envelope Components o
Number Of Bodies: 44
Mumber Of Total Evaluated Mates: 15
Top Level Mates: 15
Flexible Subassembly Mates: ] -
Copytociipboard | [ close | [ Hem
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Lesson 2: Using Assemblies

Working In-Context

Working in-context means editing a component (part or assembly) while in the context of
the assembly. The mode is toggled between Edit Assembly and Edit Part.

Edit Assembly Mode vs. Edit Part Mode

When an assembly is opened, it opens in the default Edit Assembly mode. To create or
edit a component part in-context, Edit Part is used. You can toggle back and forth between
the modes using Edit Component ‘#.

_

Edit Assembly Edit Part

Tip: Colors are used to indicate which mode is currently active. See "Why do the Colors
Change?" on page 16 for more information.

Below is a breakdown of some common actions that are typically performed in each

mode:
Edit Assembly Mode Edit Part Mode
Adding new components Creating new sketches
Inserting mates Creating sketch geometry
Moving components Creating bosses or cut features

In-Context Parts and Virtual Parts

In-Context Parts are parts that are created or edited in the context of the assembly. In-
context part names appear in the FeatureManager design tree appended with an arrow
(In-Context->).

Virtual Parts are in-context parts that are saved within the assembly rather than as
separate part files. Parts can be both in-context and virtual. Virtual part names appear in
the FeatureManager design tree in square brackets [Virtual Part”Test].

Why use In-Context and Virtual Parts?

In-context parts reference other parts in the assembly and change automatically when the
references change.

Virtual parts are more flexible because they can be renamed, deleted or saved as external
(part) files at any time.

Tip: If there are no references, do not create the part in-context.

SolidWorks SAE Design and Analysis Project 13



Lesson 2: Using Assemblies

Setup for Using Edit Part

There are settings under system options that can be used to determine how assemblies and
virtual parts behave in Edit Part mode.

Where to Find It
0 CommandManager: Assembly > Edit Component ®

a Shortcut Menu: Right-click a component and click Edit Part @
12 Virtual part setting.

Click Tools, Options, System Options, Assemblies and clecar Save new
components to external files.

Do not click OK yet.
13 In-context appearance setting.

Click Display/Selection and select Opaque Assembly from the pulldown menu under
Assembly transparency for in context edit.

Do not click OK yet.
14 In-context part setting.

Click Colors and click Use specified color when editing parts in assemblies. That
color is listed under the Assembly, Edit Part setting.

Click OK.

Creating a New Part

Creating an in-context new part requires a few
selections including a planar face or plane for use
as a sketch plane.

The selected face or plane will establish the
orientation and position of the Front plane of
the new virtual part. This in turn defines the
orientations of the Top and Right planes.

Where to Find It

0 CommandManager: Assembly > Insert
Components ¥, New Part ©

O Menu: Insert, Component, New Part

14 SolidWorks SAE Design and Analysis Project



Lesson 2: Using Assemblies

15 New part.
Click New Part © and select the face of the Brake Caliper as shown.

SolidWorks SAE Design and Analysis Project 15
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Edit Part Mode

Edit Part Mode is the opposite toggle of Edit Assembly Mode and allows the use of
sketch and feature tools within the assembly. It is triggered by adding a new part
component or editing an existing part in the assembly.

Editing Assembly  ~<@—]|  Editing Part

Why do the Colors Change?

Due to the settings made ("Setup for Using Edit Part" on page 14), the appearance of all
the parts remains opaque. The part being edited will appear in the Assembly, Edit Part
color and all others appear in the Assembly, Non-Edit Parts color.

Controlling the Display

The display includes the visibility and colors of the components in the assembly.
Controlling the display is the first step in managing the assembly itself, and the Display
Pane is one of the best tools.

Display Pane
The Display Pane is a portion of the FeatureManager design tree that has N@PSs
visual controls and is usually hidden. The columns show the current state of
Hide/Show, Display Mode, Appearance and Transparency and allow you
to change them. The options are described below. 200>
T OO
O Hide/Show - Toggles between Hide Component and Show Component. %é’ § §
~ - O
O Display Mode - Sets the display to Wireframe, Hidden Lines Visible, %E‘g 2
Hidden Lines Removed, Shaded With Edges, Shaded, or Default T %& S
o<E

Display.

O Appearance - Sets the appearance of the component. The lower triangle represents the
part appearance while the upper triangle represents the component (assembly level)
appearance.

O Transparency - Toggles Transparency on and off.
Note: The display pane works independently of the mode.
Where to Find It

a Display Pane: Hide/Show & in the component row
Note: Click Hide Display Pane < to close the display pane.
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16 Display pane. C[EB[¢[@] <8ds
Click Show Display Pane > to expand the display T

@ ’ BrakeBWheel (Default<Default Displ *
plane and change the appearance of components. [ Histoy

Annotations

Expand the Brake Rotor Assembly folder. Click -

the Rotor - Cast Iron component in the Hide/ %::“
op Plane
Show column as shown to hide it. N R\g:tP\ane
L Origin
S @ (1) Upright Assembly - Mirror<3>
@ ’ (-) Hub Assembly<1> (Default<D
A @ ’ (-) Brake Rotor Assembly<1> (De
4 Mates in Brake8Wheel
History
4 Annotations
@ Sensors
Iﬂ Front Plane
m Top Plane
m Right Plane
I_. Origin
N ’ (f) Rotor Hat<1> (Default<<
N r Rotor - CastIron<1» (Defaull
N (-) Rotor Washer<1> (Default<<C
Ny 7 () Rotor Washer<27> (Charr
N # () Rotor Pin<h> (5<<.5> Di
4 m]@ Mates T
4 EE LocalCirPatternl
b @ ’ (-) Wheel Assembly<1> (Default: |\ '
v @Gy JF () Brake Caliper<l> (Default<<D A

BsE BAHE
aaa

m

BEEZBE BEH
gEaa
BN N

Where to Find It mﬁr?m

Entities

0 CommandManager: Sketch > Convert Entities -

O Menu: Tools, Sketch Tools, Convert Entities
17 Convert entities.
Select the face and click Convert Entities ©.

Tip: If you see small green icons on the geometry of the sketch, you are seeing sketch relations.
Click View, Hide/Show, Sketch Relations to shut off their display.
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18 Delete.

Delete three entities to open the end of the
sketch.

Note: There is one large arc and two small ones connected to it. Only one small arc is
shown here.

19 Convert edge.

Click Show Display Pane > and show the Rotor - Cast Iron component.
Select the edge of the Rotor - Cast Iron component and click
Convert Entities ©.
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Where to Find It
0 CommandManager: Sketch > Sketch Fillet

O Menu: Tools, Sketch Tools, Fillet
20 Sketch fillets. B @
Click Fillet ™, set the Fillet Radius to 2.5mm, and select the v x

first set of geometry by selecting the geometry inside of where  yesage ~
they Would intersect_ Select a sketch wertex or entities to fillet,
Entities to Fillet Ea

Fillet Parameters Ca

K 2.50mm =

Keep constrained corners

Dimension each fillet

Repeat the selections for the similar geometry on the opposite side. Click + twice.
21 View normal to.

Right-click the sketch in the FeatureManager and
click View Normal To & and zoom in as shown.

22 Delete.

Box select from upper left to lower right as
shown to select the three entities.

Delete the three selected entities.
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23 Drag endpoints.

Drag the endpoint of the vertical line outside the
geometry as shown. !

Repeat for the other vertical line and stop where
the endpoints are horizontal.

24 Tangent Arc.
Click Tools, Sketch Entities, Tangent Arc ) and m (3 IE i

[ o
create the arc between the two endpoints as shown. {
+ O +
25 Drag and drop.
Drag the centerpoint of the arc to the edge of the B
circular edge. Drop it on the centerpoint that
appears.

26 Previous view.

Click Previous View ¢ to go back to previous views and zoom states. Return to the
zoomed isometric view.
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Where to Find It

0 CommandManager: Features> Extruded Boss/Base

O Menu: Insert, Boss/Base, Extrude @]

27 Extrude.

@)

Extruded
Boss/Base

Click Extruded Boss/Base ) and set the Depth to 3mm.
Click .

Understanding the Color Coding

Lesson 2: Using Assemblies

() Boss-Extrude @)

v X ™

From ~
[sketch Piane -

Direction 1 ~

[Biind -

g |

2 [3.00mm =

|| =

|:| Drraft oubward

The part turns blue when the extrusion is completed. The reason was explained earlier
("Why do the Colors Change?" on page 16) but until there is a solid body, it is difficult to
notice. This is the Assembly, Edit Part color and it appears in both the graphics and in the

FeatureManager design tree.

(B #F BrakeB\Wheel (Default<Default_Display 5t =

3

3

-

SolidWorks SAE Design and Analysis Project

History
Annctations
@ Sensors

‘ﬁ Front Plane
‘ﬁ Top Plane
W Right Plane

I_. Origin

N (f) Upright Assembly - Mirrar<3> (Default

N () Hub Assembly<1> (Default)

(® @ (-) Brake Rotor Assembly<1> (Default

@ (-) Wheel Assembly<1> (Default)

€& F (7) Brake Caliper<1> (Default<<Defau|
& §" [ Partl “Brakef&Wheel ]<2> -> (Defau

L3 Mates in Brake&Wheel
3 History

Sensors
4 Annotations

b
25 Material <not specified>

™ Front Plane
m Top Plane
m Right Plane
I_. Qrigin

L3 ﬁ Boss-Extrudel ->
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28 New sketch.
Select the face and click Sketch =

29 Convert entities.
Select the edge and click Convert Entities ©.

Where to Find It
0 CommandManager: Sketch > Offset Entities ©

O Menu: Tools, Sketch Tools, Offset Entities
30 Offset entities.

[T offset Entities @)

Hide the Rotor - Cast Iron component. Click Offset v x

Entities & and set the Offset Distance to 2mm. Select the  roometess ~
edge, click Reverse and click . £y 200mm e
Repeat the procedure for the opposite side. e dmenions

Select chain
[T Bi-directional
I:‘Cap ends

@ Arcs

Lines
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31 Convert.

Show the Rotor - Cast Iron
component. Select the edge as shown and click
Convert Entities ©@. Click v.

32 Drag.

Drag the open endpoints out beyond the
converted edge.

33 Trim.
Click Trim Entities 2z, Power trim §E.

Click+Drag across the sections of geometry
using the paths shown to trim away excess
geometry.
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34 Sketch fillets.

Add sketch fillets Radius 1mm in four places
as shown.

Tip: If corners are trimmed to a single endpoint,
select the endpoint to add the fillet.

Extrusions In-Context

Extrusions can also be created in-context when external features are
referenced. In this example, the depth of an extrusion is measured as
an offset from an existing face.

35 Extrude. & Boss-Extrue @

Click Extrude @ and set the End Condition to Offset from + x ®
Surface. Set the Offset Distance to 1.5mm. Click in Face/ ... @
Plane field. [sketch Piane -

Direction 1 Ca

[Offset Fram Surface v]
"1
¢ N |
£y [Lsomm =

Rewerse offset

[T Translate surface
Merge result

= =

|:| Drraft oubward
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36 Select other.

Right-click the face as shown and select Select Other. Click the top selection,
Face@Extrudel@[Brake Rotor Assembly<l>/Rotor - Cast
Iron<l>].

Tip: The top selection at the cursor is not listed. Why? It is assumed that if you wanted to select
that face you would have selected it directly.

37 Offset distance.
Check the direction and click + .
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Edit Assembly Mode

Edit Assembly Mode is the opposite toggle of Edit Part Mode and is the default state of
the assembly where you can add components and mates. It is triggered by exiting the
editing of a part in the assembly or opening of an assembly file.

Editing Assembly  ~<@—]|  Editing Part

1 Edit assembly.

Click Edit Component @ or the confirmation corner &, to edit the assembly. This
returns you to edit assembly mode and all the colors return to their original settings.

Working with Virtual Parts
The virtual part has been stored inside the assembly since it was created. Now that it is
nearly complete, we will save it externally and make it a real part.
Renaming a Virtual Part

2 Rename.
Right-click the [Part1”Brakes&Wheel] component and select Rename Part.
Type the name Brake Pad.

Tip: Although the part has been renamed, it remains a virtual part.

Saving a Virtual Part as an External Part

The virtual part requires a location on disk to store the new * . sldprt file.

3 Save as external file.

Save Az |E|
nght_CIiCk the part and SeleCt save Part Select one or more paths below and specify the location using buttons
(in External File). The file Brake :
. File Mame E] Path
Pad . Sldprt 1S added tO the assembly %Brake Pad ChUsersycgrdDocumentsSAE Les...
folder.
Click Same As Assembly and OK.
4 1 +
[ Same As Assembly ] [ Specify Path ] [InternalToAssemny]
o) (o]
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Tip: The part name appears without the square brackets.

Adding Component Instances and Mating

Components can be added to the assembly in several ways. If there is already an instance
of that component in the assembly, additional instances can be added using control+drag

and drop.
4 Copy an instance.

Click and Control+drag the Brake Pad<1> component. Drop the component
outside the Brake Caliper as shown.

5 Hide component.
Click the Rotor - Cast Iron component and click Hide Components x.
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6 First mate.

Press Shift+Up Arrow key. Click Insert, Mate § and select the faces as shown. Click
Coincident x and Anti-Aligned %%. Click ~ .

7 Second mate.

8 Press the Down Arrow key. Select the faces as shown, click Coincident A and click
v

9 Third mate.

Hide the Brake Caliper component. Select the faces
as shown, click Coincident A and click ~ .
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10 Show.

Show the Brake Caliper component.

11 Save.
Click File, Save [g to save the assembly and parts.

Viewing the Mates of a Component
The mates used to constrain a component can be listed and viewed using View Mates. It is

a useful tool in understanding how components are used in the assembly.

Note: The arrow symbol « indicates a path to ground. Mates marked like this are the
ones that hold the component in place.

Where to Find It
QO Shortcut Menu: Right-click a component and click View Mates &

12 View mates.
Click the Brake Pad<2> and View Mates §.

M
[ AL & coincidentd (Brake Caliper<1>,Brake Pad<2>)|

A, & Coincidentl0 (Erake Caliper<1> Brake Pad<2>)

A & Coincidentl1 (Brake Pad<1> Brake Pad<2>)

Note: Click the “x” to close the dialog.
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In-Context Part Editing

Any component part can be edited in the assembly whether it was created in the context of
the assembly or not. Toggling back to edit part mode uses the same command; Edit Part.

13 Edit part.
Click Brake Pad<1> and Edit Part ®.
14 New sketch.

Click the face and click Sketch {Z. A new sketch has been created on the face.

15 Convert edge.

Click the circular edge and click Convert Entities .
Click .

Exit the sketch.
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Opening a Part from an Assembly

In this example, we will create a slot to match up with the hole in the
Brake Pad component. The slot will be constructed from an existing
hole and makes for easier fit up.

1 Open Brake Pad.

Click on the Brake Pad<2> in the FeatureManager design tree and select Open
Part 2.

2 Edit a sketch.

Right-click on Sketch3-> in the FeatureManager design
tree and select Edit Sketch .

3 Construction.

Click the circle and click For construction to make it dashed.

Where to Find It
0 CommandManager: Sketch > Straight Slot @|-|, Centerpoint Straight Slot @

O Menu: Tools, Sketch Entities, Centerpoint Straight Slot
4 Slot.

Click Tools, Sketch Entities, Centerpoint Straight Slot @ and place the cursor at the
center of the circle. Drag the cursor horizontally and click to create the centerline. Drag
vertically and click to create the height. Click « .

5 Relations.

Click the circle and a horizontal line of the
slot. Add a Tangent o relation.
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6 Dimension and cut.

Add a 2mm dimension as shown to fully define the sketch.
Create an Extruded Cut ©@ with Through All end condition.

Multi-body Materials

In order to have different materials in the same part there must be multiple solid bodies
(multi-bodies) within that part.

This part is currently made up of three features; two bosses and one cut feature. They are
listed in their order of creation. There is just one solid body because by default new boss
features are merged to the current body. The part will be edited to create multi-bodies.

Boss-Extrude1-> Boss-Extrude2-> Cut-Extrude1->

Reordering Features

Features can be reordered in the Feature Manager design tree using drag and drop. The
rule to remember is that you cannot reorder a child feature before the parent feature. So
how can you determine the parent/child relationships?

Parent/Child Relationships

The Parent/Child tool is used to determine the parents and children of any feature. In this
case it will be used to determine the limits of where a feature can be reordered.

7 Parent/child. BT, Parent/Child Relationships =
Right-click the Cut-Extrudel feature and select | [ 5 w1 (8 o -
Parent/Child. The dialog tells you that the Bos s~ % e

Extrudel and Sketch3 features are the parents of
the selected feature. This also means that the Boss—
Extrude?2 feature is not. This means that the child Ll ——
can be moved to a position between the boss features.
Click Close.

Note: The Sketch3 feature is embedded in the Cut-Extrudel feature.
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8 Reorder.

Drag the Cut-Extrudel feature and drop it on the Boss-Extrudel feature. This
places it between the boss features.

i Brake Pad (Default<<Default i Brake Pad (Default<<Default>_Dis @ Brake Pad (Default<<Default> [
()

4 History 4 History L3 History
Sensors Sensors Sensors

' Annctations 4 Annotations L3 Annotations
‘D’E Material <not specified> 25 Material <not specified> 85 Material <not specified>
\ Front Plane \ Front Plane \ Front Plane
\ Top Plane \ Top Plane \ Top Plane
\ Right Plane \ Right Plane \ Right Plane
L Origin L Origin I_, Origin

4 @E Boss-Extrudel -» 4 @D Boss-Extrudel %ﬂ’ 4 ﬁﬂ Boss-Extrudel ->

v ] Boss-Extrude2 -> » ] Boss-Extrude2 -> b [ Cut-Edrudel -

» (@ Cut-Btrudel -» v (@ cut-Brdet > v ] Boss-Extrude2 >

9 Folder. %) 9 Brake Pad (Default<<Default:

Click the first feature Boss-Extrudel, Control+right-click the ’ Sw

second feature Cut-Extrudel and select Add to New Folder. + [2) Annotations

o—
25 Material <not specified>

Name the folder Backing. X Front Plane

10 Edit feature.
Click Boss-Extrude?2 and Edit Feature & . Clear Merge result ;’ig
and click v . There are now two solid bodies named Cut - > ) Boss Etrudel >
Extrudel and Boss-Extrude?. Rename them to Plate and e

4 @ﬂ Boss-Extrude2 -»
Pad as shown.

(@) 1 Brake Pad (Defoult<<Default> 5 J& Brake Pad (Defautt< <Default>

3 Histary 4 Histery
Sensors Sensors
L3 Annctations L4 Annotations
~ [@) Solid Bodies(2) ~ [@) Solid Bodies(2)
D) Cut-Bdrudel D Plate
() Boss-Extrude2 Q) pad
855 Material <not specified> 355 Material <not specified>
\ Front Plane \, Front Plane
\ Top Plane \I Top Plane
\ Right Plane \I Right Plane
I_._ Origin L Origin
» Backing 3 Backing
» @) Boss-Bxtrude? - » ] Boss-Bxtrude2 ->

Tip: The default names were taken from the last feature that was applied to the body.

Materials

Materials can be added to the entire part or to selected solid bodies within the part. In this
case we will take advantage of the multi-body format to assign different materials to each

body.
Where to Find It

a Shortcut Menu: Right-click a component or body and click Edit Material.
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11 Material for the Plate.

Right-click P1ate from the body folder in the FeatureManager
and select Material, Edit Material. Under Steel, select 1023
Carbon Steel Sheet (SS). Click Apply and Close.

12 Material for the pad body.

Right-click Pad from the body folder in the FeatureManager
and select Material, Edit Material. Under Other Non-metals,
select Ceramic Porelain. Click Apply and Close.
Note: Custom materials and custom material libraries can be
created.

13 Open assembly.

Press Control+Tab and move the cursor to the assembly.

Erake Pad.sldprt* Erakeftiheel SLDA,,

Show in Falder

This message appears:
Models contained within the assembly have changed. Would you
like to rebuild the assembly now? Click Yes.
14 Edit assembly.

Click Edit Component ‘. Hide the Brake Caliper and
Rotor - Cast Iron components.

15 Display state.

16 Create a new display state and rename to ALL. Right-click in the graphics area
and click Show Hidden Components. Window-select all the components and click
Exit Show Hidden.
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Pack and Go

Pack and Go is utility that can be used to copy all files used by the assembly into a new
folder or zip file, consolidating the file set into one location.

o Ny,
|

oo [2|@

Work Flow

The work flow using Pack and Go creates multiple backups, using the last backup to start
the next work session.

Creating a Zip File

Creating a zip file is a good way to consolidate the files and generate a backup in one step.
The zip file can be used to start the next session and then be stored away.
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1 Pack and go.

Click File, Pack and Go and click Save to Zip file. Using Browse, set the location to

a temporary folder, name the file Backup 1.zip

and click Save.

H Pack and Go

Select files to be saved to the specified Pack and Go folder, Mote: unchecked files must
be made available to successfully render the model,

Include drawings
Include simulation results

DIncIude custom decals, appearances and scenes
Include default decals, appearances and scenes

S

@ Mested view

Flat wigw

Ihclude Toolbox components

@ Save to Zip file:  Ctemp\Backup_1zip

Add prefix

/| Flatten ta single folder

Add suffix

VMame In Folder| Save To Name Sizg Type Date Modified -
]| Brakeitthes] SLDASM| e 54 Brake el SLDAS | 813 | SOLIDWORKS Ass | 2/1/2016 2:22:35 )
7] (brake Ci\Usersy|Brake Caliper.5LDPRT| 591 |SOUIDWORKS Part] 1/26/2016 11:55:1 r
7] (GyBrakePadsldert | enisers|Brake Padusigprt 57 |SOLIDWORKS Par 2/1/2016 2:20:38

7| DC@ErskeRoor [ icersy | Brake Rotor Assembl | 371 SOLIDWORKS Ass | 1/28/2016 45131

7| CRetor-Cast [ icer|Rotar - CastIron.5LD| 260 | SOLIDWORKS Part 1/28/2016 11531

7| R CA\Users\|Rotor Hat,SLDPRT | 275 |SOUIDWORKS Part] 1/26/2016 11:53:1

7| {Reter Ci\Usersy|Rotor Pin SLDPRT | 138 [SOLIDWORKS Part| 1/26/2016 11:55:1

7l {GyRoter CAUsers\| Rotar Washer,SLDPR | 106 | SOUDWORKS Parti 1/28/2016 11:53:1 i

@Assemb\ies: 5 % Parts: 16 Drawings: 0 Other: 0 TUtaI: 21 W
Sawve to folder | CAEEMR Browse..,

Browse,..

Emnail after packaging

Sawe Help

| | Cancel

2 Unzip.

At the start of the next session, unzip the file to a new folder and begin working. More
files may be added from external drives or different folders.

3 Repeat the process.

At the start of the next session, unzip to a new folder and begin working. Repeat the
process each time to keep all the files together.

Adding to File Names

If you want to rename the files with each new backup, the Add prefix and Add suffix

options can be used.

For example, the file name Brake Caliper could become Brake Caliper 2 or
2-Hub Assembly with a suffix or prefix added.

Note: Using a prefix or suffix changes the name. It is not the same as using the
SolidWorks Data Management product.
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4 Appending the names.

Use the same settings as in
box. Click Save.
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the previous step 1 but click Add suffix and type 1 in the

i Pack and Go @
[T Include drawings [Tlinclude custom decals, appearances and scenes @) Mested view
Dlnclude simulation results Include default decals, appearances and scenes () Flat viewr

Y Mame In Folder|Sawe To Mame Sizg Type Date Modified -
7| (GBrake CiUsersy | Erake Caliper 15LDP [591 |SOLIDWORKS Part| 1/26/2016 11:53:1
7| ChErekePadsidprt | eniserss | Brake Pad_Laldprt |57 K| SOLIDWORKS Part| 2442016 2:20:39 P 3
7| = (@EBraksRotor Clsersy | Brake Rotor Assembly| 371 [SOLIMWORKS A5 | 1282016 45131
7 pfetor- Cast e isersy [Rotor - CastIron_L3L[260 |SOLIDWORKS Part|1/28/2016 11:53:1
7 p Fatar Ci\Usersy|Rotor Hat LSLDPRT [275 |SOLIDWORKS Part| 1/26/2016 11:53:1
7 Gy Roter CUsersy|Rotar Pin_1.5L0PRT  [139 |SOLIDWORKS Part| 1/28/2016 11:53:1
7 Gy Rtor CiUsersy [Rotor washer 1.5L0P|106 |SOLIDWORKS Part| 1/26/2016 11:53:1
7l = @Hus Clserst|Hub Assembly 1500168 | SOLIDWORKS Ass | 27172016 2:22:34 P a
() Sawe to folder: | ChEEME Browse...
@ Sawe to Zip files  CAtempr\Backup 1zip

DAdd prefix: Add suffe 1

Flatten to single folder DEmaiI after packaging

[ Save ” Cancel ” Help ]

Tip: Virtual parts that have not been saved as external files will appear greyed in the list with
<internal to assembly> as the folder. They are stored within the assembly that
was active when they were created.

5 Save and close all files.
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3

Lesson 3: Creating a Weldment

When you complete this lesson, you will be able to:
Create weldment parts.
Use 3D sketches.

Work with sub-assemblies.

Add structural members.

d

a

d

a Create custom profiles.
d

O Trim structural members.
d

Edit structural members.
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Creating Weldment Parts

The Frame will be built as an in-context Weldment using references from existing
assemblies. The weldment process includes creating sketches, adding structural members
and trimming the structural members.

Planes and Sketches

Planes and sketches, both 2D and 3D, are used to
define the locations of the structural members in
the weldment.

Structural Members

The structural members, square and round tubes in
this example, are added to the lines and arcs of the
sketches. After they are added they are trimmed to
fit.

Weldments

A Weldment is a multi-body part composed of structural members. The centerlines of the
structural members are sketched and profiles are selected from a library and are applied to
the sketches.

Tip: Most of the work to create a weldment is invested in the creation of the weldment sketches.
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Creating a Weldment

Creating a typical weldment involves several steps to
create and trim the weldment members.

For example, this weldment is made up of five
structural members; two of the longer length and three

of the shorter length.

The following chart defines the basic steps in creating

a weldment part.

Sketch

Create a new sketch that
defines the centerlines of
the weldment profiles.

The sketch can be a 2D or
3D sketch.
Close the sketch. §
Click Structural
Member @ and select p
Create geometry.
Structural Sl file fi h
Members elect a profile from the ]
library for use with the
geometry.
=
. Click Trim/Extend & ‘\
E"m a(;'d and trim or extend the
SXten length of structural
tructural members to planes or
Members

other structural members.

Some Important Points about Weldments

Here are some important points to remember about weldments:

Lesson 3: Creating a Weldment

L/

0 Weldment parts are multi-body parts. Each structural member is an individual solid

body.

O The profiles used are selected from a library. You must create your own profiles and

library folders if the standard profiles are not what you need.

O Weldments can make use of symmetry. Structural members can be patterned using

Mirror with the Bodies to Pattern option.

O A Cut-List folder is created to store information about the structural members and

their lengths of the structural members. They can also be sorted by equal lengths.

O A Weldment Cut List table can be generated in a drawing of the weldment.

SolidWorks SAE Design and Analysis Project
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O The drawing can also have balloons like a BOM.

Some Details About Weldment Sketches

Weldment sketches are used to define the centerlines of beams used in the weldment.
Continuous beams should be created using single pieces of geometry. If they are not,
smaller separate pieces will be created.

Sketches used for weldments may be different than sketches used for other features. For
example, the sketch shown here would not be useful for a boss extrude or revolve.

Single Line Multiple Lines
1 Open Frame&Suspension.

Click File, Open and select the assembly Frame & Suspension from the Lesson
3\Frame&Suspension folder.
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2 Show sketches.
Open any instance of the A-Arm Spherical Ball component.
Right-click Sketchl and select Show.

Return to the assembly.

Note: The A-Arm Spherical Ball components can be rotated
for a better view of the sketch.

Using Different Planes and Sketches

In the process of adding a new part in-context, a planar face or plane must be selected.
This plane is used as a sketch plane and a new sketch is opened. In fact, several things
happen at once when the plane is selected:

O A new in-context part is created.

O The new part is being edited.

O A new sketch is created on the selected plane.

a The new sketch is open.

O The selected plane becomes the Front plane of the new part.

The new sketch may not be the sketch you want. Although it is a requirement to select
something, you do not have to use the sketch. You can just exit the sketch and create the
plane or sketch that you need.
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3 New part.

Click Insert, Component, New Part and select the plane Ground. A new sketch, in
the new part, is automatically started on the selected plane. See "Creating a New Part"

on page 15 for more information.

Note: The Ground plane is selected, but in theory any plane or planar face could
have been selected because none of the existing planes or planar faces is

sufficient.
4 Exit sketch.

Right-click in the graphics area and select Exit Sketch (& to leave the current sketch.

You are still editing the new part.
5 Reference plane.
Click Insert, Reference Geometry, Plane .

Select the plane Front from the active part
[Partl"Frame&Suspension]<1> and Parallel.

Select the centerpoint of an arc from A-Arm Spherical
Ball (connected to the A—arm - Upper assembly) as
shown. Click v and rename the plane Upper Arm.

ﬁ Plane ?
v X~
Message A
Fully defined
First Reference ~

@ Front Plane@Partl “Frame&Suspen

Parallel
Perpendicular
Coincident
||| a0.00deg
0.40in

E Mid Plane

Second Reference ~

0 Ipoimll@Skatchl@A—Arm Spherica

Coincident
Project
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6 Lower plane.

Q ’A—arm - Upper<2> (right<righ
Q 'A-arm - Lower<2> (Left Side<
g ' Unspring Mass Assembly - Rig—
(@ @ () Tie Rod Assembly<1> (Def;
Q ' Steering Wheel<1» (Default=[|
Q ’ Steering Rack and Shaft Asserr|
@ @ (1) A-Arm Spherical Ball<1> (T
% T () A-Arm Spherical Ball<2> T
% t (-) A-Arm Spherical Ball<3> (T
@ B (-) A-Arm Spherical Ball<d> (T
@ ' (-) Rear Axle Assembly<1> (D¢
@ 1 [ Partl *FrameiSuspension |<
4 Mates in Frame&Suspension
L4 History

@ Sensors

Annotations

455 Material <not specified>

m Front Plane

Bl Top Plane

m Right Plane

L Qrigin

' Upper_Arm ->

' Lower_Arm ->

» L’ﬂ@ Mates

Using the same procedure as the previous step, create a new plane
using the plane Front and a centerpoint of an arc from A-Arm
Spherical Ball (connected tothe A-arm - Lower
assembly) as shown. Click v and rename the plane

Lower Arm.

v v v v vy oy

<
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Using 2D Sketches

A series of 2D sketches will be created to form the
basic shape of the frame.

3D sketches will be used to fill in much of the
bracing and support structure after the basic shapes
are complete.

Note: Many of the 2D sketches, like this one, will require the creation of new planes.
7 New sketch.

Right-click the plane Lower Arm and Sketch (.
8 Rectangle.

Click Rectangle 7 and sketch as shown.
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9 Reference to existing geometry.

Add dimensions between the centerpoint of the arc and the edge of the rectangle as
shown. Set the values to 35mm and 30mm. Selection of A-Arm Spherical Ball
geometry for the dimensions creates external references to that component.

10 Centering geometry.

Sketch a centerline connecting the midpoint of the line and the origin as shown. Select
the centerline of the current sketch, control+select the plane CenterLine and add a
Collinear.” relation.
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11 Add line and dimension.
Add the line and dimensions 710mm and 430mm as shown.

12 Exit sketch.

Right-click in the graphics area and select Exit Sketch [& to leave the current sketch.
Rename the sketch Main.

13 New plane.

Control+drag the plane Lower Arm downwards. In the Plane dialog set the offset to
115mm. Rename the plane Lower Frame.

14 Hide components.

Hide the Steering Wheel and Steering Rack and Shaft Assembly
assemblies.
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15 New sketch.

Create a new sketch on the plane Lower Frame. Sketch the lines and a centerline
connecting the midpoints of both lines as shown.

16 Symmetry.

Add a Horizontal — relation to the centerline. The two angled lines
are now symmetric to each other.

17 Relation to inactive sketch.

Select the centerline of the current sketch, control+select the
centerline of the inactive sketch and add a Collinear ,~ relation.
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18 Complete sketch.
Add the dimensions as shown. Exit the sketch. Rename the sketch Lower Frame
Sketch.

650

— e _ ]

315

q—f |
|

Renaming and Opening a Virtual Part

It is easier to work on the part outside the assembly provided that the assembly geometry
is not being referenced. The part can be opened even though it is a virtual part.
1 Rename the virtual part.
Right-click the virtual part Part1~Frame&Suspension in the FeatureManager
design tree and select Rename Part. Type Frame.
2 Open the virtual part.
Right-click the virtual part Frame”~Frame&Suspension and select Open Part g.
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Why is the View Orientation Different?

When a new part is created in-context, the initial plane or planar face selected defines the
position and orientation of the Front plane of the new part. This may cause the new part
to an unexpected orientation, different than that of the assembly. Saving a view state is a
great solution.

3 Orientation.

Click View, Modify, Rotate C' and rotate the view orientation so that it looks similar to
that of the assembly.

<

4 Save a view state.

Mammed View -7 ===l
In order to save the view orientation and zoom, save a view | viewname: T
state. Press the Spacebar and click the New View %7 icon 150l —
on the Orientation dialog. Help

Type the name ISO and click OK.
The view name I SO will be added to the list and can recalled by double-clicking.
5 Plane.
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Create a new plane using the plane Right and Parallel for the First Reference and
the endpoint of the Main sketch as the Second Reference. Rename the plane
Bulkheadl.

= I S :

il Plane Y v Histary
@ X - Sensors
v [2) annotations

Message ~ =

25 Material <not specifie...
Fully defined 1

™ Frant Plane
First Reference ~ M Top Plane
([ | Right Plane N\ Right Plane

o

Parallel L, origin

W Upper_am ->
_| | perpendicular B LowerAm >
A Coincident . Main >
[%¥] [90.00deg W Lower_Frame

[ Lower Frame_Sketch

=| Mid Plane
Second Reference ~ }

! IPaln(L@Mem

Coincident

3| project

Galo

Third Reference ~
@l

Options ~

[ Flip normai

3
6 Sketch geometry.

Create a new sketch on the plane Bulkheadl. Add lines to the existing endpoints of
the Ma in sketch. Select the centerline, control+select the endpoints and add a
Symmetric = relation.

Note: Endpoints or geometry can be selected for the addition of a symmetry relation.
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7 Dimensions and fillets.

Add the three linear dimensions (440mm, 215mm
and 420mm) as shown.

Click Sketch Fillet ™\ and set the Fillet Radius to
100mm. Select four corners as shown. Click .

Tip: If this message appears: At least one
segment being filleted has a
midpoint or equal length
relation. Geometry may have to
move to satisfy this relation
when the fillet is created. Do
you want to continue? Click Yes.

Close the sketch and rename it to
Bulkheadl Sketch.

Additional Planes and 2D Sketches

A series of small 2D planes and sketches are needed to define the shape of the frame.

Bulkhead3 sketch \\‘/{(—Seat_Angle_sketch
Bulkhead2sket%* . i

Engine2 sketch

Enginel sketch

Through Point Sketch

8 Bulkhead2 and Bulkhead3 planes and sketches.

Create planes parallel to Right through the endpoints in the Main sketch and create
the following sketches.
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Bulkhead2 sketch  Bulkhead3_sketch
9 Seat position and angle.

Create a new plane using Right and Parallel for the First Reference and the
endpoint of the Lower Frame Sketch as the Second Reference. Rename to
Seat Position.

Using Seat Position and the sketch line as shown, create a new plane. Click
Angle and use 10 degrees. Rename it to Seat Angle.

Create the sketch and rename it to Seat Angle sketch.

Tip: Add the 100mm sketch fillets before the 90mm and 500mm dimensions.
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Sketching with Pierce Relations

So far, we have connected geometry to endpoints and midpoints. But what if the structural
members are connected to an arc or elbow shape? This method utilizes a lesser known
relation called Pierce. The pierce relation positions an endpoint where the sketch plane
intersects (pierces) the selected geometry.

Note: Sometimes it is necessary to create a bracing member in order to create
bulkheads and other sketches. In this case the position of the bracing member is
required to sketch the position of a bulkhead.

10 Edit sketch.
Edit the sketch Bulkheadl Sketch. Click Point = and add a

point near the arc. Add a Midpoint relation between the point and
the arc as shown. Exit the sketch.

11 Plane through point.

Create a new plane using Front and Parallel for the First Reference and the point as
the Second Reference. Rename to Through Point.

[ Plane ?

v X+
Message ~
Fully defined

First Reference ~

EE] Front Plane
Parallel
Perpendicular
Coincident
10.00deg
10.00mm
El Mid Plane

Second Reference ~ ®

© I PointaD@Bulkheadl_Sketch
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12 Pierce.

Create a new sketch on the Through Point plane. Sketch a line from the point
towards the arc as shown. Select the endpoint and the arc and add a Pierce ¢ relation.
Rename to Through Point Sketch.

13 Planes.

Create a new plane offset 550mm from the Seat Position plane. Rename to
Enginel. Offset 300mm from the Enginel to create Engine?2.
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14 Converting a single sketch entity.

Create a new sketch on the Enginel plane. Click Convert Entities @ and select the
centerline in the Seat Angle sketch as shown. Click v . Right click the line and
select Construction Geometry |2i. Add the lines to the centerline as shown.

: ]
S g
2 2
g G ‘\
E 3
15 Mirror in the sketch. B0 Mirror @
Click Tools, Sketch Tools, Mirror i1 and select the three v X -
sketched lines. Right-click and select the centerline and click v . wmessase ~
Select entities to mirror and a sketch line
at linear model edge o mirror about
Options A

Entities to mirrar:
Lineé
Line3
Line?

Lib

V] Copy
Mirrar about:

A
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a

1@ 7/

Engir

16 Collinear with a plane.

Add a Collinear ,“ relation between the

Through Point plane and the top line and add the
dimensions as shown. Exit the sketch and rename it
Enginel Sketch.

17 Converting an entire sketch. G B [RBIS1®] |, @neramcsspes.
. @ Convert Entities [(GH©) » Histary
Create a new sketch on the Engine?2 plane. b £ sensr
. agw » [&) Annotations
Click Convert Entities © and select the sketch Entities o Convert ~ - p—
Enginel Sketch using the flyout ﬁ“mt"'w
— . . ' [ Top Plane
FeatureManager design tree as shown. Click . gsmwam N RightPlane
. Inner loops ohe by ane L» Origin
Close the sketch and rename it Eelectallinge oves N Upper_pmn -»

N Lower_Arm -
7 sketen2 -
N Lowser_Frame
7 () Sketehs
| W Bulkheadl
{7 () Bulkhesdl Sketch
:| N Bulkhead?
{7 Bulkheada_Sketch
W Bulkheads
{7 Bulkheads_Sketch
N Seat_Position
N Seat_fingle
t Seat_fingle_Sketch
| [l Through Faint
t Thraugh_Paint_Sketch
ﬁ Enginel
ﬁ Engined
L: Enginel_Sketch

7 sketehn

EngineZ2 Sketch.

Engine2
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Adding Bracing to the Frame

Bracing is added between the existing sketches using more sketches. The best practice is
to use the type that is most suitable in the situation, 2D or 3D. For more information
regarding 3D sketches, see "Using 3D Sketches" on page 59.

Tip: All of the previous sketches could have been created as 3D sketches.
18 Sketch.

Create a new sketch on the Through Point plane. Add the two centerlines, three
lines and two dimensions as shown. Rename to Engine Mount.
Exit the sketch in an under defined state.

Note: This sketch is another example of a valid weldment sketch that would be
unsuitable for a standard extrusion. For more information, see "Some Details
About Weldment Sketches" on page 42.

Using 3D Sketches

3D sketches are very useful in creating sketch geometry that does not lie on an existing or
easily definable plane. Bracing lines that cross through 3D space between existing
endpoints are best created using 3D sketches.

Where to Find It

-

fH
0 CommandManager: Sketch > Sketch *“" > 3D Sketch [&
0 Menu: Insert, 3D Sketch ’
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Sketching in the X, Y and Z Directions

The Space Handles that appear in a 3D sketch when creating lines can be used to sketch
along the X, Y and Z directions. The direction is shown at the cursor.

Lo21se p,
XY 1 \, ¢ 053,500 2203, 90°

YZis, ZXim,

Note: The space handles can be ignored to sketch between endpoints in 3D space.

How do you know if you are in a 3D sketch?
Look at the Status Bar near the bottom right corner of the window. It will say Editing
3DSketchl fora 3D sketch or Editing Sketch6 fora 2D sketch.
19 3D sketch.

Click 3D Sketch [ and add a line. Start the line at the lower endpoint and end it on the
angled line as shown. A Coincident relation is added in the process.
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3D Sketch Dimensions

The Tab key can be pressed while creating a dimension to switch between the true
distance (absolute) and distances along the X, Y and Z axes.

Select the line and place the dimension... (Absolute)

Select the line and...

press Tab once press Tab twice press Tab three
(Along X) (Along Y) times (Along 2)

Note: Once created, you can use Edit Sketch [z to edit either a 2D or 3D sketch.
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20 Dimension.

Add an absolute dimension of 350mm that defines the true length of the line.
Exit the sketch.

21 Assembly.

Press Ctrl+Tab and click the assembly. At the message: Models contained
within the assembly have changed. Would you like to rebuild
the assembly now? Click Yes.

22 Edit assembly.

Edit the assembly by right-clicking in the graphics area and selecting Edit Assembly:
FrameSuspension.

23 Save.

Save the assembly and click Save All. At the message: This assembly
contains unsaved virtual components which must be saved
click Save internally (inside the assembly) click OK.

24 Show display state.
There are many components that have been hidden. They will be shown now.

Click the ConfigurationManager tab & in the FeatureManager design tree and double-
click the display state Full Display State-1. Click the FeatureManager design
tree tab @.

25 Hide planes.
If there are planes visible, click View, Hide/Show, Planes to turn of the display.
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Placing a Component Using Sketch Geometry

The geometry of the Frame, an in-context virtual
part, can be used to create mates as well as place
and orient components.

© . Concentricll (Frame*Frame&Suspension=<1 > ENGINE<

26 Insert component and mate.
Click Insert, Component, Existing Part/Assembly ® and select the ENGINE part
from the Lesson 3 folder.
Mate the Right plane of the ENGINE and the Centerline plane of the assembly
using a Coincident mate.

Note: Use the Aligned and Anti-Aligned options to get the mate alignment as shown.
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27 Concentric mate.

Select the cylindrical face of the engine and the sketch line as shown. Add a
Concentric mate between them.

28 Rotate.

Rotate the under defined component as shown.
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Making Changes

With the addition of the ENGINE, we can see that it appears to be too close to the
Enginel sketch (inside right box). One solution may be to pull the attachment point
back by shortening the length of a line in the Engine Mount sketch (inside left box).

29 Change dimension value.
Return to the part by pressing Ctrl+Tab and clicking the part.

Double-click the Engine Mount sketch in the FeatureManager design tree and
change the dimension to 50mm as shown. Click Rebuild @ .

30 Return to the assembly.

Press Ctrl+Tab and click the assembly. With the change in the sketch geometry, the
engine has been pulled back to a better position within the frame as shown.
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Working With Sub-Assemblies

Large assemblies often have multiple sub-assemblies within them. @ B Frametsuspension (RIDE<Full
This is good practice and helps make the assembly easier to work > e isoy
. . . . 3 Annotations
with by shortening the FeatureManager design tree and breaking the Sensors
components into logical groups. g T
Centerline
This section will show how to open a sub-assembly from the main E;’?”_*A"'e
. rigin
assembly and set Component Properties. B s
w Rear Axle

" €L Rear Aule

(5 ﬁ A-arm - Upper<2= (right<
@ ﬂ A-arm - Lower<2> (Left Si
@ ﬂ Unspring Mass Assernbly -
@ ﬁ (-) Tie Rod Assembly<1> (|
(@ F Steering Wheel<1> (Defau

Opening a Sub-assembly from the Assembly b @ @ () A Spherical Ball<1>

Sub-assembly components can be opened directly from the assembly FeaureManager
design tree like part components.

Tip: Right-clicking a component part in the sub-assembly and trying to open it will open the part
only.

31 Open sub-assembly.

Right-click the sub-assembly Rear Axle Assembly from the FeatureManager
design tree and select Open Subassembly [¥.

Rigid vs. Flexible Sub-Assemblies
All sub-assemblies have the option of being solved as Rigid or Flexible.
Where to Find It

aQ Shortcut Menu: Right-click a sub-assembly and click Component Properties .
Change the Solve as option to Rigid or Flexible.

Rigid

Rigid treats the entire sub-assembly as a single rigid component when used as a sub-
assembly. Rigid is the default condition for all sub-assemblies.

Flexible

Flexible allows the components that can move or rotate in the assembly to move or rotate
when used as a sub-assembly.
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1 Test component.

The assembly is designed so that the
Sprocket is free to move along the axis
CL Rear Axle.Move ita small
amount to test it.

Close the sub-assembly without changes
and return to the main assembly. Click
Discard.

2 Warning.

To line up the Sprocket with the engine output, select the faces indicated and try to
add a Coincident mate. A warning saying that the coincident mate cannot be added
will appear. Click x .

Why Does the Warning Appear?

The sub-assembly is solved as the default rigid condition which does not allow
components in the sub-assembly to move independently.
3 Component properties.
Right-click the Rear Axle Assembly and select
Component Properties . Under Solve as, click
Flexible and OK.

Using the same procedure as in step 2, add the Coincident
mate.
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Bracing Sketches

There are several more planes and sketches required to complete the Frame geometry.
4 Open part.

Open the virtual part Frame.
5 Pierce relation sketches.

Create a new plane through the endpoint indicated and Parallel to Front plane. Use
the plane to create two new sketches.

In the each sketch, use one Coincident and one Pierce relation.

Note: The pierce relation in the first sketch uses an arc, the second uses a line.
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Remaining Sketches

The remaining sketches are all 3D sketches and will be presented with a brief description
and an image as shown below.

Two_ Iin_es and
Coincident
relations.

Two lines,
Coincident and
Midpoint relations.
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One: Iinc_a and
Coincident
relations.

Fou_r Iin_es and
Coincident
relations.

Why is the Bracing One Sided?

The resulting structural members will be mirrored across a plane to create the bracing on
the opposite side. For more information, see "Mirroring Structural Members" on page 81.
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Weldments use standard profile shapes that are applied to g
sketch geometry to create structural members. Each structural

member is a separate solid body in the multi-body part.

Weldments also track the quantities and lengths of the
structural members using a weldment cut-list.

A Quick Look at the Standard Profiles

The weldment profiles are divided into two Standard folders: ansi inch and iso.
Profiles must be library features and be present in the folders to be used. The standard

profiles use these shapes:

g — J
angle rectangular or | 5 sectionor
iron c channel | pipe square tube sb beam

Weldment Cut List
The Weldment Cut List tracks the structural member types and lengths.

- B cutlist(s)

r ¥ <)
=)
v ¥ )

"IE Material <not specified>

13

Creating Custom Profiles

\. Front Plane

\. Top Plane

N Right Plane

1_, Origin

@ Weldment

{7 ) sketent

rla Structural Member1

+ B Cutlistie)
+ ¥ a2
() Structural Member 1[3]
- H a3
() Structural Member 1[2]
@ Structural Member1[4]
v ¥ e
@ Structural Member 1[5]
[T Structural Member 161
"E Material <not specified>
™ Front Plane
\ Top Plane
™ Right Plane
L Origin
¥ Weldment
{7 ©) Sketcht
(@ Structural Member1

TEM NG, QTY. LEMGTH
1 2 175
2 2 225

2 2 185.803
N

O=%

hS

We need two profiles: a round (pipe) tube and a square tube each
with an outside measurement of 25.4mm. This size is different
than the standard sizes, so they will need to be created and placed

in the proper folders.

Note: The weldment profiles are set to specific folders by the
option Tools, Options, File Locations and Weldment Profiles.

1 Open a new part.

Open a new part with mm units.
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2 Sketch.
Create a new sketch on the Front plane and sketch a 25.4mm circle and dimension as
shown.

Add an offset of 2.4mm as shown and exit the sketch.
$25.40

3 Save as library feature.
Select the sketch Sketchl. Click File, Save As.

Select the Save as type Lib Feat Part (*.sldIfp), type the file name 25 . 4mm Dia, and
click Save.

For Save in, navigate to the default weldment library folder located in the
C:\Program Files\SolidWorks Corp\SolidWorks\lang\english\
weldment profiles folder.

Note: If you receive a message that you are not allowed to save in that folder, try
saving the file in a local folder and moving the file to that folder. Also, the full
path used in this lesson is based upon the default installation on SolidWorks
onto the C drive. If SolidWorks has not been installed using the default settings,
then the path will require some adjustment.

w Save As @
@Qvl < english » weldment profiles » - ‘6,‘ ‘ Search weldment profiles )
Organize v New folder = @

r Favorites e MName B Date modified Type

Bl Deskiop ansi inch 10/7 3AM  Filefolder

& Downloads E iso 10/7 3AM  Filefolder

| Recent Places

i Libraries

3 Documents

@' Music
[ Pictures
B videos -4 0 2
File name:  25.4mm Dia.SLOLFP -
Save as type: | Lib Feat Part (*sldifp) -
Description: Add a description
@ Save as Include all referenced components
Save as copy and continue Add prefix
Save as copy and open Add suffix -
+ Hide Folders Save ] \ Cancel
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Library Feature Folders and Icons

The library feature is a different file type and uses different icons G B 25ammbia ek <Debut
for the top level component and the sketch. =l
. v History
4 Close library feature. -
. 4 Annotations
Close the library feature part. R
5 Create new Folders. -l
Adding the weldment profile to the weldment profiles £ o,

folder is not enough to make use of it.

Create a new folder FSAE in the

<Install Directory>\Program Files\SolidWorks Corp/
SolidWorks\lang\english\weldment profiles folder. Open that folder
and create two folders named Square Tubes and Round Tubes.

Move the 25.4mm Dia.SLDLFP file into the Round Tubes folder.

@uvl « lang » english » weldment profiles » FSAE » v“‘"|

Organize » Include in library + Share with = Burn New folder

sldmaterials -
Tutorial
weldment profiles
ansi inch
FSAE
P Round Tubes Square Tubes

6 Move existing file.
Move the existing 25mm Sides.SLDLFP file into the Square Tubes folder.
Note: The file can be found in the Lesson 3 folder.

Why Do Some Profiles Contain Points?

Profiles formed using lines typically contain points at the
corners like this tube. They are useful in moving the profile to a
position other than the centerline. T L

].250—‘

¥
I

Z‘ e
R1.250
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Adding Structural Members

74

Adding the structural members is the simplest part of the process. Selecting the existing

sketch geometry gives the structural members position and length.

It is helpful to keep all the related features together in the FeatureManager design tree for
future editing. In order to do this, it is best to rollback. See "Using Folders" on page 79 for

more information.

1 Move the rollback bar to a position after the sketch feature that you want to use for

creating structural members.

2 Select the geometry of inactive sketches to define the centerlines of the structural

members.

3 Add only structural members of the same type in the same feature.

1 Rollback.

In the Frame part, right-click the Bulkhead?2 plane and select
Rollback « .

This will place the Structural Member feature just after the
Bulkheadl Sketch sketch, near the related plane.

2 Structural member.

Click Insert, Weldments, Structural Member @ and the
following options:

Standard FSAE, Type Round Tubes and Size 25.4mm Dia.

Select all the lines and arcs as shown and click .

=)}

@ Weldment

\ Upper_Arm ->

\ Lower_Arm -»

t (-1 Main -»

\ Lower_Frame

t Lower_Frame_Sketch
N Bulkheadl

{__ () Bulkhead1_Sketch

Bulkhead2

Structural Member @

v X .

Message Ll

Select skekch segments for defining
path, You can rotate the profile by a
specified angle,

Selections ~
Standard:
[FsaE -

Type
{RUundTubes 'J

Size:
[25.40mmDia -

Transfer Material from
Prafile:Material <nat
specifieds

Mew Group

Settings Ll

Path segments:

Linel2@EBulkheadl_Sketch
Arcli@Bulkheadl Sketch
Linell@Bulkheadl Sketch
Arc3@Bulkheadl Sketch
Linel0@Bulkheadl Sketch

Rename the structural member feature to Structural Member Bulkheadl.
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Corner Treatments

The Corner Treatments End Miter §, End Butt1 @ or End Butt2 @& are used to
determine the trimming of the members meeting at a corner within the same feature.

w

@

w =
@

Corner treatments are applied to all corners in the Structural
Member dialog and individually.

Individual corner treatments can be set by clicking the circular
corner markers and setting the dialog that appears.

3 Rollback.
Drag the rollback bar to a position after the Bulkhead2 sketch.

Note: The Weldment feature is added to the part automatically. This
defines the part as a weldment part.

SolidWorks SAE Design and Analysis Project

®
v P
®
®
@
=
=

@ Weldment

N Upper Arm ->

m Lower_Arm -»

. () Main -

m Lower_Frame

t Lower_Frame_Sketch
N Bulkheadl

[T () Bulkhead1_Sketch
@ Structural Member_Bulkheadl
W Bulkhead2

[ Bulkhead2_Sketch

[ Bulkhead3
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76

4 Structural member.

Click Insert, Weldments, Structural Member and the following
options:
Standard FSAE, Type Square Tubes and Size 25mm Sides.

Make sure Apply corner treatment and End Miter & are
clicked. In this example, all corner treatments will remain as end
miters.

Select all the lines of the sketch as shown and click .

Using Groups

@ Structural Member @f (
LA
Message ~

Select sketch segments far defining
path. You can rotate the profile by a
specified angle,

Selections ~
Standard:

[Fsae -
Type :

[Square Tubes v]
Size:

[25mm sides -

Transfer Material fram
Profile:haterial <=not
specified=

Groups:

]

Settings -~
Path segments:

lined@Bulkhead2_Sketch
lineS@Eulkhead2_Sketch
line3@Bulkhead2_Sketch
linef@Bulkhead2_Sketch
Llinel@Bulkhead?_Sketch

L}
Apply corner treatment

Eew

The Group option allows you to select multiple “groups” of edges in the same dialog. The
structural members of each group are automatically trimmed against each other; for
example the members of Group1 are trimmed by the members of Group?2.

Group1
Group

Note: The use of groups may limit the selection of corner treatments.
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5 ROllbaCk. @ Weldment

N Upper_Arm -»
N Lower_Arm ->

i main->

Drag the rollback bar to a position after the Main-> sketch.

6 Structural member.

@ Structural Member @jé
Click Insert, Weldments, Structural Member and the following v x
OptiOI’lSZ Message ~

. . Select sketch ts for defini
Standard FSAE, Type Square Tubes and Size 25mm Sides. st vou can rotate the profie by

specified angle,

Selections ~
Standard:

[Fsae -
Type

[Square Tubes v]
Size:

[25mm sides -

Transfer Material from
Profile:Material <naot
specified=

_.

These selections are added to Group1.
Settings Lol
Path segments:
Linel@Main
Line3@Main
7 Group.
Click New Group and select the three remaining edges for Group2. Click
v,

Using Trim/Extend

The Trim/Extend @& tool is used to trim the end of a structural member against a face/
plane or one or more other structural members.

It is helpful to keep the related trim/extend features together with the in the
FeatureManager design tree. In order to do this, it is best to rollback first similar to adding
structural members. See "Using Folders" on page 79 for more information.
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1 Move the rollback bar to a position after the Structural Member feature that
you want to trim.

2 Add one trim/extend feature for each end of the structural member. In the simplest
cases, the trim/extend feature may include both ends of the structural member.
Trimming Boundary

The trimming boundary can be either a Face/Plane or other Bodies. Options with other
bodies include Simple cut between bodies and Coped cut between bodies.

Bodies Bodies Face / Plane
Simple cut between bodies | Coped cut between bodies

i -

Tip: The Trim/Extend tool eliminates interferences between solid bodies by shaping the ends
and creating the correct fit. Interferences between solid bodies in the multibody part can be
checked at the assembly level. For more information, see "Checking Clearances" on page

87.

8 Trim. ¥P Trim/Extend ©)
Drag the rollback bar to a position after the St ructural v X
Member_Bulkheadl featul‘e. Corner Type Ca
Click Insert, Weldments, Trim/Extend @& and click End
Trim @ . Bodies to be Trimmed ~
Select the Bodies to be Trimmed and Trimming Boundary I e Member’_.wkheadl[g]
Bodies as ShOWIl. éllow extension
Click Simple cut between bodies # and v . Trimming Boundary ~

() Face / plane
@ Bodies

’7 Structural Member_Main[1]

Ere\tiew
éllow extension

o &

[Clwield gap
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Bodies to
be Trimmed

~ ¥~ Trimming
Boundary
The Bodies to be Trimmed is shortened using the Trimming Boundary body.

Using Folders

Rollback was used in the previous steps to place the trim/extend feature just after the
structural member being trimmed. This allows us to group a series of related features into
a Folder, effectively reducing the length of the FeatureManager design tree.

Note: Features can also be dragged and dropped into the folder but they must remain
in the same sequential order.

9 Add folder.

Shift+select the sequence of features as shown. Right-click and select Add to New
Folder, naming the folder Bulkhead 1 Folder.

T Bulkheadl [ Bulkhead 1 Folder
(-) Bulkheadl_Sketch E Bulkheadl
-} Bulkhead1_Sketch
@ Structural Member_Bulkheadl | [ Bulkhead_1 Folder () Bulkheadl_Sketc
ﬁ: Trim/Extend] ) Bulkhead2 4 @ Structural Member_Bulkheadl
e P Trim/Extendl
E:' ipmiFcenct %P Trim/Extend2
[l Bulkhead? T Bulkhead2
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If this procedure is used throughout the FeatureManager design tree it

will significantly shorten the length of the tree.

Map for Structural Member Types and Trim/Extend

80

The structural member types are either FSAE, Round Tubes, 25.4mm
Dia O or Square Tubes, 25mm Sides | |. Create them and add the
trimming and folders using the map below or the included eDrawings
files (below). Use End Trim @ and Trimming Boundary Bodies for all
features.

Double-click the eDrawings file
Frame.eprt & or the html file
Frame.html @ . This will open an
eDrawing or browser that can be zoomed,
scrolled and rotated using the same tools as

in SolidWorks.

Use the eDrawing to visually determine the
type of structural member used for each
sketch and how it is to be trimmed.

eDrawings File for Member Types and Trim/Extend

—le

File View Tools

[x] +

Help | Frame.eprt

wy
]

Q

? Frame”Frame&Suspension
History

Sensors

Annotations

B cutlist(s4)

§3 Material <not specified>
N Front Plane

m Top Plane

N Right Plane

L Origin

@ Weldment

m Upper_Arm -»

N Lower_Arm ->

ﬁ Main Folder

E Lower_Frame Folder
[ Bulkhead_1 Folder
[ Bulkhead_2 Folder
[ Bulkhead_3 Folder
Seat Folder

E Through_Point Folder
E Engine 1 Folder

E Engine_2 Folder

E Engine_Mount Folder
E Connector Folder

fe

Q e # 0
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Mirroring Structural Members

Mirror can be used to pattern features, faces or bodies across a plane. In this example solid
bodies will be mirrored to complete the frame.

10 Mirror bodies. K] Miror ®
Click Insert, Pattern/Mirror, Mirror F and click the Top @ &
plane as the Mirror Face/Plane. Click Bodies to Mirror and  wiror facepiane s
select the bodies shown in blue. Click v . ) [ are
Features to Mirror v
». Faces to Mirror b
Bodies to Mirror ~
@ Structural Member_EnginemMount[1] s

Trim/Extends
Structural Member_EngineMaount[2]
Structural Member_EngineMount[3] -

Options "
] D Merge salids
: » [ Knit surfaces
Eropagate visual properties
) Eull presieu

@ Partial preview

Note: Mirroring the bodies after trimming eliminates the need to trim the mirrored
bodies.
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Editing

A big advantage of creating geometry in SolidWorks is the editing capability. You can edit
sketches and features to change the design at any time. In this section, several types of
changes will be introduced.

Editing the Corner Treatment
The corner treatments used on some of the earlier structural members may seem
inadequate after all the bracing is added. In this case, an open end makes the connection
with the brace difficult.
11 Zoom in.

Zoom in on the area as shown. This area shows a potential problem where the brace
member connects to an open face of a square tube.

12 Edit structural member feature.

It is not necessary to know the name of the feature. Right-click on a face of any
structural member of the feature and select Edit Feature @-.
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13 Corner treatment.

Click the corner marker as shown. In the Corner Treatment dialog, set the Trim Order

to 2 and click v . Repeat the process for the other corner and click ~ in the main
dialog. This changes the selections to mitered corners.

Corner Treatment

()
Group L Trim Order = 2

Group 2, Trirm Crder = 2

I Trimn Crder: 2 : I\
Yew

Merge miter trimmed bodies
|:| Set corner specificweld gaps

“{% 0.00mm -

Note: The potential changes that can be made are limited by how the feature was
created. This feature was created using groups so miters are the only other
choice.

Editing the Trimming

With the changes to mitered corners, the trimming can now be changed. In this case a
planar face will be used instead of a body.

14 Edit trim feature.

Right-click the face of the structural member shown and select Edit Feature @ . Under
Trimming Boundary, click Face / Plane and select the face as shown. Click ~

E Body 1, 1: -
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Editing the Type of Structural Member
The standard type or size of the structural member can be changed. In this example,
structural members that will have plates attached will be changed to square profiles.
15 Edit feature.
Right-click the face of the structural member shown and select Edit Feature @.
Click FSAE, Type Square Tubes and Size 25mm Sides. Click .

Using Locate Profile

In creating all of the structural members so far, the profiles
have been placed directly at the default center position.

Consider a case where structural members of the same type
and size are stacked on top of one another. Is it necessary to
sketch a centerline offset by the exact amount?

Locate Profile allows you to place the profile within the
sketch using the points built into the profile. For more information see "Why Do Some
Profiles Contain Points?" on page 73.

16 Filld the pal'ellts. E¥) Parent/Child Relationships (==
Right-click a face of the structural member as S e |
shown and select Parent/Child. The Parents and b par e
Children of the feature are listed. Click Close. L oersrameseten

17 Show sketch.
Right-click the Lower Frame sketch in the dialog and select Show.
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18 New sketch.
Right-click the top face of the structural member and select Sketch (.

19 Convert.

Click Convert Entities @ and select the centerline of
the visible sketch.

Drag the endpoints outside the structural members and
exit the sketch.

Add relations to span the full width as shown.
Close the sketch.

20 Locate profile.

Click Insert, Weldments, Structural Member and the following options: FSAE, Type
Square Tubes and Size 25mm Sides. Sclect the line and click Locate Profile. Click
the point at the lower center position on the profile and click v .

SolidWorks SAE Design and Analysis Project 85



Lesson 3: Creating a Weldment

21 Measure.
Click Tools, Evaluate, Measure and select the two faces shown.

. B Measure - Frame®Frame&Suspensio... 7 |[=
eadeRgcy

Face=1= ‘

The two selected items are parallel,
Mormal Distance: 79.6mm
Distance: 436.57mm

Delta ¥ 420.62mm

Delta ¥: 79.60mm

Delta Z: &4.61mm

Total area: 26662.5 millimeters ™2

[Lm | »

e Mormal Dist: R
S U 436.57mm

Repeat the measurement on the opposite side to ensure that the structural member is
centered.

22 Save.
Save the part and close it. Return to the assembly and click Yes to rebuild the assembly.

Using Instant 3D

Instant 3D can be used to make dynamic changes to a model by dragging or directly
changing dimensions.

Single-click a dimension to change

the value. @ ‘

Drag the dimension handle " near

the ruler to lock onto whole number
— 540
ruler values. -
— 840
— 680
%l!l
620

Where to Find It
0 CommandManager: Assembly > Instant 3D &

23 Change dimensions.

Click Instant 3D % and double-click the feature shown. Right-click the Frame part
and select Edit Part ©®. Double-click the feature and drag the handles on the
dimensions to resize them to the values 80mm and 300mm as shown.
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[

Double-click the feature and change the dimensions to resize them to 350mm and
530mm as shown.

Checking Clearances

What is the minimum clearance between the Sprocket and Frame? This question can
be answered using Clearance Verification = tool.

24 Edit the Assembly.

Click confirmation corner ~ ¢ to edit the assembly.
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25 Clearance.

Click Tools, Evaluate, Clearance Verification =.
Click Selected Items and select the Sprocket and Frame.

Type Omm in Minimum Acceptable Clearance and click
Calculate. The clearance is close to 18mm. Click ~

Selected Components Ll
E Frame™Frame&Suspension-1@Fr:

Rear Axle Assembly-1@Frame&tsu
4 LI} 3

(]

Check clearance between:
@ Selected items

= Selected items and the rest of
~ the assembly

SR 0.0000mm =

(=i
Calculate

Results hd

Fl E:'l Clearancel - 17.9625mm

% Frame”Frame&5uspensiol
% Sprocket-1 [Default] - Rear

Note: A visual check shows that there is no interference between the Sprocket and
Frame components, but they can be checked. For more information, see

"Interference Detection" on page 90.

Fully Defining a Component

The ENGINE component remains under defined, still able to rotate freely. It should be

fully defined to prevent inadvertent movement.
26 Open the ENGINE.
Right-click the ENGINE component and select Open Part [%.
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27 Add new plane.

Click View, Hide/Show, Temporary Axes. Add a Parallel
plane between the selected face and the temporary axis through
the hole as shown.

Filtering the FeatureManager Design Tree

' Plane ?
v X
Message ~
Fully defined
First Reference ~
@ .Face <1» J

< . enaine
IS@ 8 Frame&Suspension (RIDE<Dis

E © % " [ Frame”Frame&:Suspensi
= Enginel Folder
B N Enginel
u t Enginel_Sketch :|
@ @ structural MEmbEr_Enj
" = [ tngine2 Folder
= N Engine2
— t Engine2_Sketch
Sec
@ Structural Member_En
@ + [ Engine_Mount Folder
t (-) Engine_Mount
E % (1) ENGINE<1> (Default<<
D Coincident
Project

The FeatureManager design tree filter can be used to filter by name. Typing a name into
the filter will result in a list of only the features, sketches, components or mates that use

those characters.

28 Filter.
Return to the assembly. Click in the filter at the top of the
FeatureManager design tree and type engine.
Right-click Enginel sketch and select Show.
Click “x” to stop the filter.
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29 Mate.
Add a Coincident mate between the plane and the line in the sketch.

Interference Detection

Interference Detection is useful in finding interferences or clashes, between static
component parts in the assembly. The results show the interfering volumes in red.

Tip: To check interferences between solid bodies in the same multibody part, select the
multibody part only and click Include multibody part interferences.
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30 Interferences. B Interference Detection @
Click Tools, Evaluate, Interference Detection . v x
By default, the entire assembly is selected for interference Selected Components ~5
detection, so right-click in the Selected Components field | -
and select Clear Selections. — '

. Calculate
Select the ENGINE and Frame components and click
Calculate [ Excluded Components b
Results Ea

A total of four interferences are found combined into two
symmetrical sets. Click ~ .

O Interferencel - 903,7983mm
O Interference2 - 903,7983mm
O Interference3 - 538.0668mm

>
>
>
b O Interferenced.- 538.0277mm

m

4 I 2

DComponent\tiew

Options Ll
I:‘Treat coincidence as interference
|:| Show ignored interferences

DTreat subassemblies as
components

DIncIude multibody part
interferences

Make interfering parts Tm
transparent

31 Edit sketch.

Click in the filter at the top of the FeatureManager design tree and as before type
engine. Right-click the under defined (-) Engine Mount and select Edit Sketch
2. Click “x” to stop the filter.

Tip: This is a shortcut that puts you in Edit Part and Edit Sketch mode directly.

32 Drag.

Drag the open endpoint short of the ENGINE
component.
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33 Dimension.

Add a 5mm dimension between the edge of the
ENGINE and the endpoint as shown.

34 Edit assembly.

Click Edit Component ‘# to exit the sketch and
return to edit assembly mode.

Note: The sketch name has changed to Engine Mount-> denoting that it is fully
defined and contains external references.

Mounting Plates

The Frame is currently placed with reference to the
suspension points, but it is not attached. To create an actual
attachment, mounting tab plates are required.

Creating a Reusable Sketch

The mounting tabs used to attach the suspension to the Frame are plates that are rounded
on one end. Although all the tabs have a similar shape, the length and ends may vary. For
this reason, creating a sketch that can be easily copied and modified is a good solution.

1 New part.

Open a new part with units mm. Create a new sketch on the Front plane.
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2 Geometry and dimensions.

Create the geometry and dimensions using
these guidelines:

1

Create a centerline from the origin on a
slight angle.

Offset the centerline with the bi-directional
option (add dimensions off) to create the
sides.

Add a tangent arc to close the upper end.

Add a line between endpoints to close the
lower end.

Add a circle.

Add dimensions.

Lesson 3: Creating a Weldment

Note: The centerline is on a slight angle (not horizontal or vertical) and under defined

to make the placement flexible.

3 Drag.

Drag the lower corner endpoint. The under
defined sketch should rotate but maintain the
shape.

4 Save.
Save the part as TAB Sketch.
Exit the sketch but do not close the part.

SolidWorks SAE Design and Analysis Project
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5 Copy sketch.
Select the Sketchl feature in the FeatureManager design tree
and Edit, Copy.

Pasting the Sketch

% ’ TAB_Sketch (Default<<Default>
L4 History

Sensors
L4 Annotations

=
£ Msterial <not specified>

m Front Plan
‘[ﬂ Top Plane

W Right Plane

After editing the Frame part, the sketch will be pasted onto the face of a structural

member.

Tip: A common mistake in this situation is to paste the sketch before editing the part. The sketch
can be pasted, but is only useful as an assembly feature. An assembly feature is a feature
that exists only at the assembly level and can only be used to create a cut.

6 Edit part.

Return to the assembly, right-click the Frame part and select Edit Part .

7 Paste.

Select the face of the structural member as indicated. Click Edit, Paste.
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8 Edit sketch.
Right-click an edge of the sketch and select Edit Sketch [z.

9 Temporary axes.

Show the temporary axes by clicking View, Hide/Show, Temporary Axes. Select the
centerline and the temporary axis and add a Parallel relation.
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10 Concentric.

Select the circular edge and the circle and add a Concentric relation.

11 Extrude.
Extrude the sketch 3mm as shown.

4

Note: This part has been marked as a weldment ¥ wedament | 50 the Merge Result
option in extrude remains cleared.
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12 Repeat procedure.

Select the bottom face and create a new sketch. Convert edges from the previous body
to create the sketch and extrude the sketch 3mm as in the previous step.

Repeat for the remaining tabs on the same side and mirror.

13 Paste sketch.

Show Enginel sketch. Select the face, click Edit, Paste and edit the sketch. Add
a Concentric relation between the arc and circular edge as shown.
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14 Point.

Add a point on the centerline. Add a Coincident relation between the centerline and the
point. Use the point to add a Pierce relation between the point and the inactive sketch
line.

15 Trim and extrude.

Create the front edge of the structural
member using Convert Entity. Trim
the geometry leaving the centerline and
point intact as shown.

Extrude the sketch 3mm.

16 Plane.

Click Insert, Reference Geometry, Plane, sclect the faces and click Mid Plane.
Rename the plane Centered.

17 Mirror.
Mirror the body using the in-context plane.
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Weldment Cut Lists

The Cut 1ist folder list of all structural members in the weldment.

Note: In a non-weldment multi-body part the folder is named Solid Bodies.
18 Updating the folder.

Open the part Frame. @ @ Frame* Frame&iSuspension
Right-click the Cut 11ist folder and select Update to group > ) History
similar structural members in folders. , ;‘:"::t':ms

.

v ¥ Cut-ListTteml(2)
v ¥ Cut-ListTtem2(2)
v ¥ Cut-ListTtem3(2)
v ¥ Cut-ListTemd(2)
» ¥ Cut-ListTtemS(1)
@ Structural_Member
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Cut List Properties

The Cut-List Properties can be used to view detailed information about the individual
structural members including lengths and angles. Right-click a Cut-List-Item folder

and select Properties.

Cut-List Properties

Cut List Summary | Properties Summary | Cut List Table

[o o s

BOM quantity:

Delete |:|Exclude from cut list LENGTH -
b Cut-List-Iteml - Property Name Type Value / Text Expression Evaluated Value
B Cut-List-ltem2 1 | LENGTH Text |»|| "LENGTH@ @@ Cut-List-temll@Frame"Frame |184.21
Cut-List-Ttem3 2 | ANGLEL Text || "ANGLEI@@@Cut-List-Ttem11@Frame* Frame 45.00
Cut-List-Ttem4 =3 |anGLE2 Text |»|| "ANGLE2@ @@ Cut-List-Ttem11@Frame” Frame | 45.00
Cut-List-Item5 4 | Description Text hd
Cut-List-Ttemé 5 | MATERIAL Text x| "SW-Material @ @@ Cut-List-Ttem1l @Frame*F Material <not specifie
Cut-List-Ttem7 6 | <Type a new proper I

Cut-List-ltemd
Cut-List-Item10
Cut-List-ltem12
Cut-List-ltem13
Cut-List-Item14
-7 Cut-List-rem15
[ Cut-ListItemis
I Cut-List-tem17

WiViNINIVININININ NN

@ Cut-List-Item18 8
[ QK ] [ Cancel ] [ Help
For example, Cut-List-Iteml1 the following property i
values and are listed:
45°

LENGTH=184.21
ANGLE1 =45.00

A drawing of the structural member would look like this:

Save as External File

The virtual part can be saved externally, creating a part file

outside of the assembly file.

Note: You cannot create a drawing of the virtual part until it is (

saved to an external file.
19 Edit the Assembly.
Return to the assembly.
Click confirmation corner

20 Save external.

45°

18421

% to edit the assembly.

Right-click the virtual part and select Save Part (in External File). Click Same As

Assembly and OK.
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Note: The name changes slightly. The braces surrounding the name ([, ]) are
removed.

21 Save and close all files.
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Lesson 4: Using Molds and Surfaces

When you complete this lesson, you will be able to:
O Understand the loft feature.

Q Describe the bodies created using the mold tools.
O Use surfaces to add to the mold tools.

O Use symmetry to create additional molds.
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Molds and Surfaces

The Mold Tools commands can be used to create the mold tooling for a part. The mold
tooling is created using a set of surface and solid bodies in the same part. Like the

weldment, it is a multibody part.
1 Open assembly.
Open the assembly Intake Assembly from the Mold folder.

plenum

restrictor

intake
connection
boot

2 Open assembly.
Open the assembly Frame&Suspension from
the Lesson 3\Frame&Suspension folder.
This is the assembly used in the previous lesson.
Add the Tntake Assembly assembly to the

main assembly. Mate the sub-assembly using one
concentric and two coincident mates.
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3 Open runner.
Right-click one of the instances of the part runner and select Open Part .

The runner part

The actual runner part is created in two pieces, a right and a left, that are later assembled
into one. Each piece requires a mold.

Features in the Part

The model of the runner part is created using three main boss features: the Be11, the
Straight Boot Section andthe Center Guide Curve.
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The revolve feature named Be11 is used to connect the runner
components to the plenum.

The extrude feature named Straight Boot Section isused to
connect the runner components to the intake connection boot
components.

This feature must fit inside the intake connection boot.

The loft feature named Center Guide Curve
smoothly connects the revolve and extrude features.

For more information about loft features, see "Anatomy of a Loft" on page 105.
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Anatomy of a Loft

The loft feature is used to transition between different profile shapes. In this example, the
starting profile is a slot shape that transitions to a circular shape.

Profiles

Profiles represent the starting, ending and optionally intermediate shapes along the loft.
They are closed contour sketches or curves.

Centerline[Sketchd)
C

Guides

A centerline is a guide used to orient the profiles in transition. A guide curve is used to
shape the loft. Guide curves are open contour sketches or curves.

& Centerling[Sketchd) & Centerline(Sketchd)

% Profile[Sketch2)

Loft with Guide Loft without Guide
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Creating Mold Tooling

SolidWorks contains a series of mold tools that can be used
to analyze and create mold tooling starting with the molded
part.

If carbon fiber is used, the cavity solid body is the desired
mold. When the carbon fiber is created, the thickness will
be applied to the inside maintaining the outside dimensions
that fit into the intake connection boot
components.

This example assumes carbon fiber is used.

Surface and Solid Bodies

The mold tool procedure creates multiple bodies, including sets of both  + [@ setasediesi)
surfaces and solids, in a single part file. For more information see g:“lizﬂﬁl

"Surface and Solid Bodies" on page 106. © Tooling Spi1[2)

- Surfa(EEnd\es(EJ
ﬁ @ Surface Bodies
o
2
0

- @ Cavity Surface Bodies(1)
@ Parting Linel[3]
Solid Bodies
Note: A multibody part, like a weldment, is created.

- @ Core Surface Bodies(1)
@ Parting Linel[2]

v @ Parting Surface Bodies(l
@ Surface-Knitl
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Each of the resulting solid and surface bodies are created for a specific purpose. They are

described below.
Molded Part Parting Surface
Cavity Solid Cavity Surface
Core Solid Core Surface

SolidWorks SAE Design and Analysis Project
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Mold Tools

108

The mold tools are designed for use with plastic injection molding, but they can be
adapted for use with other manufacturing methods. The sequence shown here is typically
used. The result is a multibody part with bodies representing the molded part, the core, and

the cavity.

Scale &

Scales the molded part to account for
shrinkage in some materials. Not used
in this example.

Analysis Tools

Draft Analysis @ and Undercut
Analysis @ are used to see if the
part can be removed from the mold.
Parting Line Analysis &> is used
to visualize potential parting lines.

Split Line &

Breaks up model faces by adding
edges.

Parting Lines ©

Uses model geometry to define the
parting line edges that define the
parting surface.

Shut-off Surfaces &

Adds surfaces to close holes in some
molded parts. Not used in this
example.

Parting Surfaces &

Surfaces created from the parting
lines to separate the mold cavity from
the core.

Surfaces

Many surfaces types can be used to
supplement or replace the parting
surface depending on the complexity
of the model.

Tooling Split &

Creates both the core and cavity solid
bodies by splitting a solid.

Note: The options scale and shut-off surfaces are not used in this example.

Tip: Most of these tools are on the Mold Tools tab of the CommandManager. Right-click an
existing tab and select Mold Tools to display the tab.
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4 Configuration. b Add Configuration @

Create a new configuration, Mo1d, to hold all the mold features. v x

Make sure that Suppress features under Advanced Options  counguration properties ~
is checked. The new features will be suppressed in the cenfiguration name:
Default configuration.

Mald

Description:

I:‘ Use in bill of materials

Comment:

-
Bill of Materials Options hd
Advanced Options ~

Suppress new features and mates
D Suppress hew components
I:‘ Use configuration specific color

Colar..

[] Add Rebuildysave Mark

5 Add the MOld TOO]S Tab. Features
Right-click an existing tab on the CommandManager and click e
Mold Tools. The Mold Tools tab is now displayed on the Shest atal
CommandManager. Weldments
[ v motd Tools
Data Migratlbo\?n
Direct Editing
Evaluate
6 Draft analysis. B @
Click Draft Analysis @ from the Mold Tools tab in the v X
CommandManager and select the Right plane. Set the Draft — aaysis parameters ~
Angle to 1deg and click ~ . Right Fane

|l“ 1.00deg o
[T adjustment triad
[T Face classitication

Color Settings Ll
[T Gradual transition

FPositive draft:

I o o,
Requires draft:
Megative draft:

I o
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What Does This Mean?
This means that the angle between the Right plane and the yellow

faces is 1deg or less. It is in fact 0deg because they are perpendicular.

Note: This small undrafted area is not a problem using carbon fiber,
but it would cause problems for other materials.

7 Display off.
Click Draft Analysis @.

8 Undercut Analysis.

Click Undercut Analysis @& and select the Right plane. Click v x
x . This confirms that the mold should be created in two pieces.  anayss parameters ~

DCoordinate input

2N

[ adjustment triad

Undercut Analysis @

Highlight occluded regions

Undercut Faces Lo

Directionl undercut:

|§| 1 Edit Calar...
Direction2 undercut:
) Co—
Cecluded undercut:
EE—
: - — - Straddle undercut:
™ i o ~ MO undercut:
R 5 Edit Colar..
9 Split line. @ split Line @
Click Split Line @ and click Intersection. Select Right plane ¥ *
and the faces that intersect that plane. Click « . Type of Spiit ~
() Silhouette
() Projection
P ] @ Intersection
; -~""// E: e Selections ~
' ) [
@ Face=1= -
Face=2=
Face=3= E|
Face<4»
Face=5=
Face=f=
Face=7= i
°
R r Surface Split Options ~
\'x‘ _/-"/ [ split all
™~ : /,-""'. @ Matural
“"\-\_\_ _'_,,// () Linear
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10 Parting line. © Parting Line @
Click Parting Lines ©, Select Right plane and set the Draft v ox

Angle to 1deg. Message ~
Click Draft Analysis. e e tm s deedioon
Mold Parameters -~

T —

| onttanasis |
H EE

Use for Core/Cavity Split
Split faces

(@) &% +/~ draft transition

At specified angle

11 Edge selections.
Select the starting edge as shown. n

Click Select Next Edge || (or type “n”) and then Add
Selected Edge [z (or type “y”).

Continue the selections using the selection
tools.
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Continue selecting edges to complete the loop of selections as shown. Click .

12 Parting surface.

Click Parting Surfaces & and select Perpendicular to pull. Set
the Distance to 30mm and click Knit all surfaces. Click Sharp
= and click .

)

| Minimurm radius of Curvature; 13,841 mm |

Note: The parting surface is not always large enough to be able to
split the mold.

% Parting Surface @
v X
Message Lal

Select a parting line feature or model
edges to create a parting surface
Mold Parameters Lal
() Tangent ta surface
() Mormal to surface

@ Perpendicular to pull

Parting Line Lal

@ Parting linel

Parting Surface ~

30.00mm e

|l“ 30.00deg —

Smoothing:

&y [ 3.40mm —

Options Eal
Knit all surfaces

Show preview
|:| Manual mode

»
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Using Surfaces

Surfaces often must be used to fill in or complete the surface geometry started by parting
and shut-off surfaces. Here is a partial list of surface tools found on the Surfaces tab of
the CommandManager.

Q

0O O 0O O 0O O O

13 Extend edges.

Extruded ¢, Revolved @
Swept #°, Lofted 4
Planar @

Ruled &

Knit 7]

Filled @

Extend &, Trim &

Offset ©

‘& Extend Surface @
Click Extend Surface & and select three edges as shown. Click v x
Distance, set the value to 30mm and click ~. Edges/Faces to Extend ~

Face=1=

Repeat the process for five edges on the opposite end. Face<2-

/ e End Condition: ~
/ / @ Distance
/ () Up to point
{ () Up to surface

/ &y 0.00mm e

Extension Type ~

@ Same surface
) Linear
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14 Planes.

Create planes offset 1770mm from the Front and 60mm from the Top as shown.

15 Trim. & Trim Surface @@
Click Trim Surface & and sclect Standard. Select the v x
Plane3, Keep selections and select inside the plane. Click v . ranrype ~
Repeat the process for the opposite end. © standars
Selections Ea
Trim toal:
Q Plane3

@ Keep selections
() Remave selections

Surface-Extend2-Trim1

&>

(]

Surface Split Options Ll
split all
@ Matural

() Linear
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16 Sketches.

Click the parting surface and select Sketch (Z. Using converted entities and lines,
create the two sketches as shown. Exit both sketches.

17 Planar surfaces. 8 Plaar Surtace @
Click Planar Surface @ and select a sketch. Press Enter to v X
repeat the command and repeat the procedure for the other planar  sounging entities ~
surface. O EEEm
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18 Knit surface.

m Knit Surface @
Click Knit Surface {i] and sclect the three surfaces. Click Merge v x
entities and click . Selections ~
¢ Surface-Plane2

Surface-Planel

Surface-Trim2

I:‘Creai_:e solid
Merge entities

19 Drag and drop.

Drag and drop the Surface-Knitl body into the Parting Surface Bodies
folder as shown.

@; ﬂ runner (Meld<Display State-7>) _‘@J ? runner (Mold<Display State-7>)  *

4 Histary + History
L4 Annotations + Annotations
3 Solid Bodies(1) 3 Solidl Bodies(1)
4 Surface Bodies(3) 4 Surface Bodies(3)
’ Cavity Surface Bodies(l) » Cavity Surface Bodies(1)
4 Core Surface Bodies(1) 4 Core Surface Bodies(1)
Parting Surface Bodies Parting Surface Bodies
¢ Surface-Knitl Q Surface-Knitl

Note: The surface must be moved because it was created manually using extend,
planar and knit surfaces.
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20 Tooling split sketch.

Click Mold Tools > Tooling Split & and select the knitted surface as the sketch plane.
Create the sketch and dimensions as shown.

250
21 Tooling split sizing. 7 Tooling Spit @
Exit the sketch. Set the Depth In Direction1 and Depth In v x
Direction2 to 50mm as shown. Click + . P ~
{’3 50.00mm =
{’3 50.00mm =
I:‘Interlock surface
Core Ea
@ ‘ Parting Line1[2]
Cavity ~
Y
Parting Surface Ll

@ I Surface-Knitl
-
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22 Test measurements.

Right-click the first (Parting Linel)solid body inthe Solid Bodies folder and
select Isolate. Click Tools, Evaluate, Measure and measure the distance between
endpoints as shown. The key dimension is Dist 56.45mm as shown.

23 Exit isolate.
Click Exit Isolate on the Isolate dialog.
24 Isolate cavity solid.

Isolate

N+ @ (e

Right-click the third solid body in the Sol1id Bodies folder and select Isolate. The
key dimension is the again Dist 56.45mm as shown.

U 54.55mm
.

This shows that the outside faces are used to create the mold. Click Exit Isolate.

118

SolidWorks SAE Design and Analysis Project



Lesson 4: Using Molds and Surfaces

Making Use of Symmetry

Individual bodies can be saved into new part files. This creates an external reference from
that single body to the part file.

The other half of the mold is symmetric to the current one. It can be created using a
mirrored part. The mirrored part is derived from the original part but mirrored using a
plane or planar face.

runner -> mirrored part

‘NP

runner-> runner-Cav_1-> runner-Cav_2-

Note: Ifthe other mold is not symmetrical to the first, a similar procedure can be
followed using slightly different selections in the Parting Line feature.

25 Stock feature.

Right-click the cavity surface body in the Surface Bodies folder of the
FeatureManager design tree and click Insert into New Part. Use the name runner-
Cav_1. A stock feature Stock-runner-1 is created.
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26 Mirror part. 2 fnsert Pt & @
Select the back face of runner-Cav_1 asillustrated. Click v *
Insert, Mirror Part... Click ~ . Save the part as runner- Transter A

[¥] 50lid bodies

Cav_2. Sur‘face bodies
[T ices
Planes
[V] Casmetic threads
Absorbed sketches
[Clunabsarbed sketches
Coordinate systems
[T Model dimensions
Hole wizard data
D Sheet metal information
|:| Unlocked properties
Link A
Break link to original part
+
27 Holes.
R@turn to the runner-Cav_1 part. Select the outer face and 5 ... ccication @
click Insert, Features, Hole Wizard . Add 10mm through ,
. Click .
all holes placed as shown. Click EETEE—
20 Favorite R
20 Hole Type Ea
29
! @ (||
) @)
Standard:
[anst Metric -
L Type:
[Drill sizes v]
Hole Specifications Ll
8 " * Size:
[#10.0 ~

Show custam sizing

End Condition Ca
[Through A -
Options hd
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28 New assembly.

Create a new assembly and add the runner-Cav_1 and runner-Cav_2 parts.
The holes have been transferred to these parts using the external references.

29 Save and close all files.
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Lesson 5: Brake Rotor Analysis

When you complete this lesson, you will be able to:
O Set up and run a thermal analysis.

O Post process thermal results.

O Set up and run a static analysis.

O Apply thermal loading to structural analysis.

O Post process static analysis.
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Brake Rotor Design

When a vehicle is in motion, it is said to have kinetic
energy. Brakes are designed to stop the vehicle by
absorbing the kinetic energy of the vehicle and dissipating
it in the form of heat.

The kinetic energy of a vehicle is given by the following

equation:
KE= %mv2

where m is the mass of the vehicle and v is the velocity of
the vehicle. If the mass of the vehicle is large, or the
velocity is large, this can amount to a large amount of
energy dissipated in the form of heat. The braking mechanism must be able to withstand
both the temperatures generated by this heating as well as the forces incurred during
breaking.

In this lesson, we will investigate the design of the braking rotor. The vehicle will be
moving at full speed and will be braked to a complete stop. First, a thermal analysis will
be run to calculate the temperature distribution in the brake rotor during braking. Next, a
static analysis will be run to see the affect of the thermal load as well as the forces that
come with the brake pads.

1 Open Brake Rotor Assembly.

Click File, Open and select the assembly Brake Rotor Assembly. Click Open to
open the assembly.

Activate the configuration called Sp1it Line. It contains the model with necessary
changes so that we can run the analysis properly.

2 Start SolidWorks Simulation. Addns =
Click Tools, Add-Ins. Select SolidWorks

[ SOLIDWORKS Pre mium Add-ins

Simulation. [CISGH circuitiorks
88 Featurswarks

1 [C1€M Protoview 350
Click OK. H
[)ET, SOUDWORKS Design Checker
D@ SOLIDWORKS Motion

|98 soumwoRks Routing
@ SOLIDWORES Simulation

Start Up |00

<15
=15

VI SOLIDWORKS Toolbox Library
SOLIDWORKS Toolbox Utilities
% sotmworks Utiities

(7] EI Talsnalyst

OooOeEpoooooa

m

5 SOLIDWORKS Add-ins

[l sutotrace

SOLIDWORKS Compaser

[T/ SOLDWORKS Electrical
SOLIDWORKS Flow Simulation 2016
T2 SOLIDWORKS Forum 2016

[C1 88 SOLDWORKS Inspection

[ SOLDWORKS Plastics

1s
<15

OEEREOEO

= Other Add-ins

] SOLIDWORKS 3DEXPERIENCE Smartlink ]
[l sOUDWORKS Sacial 2016 ]
[ SOUDWORKS ¥PS Driver 2016 =] il
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SolidWorks Simulation functions are accessed in the same way as SolidWorks. When a
simulation study is created, a Simulation Study tree appears beneath the FeatureManager
design tree. Each new study that gets created is represented by a tab at the bottom of the
screen. Like SolidWorks functions, Simulation functions can be accessed from the
Simulation toolbar, CommandManager, or Simulation drop-down menu. Additionally,
functions can be selected by right-clicking geometry or items in the Simulation Study tree.

Q- ?2-_0Ox

pi
_|DS SOLJDWORKS‘ File Edit View Insert Tools | Simulation | Window Help ‘ﬂ‘l 0O-® % g [H] {8 ~ Brake Rotor A. Search Cammands
f \ | | EXTEEITEREY SE TR TE T L 1)

Y LN LR E T EEL L=

£, Roller/Slicer-1
~ L} Extemal Loads
LU Pressure-1 (:1000000 N/m*2:)

Simulation Study

=y = [ i} = = 141 % = B pesign nsignt Repart
Study Fixtures External Loads Connections RunThis Results = .
ot MAppI? i e e e Shell Study | Advisor | DEformed | Compare e FlotTools @ Include Image for Report
aterial Manager Result Results
Assernbly | Layout | Sketch | Evaluate | SOLIDWORKS Add-Ins | Simulation | SOLIDWORKS MED | Flow Simulation | |« Simulation Advisor X
o Model name:Brake Rotar Assembly % ¥ 7 @B &l - -
@ IE e 5 Study name:Thermal Stressi-Split Line-) < o EE R @ L] q % ﬁ l:l L —2:g
E -E- Plot type: Static nodal stress Stress1 l
Deformation scale: 46,1313 CommandManager tab ] ] udy o
" Simulation 2 Bodies and Material  +7|
+ €& 8 Rotor - Castlron<1> (Split Lin * . 3 Interactions |
() Rtor Washer<1> Deaut) smision @ |_gq_~ToOlbar Advisor 4Mehadfn
(-) Rotor Washer<27> (Chamfer L=EH T ] uon Mises (H/m2] 5 Results |
(-) Roter Pin<6> (.5) ‘i @ & 2.206e+ 008
2 To help you create the
: I@@MH+ = 2.022e+008 proper study, select one of
- | L839e+ 008 HiEns
?v - LE55e+008 lam concerned about
. excessive deformation or
X Thermal Stress (-Split Line-) | L47le+003 ey
M-S . 12876003 Tam concemed about
» & Rotor - CastTran-1 (-Gray Castrq L 10des 003 B ST
v T Rotor Hat-1 (-Gray CastIron-) 5=
. & [ 9.139e+007 1am concemed about
§% Connections 1 362es 007 [ sudden collapse under
+ & Component Contacts b compression,
~ (5 Fidtures - 55248007 Tam concermed about
Fixed-1 3.687¢+ 007 CERHEE

L850e+007

L248e+005

E lam concerned about
temperatures,

L Thermal . | e
@ue  Simulation tabs
Result Oplmnsstudy tree
- [ Results I
1% Stress1 (-vonMises:) 4
18’ Displacementl {-Res disp-] /;'
& strainl (-Equivalent-) b4 2 ,\._e? .;f/ 2
[T Model [ 3D Views | Motion Studyl | § Temperature Distribution | % Thermal Stress | -
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3 Create a study.

From the Simulation drop-down menu, select Study. v ox w

Select Thermal as the Type.

Enter Temperature Distribution asthe Name.

Click v .

The FeatureManager design tree will split and a Simulation

Message Ll

Study temperature distribution and
heat flow due to conduction,
convection and radiation

Name ~

Temperature Distribution

study tree will be created below the FeatureManager design =~ ™™ .

tree.

The setup of the study is done using the Simulation study tree.

Adjust study properties.

Frequency

al
Cﬁ« Buckling

m

Right-click the study name at the top of the Simulation study g5 oraprest
tree and select Properties.

Under Options, select Transient and enter 3 sec as the Total

time.
Click OK.

Therrmal

Options | Remark

Solution type

@ Transient: Steady state:

Total time: 3 sec

Time increment: 01 ELY

Initial temperatures from thermal study

1

Include fluid convection effects from SOLIDWORKS Flow Simulation
Fluid convection option

SOLIDWORES model name
Configuration name
Flowy iteration no.

Salver

Automatic Solver Selection

FFEPIus hd

Results folder ChllsersscgrdhDocuments\SAE\Lesson 3vF |

Advanced Options..,

[ (814 ]| Cancel || Help

Qz Fatigue

C@ Pressure Wessel Design
E& Design Study

% Submodeling

d;— Monlinear

||&'|I Linear Dynamic
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Transient Thermal Analysis

This model is run as a transient analysis because we want to study the heat distribution
during braking from a speed of 22 m/s to a complete stop. We can easily calculate the time
it takes to stop by first calculating the force it takes to stop the vehicle. We know that the
vehicle is 275 kg and we assume the coefficient of friction between asphalt and rubber is
0.72. To stop the vehicle in the shortest time, the maximum braking force cannot be larger
than the maximum friction force between the tires and the ground, which can be
transmitted to the ground. This maximum friction force is calculated as follows.

Ff =u-m-g= (0.72)(275kg)(9.81m2)= 1942 4N
‘ S

Now that we know the friction force, we can calculate the average acceleration of the car

during braking.
F
g = = 19424N_ . om
Y m 275kg =
Finally, we can calculate the time it takes to stop.
m
22—
v
f= 2= 2 =3
“ 7065

5 Apply material.
Right-click the Parts folder and select Apply Material to All.
Select Gray Cast Iron under Iron asthe material. Click Apply, then Close.
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Thermal Boundary Conditions

SolidWorks Simulation solves for the temperature distribution in the solid using the
conduction equations and boundary conditions applied to the boundaries of the model.
SolidWorks Simulation has several thermal boundary conditions that can be applied to
thermal studies.

0 Temperature
Allows for the definition of a temperature on a certain entity or body.

O Convection
Applies a convection boundary condition to the selected faces. The convection coefficient and
ambient temperature are specified and the heat lost due to convection is calculated
automatically.

O Heat Flux
Applies some amount of heat into a face per unit area.

O Heat Power
Applies some amount of heat to a vertex, edge, face or component.

0O Radiation
Allows surface-to-surface or surface-to-ambient radiation.

In our model, we will apply convection to all faces because all of the faces will be exposed
to the air. In addition, we will apply a heat power to the faces that the brake pads touch.

Convection

128

Convection is the transfer of thermal energy between a surface and a fluid. The amount of
heat transferred through conduction is proportional to the convection coefficient, 4, the
surface area, 4, and the temperature difference between the surface and the surrounding
fluid.

Qconvection: hA(Ts - Tf)

In this lesson, we will assume a convection coefficient of 90 W/m”2. K and an ambient
temperature of 20°C, which are approximations. Actual convection coefficients and
ambient temperature could be computed by running a CFD analysis in SolidWorks Flow
Simulation or from experiments.
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6 Apply thermal load.

Right-click Thermal Loads in the Simulation Study tree
and select Convection.

Select Select all exposed faces in the Convection
PropertyManager. This will choose all of the exposed faces
for the convection boundary condition.

Enter 90 W/m~2.K as the Convection Coefficient.

Enter 293 Kelvin as the Bulk Ambient Temperature.

Convection ®
v X .
Selected Entities Ea

@ Face=1=@Rotor- CastIron-1 .
Face<2= @Rotar - CastIron-lD
Face=<3>@Rotor- CastIron-1
Face= 4= @Rotor - CastIron-1
Face<5>@R0to{E- Castlran-1 7

Select all exposed
faces

<]

Units Ea
B (= 7)
Convection Coefficient Ca
ﬁf 30 - Wi mALK

Edit... Graph

Lesson 5: Brake Rotor Analysis

Q.g Temperature Distribution (-Default-)
L4 @ Parts
< ?; Connections
L4 @ Component Contacts
QY Thermal Loads
G Y
Re

Hide All

Show All

a Temperature...

H;ﬁﬁ l}aﬂvection...

Edit... Graph

Convection Coefficient (A [mA 2K |90

Bulk Ambient Temperature [Kelvin [K]]:[ 293

Bulk Ambient Temperature Ll

4 2 - Kelvin ()

Edit... Graph
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7 Edit Time Curve.
Click Use Time Curve and select Edit.

Column X denotes the time and column Y denotes the multiplication factor that will be
applied to the convection coefficient that was entered.

Enter (0, 1) and (3, 1) in the table. This will represent the convection always being

turned ON.
Click OK.
Time curse 3
Curve infarmation Preview
Mame Time curve
Shape | User defined -
Curve data
Units |sec v| |NIA v|
Paint:| ¥ ¥
1 ] 1 Get curve..,
2 3 1
Save curve..
Wiew
End time = 3 sec
(814 | | Cancel | | Help
Click ~.

Note: Similar to the time dependence of the loading using time curves, any thermal
load can be made temperature dependent using temperature curves. Solutions
with temperature curves are significantly more time consuming as convergence
iterations are required because each finite element can generate a different level
of heat power based on its average temperature.

Heat Power

As the vehicle is braked, the rotor is spinning and the brake pads are rubbing against the
surface of the rotor, creating friction and heat energy. Much of the kinetic energy of the car
is being transferred to thermal energy through the brake pads. The heat power will be
applied to the brake rotors in the area that the pads touch.

The amount of heat power can be calculated from the amount of kinetic energy carried by
the car. If we assume the mass of the car is 275 kg and the car is traveling at 25 m/s, the
kinetic energy of the car is as follows:

1,1 m\?
KE= Smvi= 5(275kg) 22; = 66.55kJ
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If we assume all of that kinetic energy is transferred to thermal energy during braking that
lasts 3 seconds, we can calculate the heat power.

HeatPower= KE_ 66.55k]_ 22 18kW
At 3s

Since we will analyze only one pad, and about 60% of the mass of the vehicle will be on

the front, the heat power is reduced.

42.95kW(0.60)
2

HeatPower= = 6.66kW

8 Apply thermal load.

Heat Power @

Right-click Thermal Loads in the Simulation Study tree v x -

and select Heat Power. Type | Split
Select the four faces of the rotor that the brake pads touch. SRS -

Enter 6660 W as the Heat Power. T IS

Face=2>@Rotor - CastIron-1

Select Total Face< 3= @Rator - CastIron-1

Face< 4= @Rotor - CastIron-1

Select all exposed
faces
() Per item

Heat Power Ca

e .

L; £560 - |

I:‘Re\terse direction

@ Edit.. i |
Edit... iews
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9 Edit Time Curve.
Click Use Time Curve and select Edit.

Column X denotes the time and column Y denotes the multiplication factor that will be
applied to the heat power that was entered.

Enter (0, 1) and (3, 1) in the table. This will represent the heat power always being
turned ON.

Click OK.
Time curse @
Curve infarmation Preview
Mame Time curve
Shape | User defined -
Curve data
Units |sec v| |NIA v|
Paint:| ¥ ¥
1 0 i | Get curve |
5 s 1
| Save curve.. |
| Wiew |
End time = 3 sec
(814 ] | Cancel | | Help
Click ~.

10 Initial temperature.
Right-click Thermal Loads in the Simulation Study tree and select Temperature.
Select Initial temperature.
Select the assembly from the fly-out FeatureManager design tree.
Enter 25 C as the Temperature.
Click v .

11 Mesh the model.

Right-click Me sh in the Simulation Study tree and select
Create Mesh. Use Curvature based mesh and default
element size.

Click v .

12 Run the study.

Click Run from the Simulation drop-down menu.

Note: The study should take several minutes to run. A calculation is performed at
each time step as specified in the study properties. Results will be available for
each time step performed.

Tip: Be careful when specifying the time step magnitude so that accurate resolution of your
loading curve is obtained.
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We will now look at the various post processing options associated with transient thermal

analysis.
13 Plot Temperature distribution.

Right-click the Thermall plot of the temperature
distribution and select Edit Definition.

Change the Units to Celsius.
Make sure the Plot Step is set as 30.
Click +.

Temp [Celsius)
8.786e+ 001
l §.25Te+001
L T.727e+001
- T.19%e+001
_ 6.668e+ 001
. 6.139e+001
| 5.609e+001
L 5.080e+001
L 4.551e+001

L 4.021e+001

3.49z2e+001
2.962e+001
2.433e+001

14 Probe.

Right-click on the temperature plot in the Result folder and
select Probe.

Select any location on the brake rotor.
Click the Response button |5 under Report Options.
A plot of temperature vs. time will appear.

Study name:Temperature Distribution(-5plit Line-)
Plot type: Thermal Thermall

7000
B0.00

50.00

Temp [Celziuz)

40.00

30.00

20.00
010 0.68 1.26 1.84 242 3.00 358
Time [z2c)

—— HNode 2031

230047, BA.ET26
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[} Thermal Plot @)
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& = :
Probe Result @

L A

Options L

@ At location

From sensars

() On selected entities

Results ~

Mode | %Walue [Celsius] |[X[in) |Y(in) |2 (ir
2031 6.227e+001 90823 43370 546

] [ +
Statistical Data ~
Walue

Summ 62.27 Celsius

Awg 62,27 Celsius

Max 62.27 Celsius

Min 62.27 Celsius

RMS 62.27 Celsius

Report Options ~

A B [ ]

133



Lesson 5: Brake Rotor Analysis

Click ~.
Note: You can do this with any of your created plots in a transient thermal analysis.
15 Plot Resultant Heat Flux.
Right-click Results in the Simulation Study tree and select Define Thermal Plot.
Select HFLUXN: Resultant Heat Flux as the Component.
Make sure the Plot Step is set as 30.

Click .
HF M i a2
1.067e+006
. 9.782e+005
_ 8.593e+005
_ G.003e+005
_ T11de+005
L 6.225e+005
L 5.336e+005
L 4.4dbe+005
_ 3.557e+005
_ 2.668e+005
1.779e+005
l 8.893e+004
T.000e+000
Tip: You can also select Plot Bounds across All Steps from the Plot st sep ~
Step menu. This will look through all solution time steps and »
plot the maximum or minimum values. © Maximum

Minimum

Note: You can also plot the temperature gradient. In addition,
you can plot the directional components of each thermal
result quantity. You are encouraged to try these plots.

Absalute Maximum

Static Study

We now know the temperature distribution after the vehicle brakes from 22 m/s to a
complete stop. This temperature distribution will be transferred into our static study as a
thermal loading condition and the material will be allowed to expand or contract as a
result of the temperature distribution. In addition, we will apply a loading condition to
simulate the load that the brake pad would apply to the rotor. We want to insure that the
brake pad will not warp significantly during this extreme braking situation.

16 Create a study.
From the Simulation drop-down menu, select Study.
Select Static as the Type.
Enter Thermal Stress asthe Name.
Click ~.
17 Apply material.
Right-click the Parts folder and select Apply Material to All.
Select Gray Cast Ironunder Iron asthe material. Click Apply, then Close.
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Tip: You can also copy the materials from the thermal study by selecting the Parts folder in
the thermal study, then dragging and dropping it onto the static study. Other study
parameters can be copied similarly.

Temperature Dependent Material Properties

Material properties are often temperature dependent. You can make your material
properties temperature dependent in SolidWorks Simulation by creating a custom defined
material and selecting Temperature Dependent under where you enter the parameter
value.

Fixtures

The fixtures in your study will represent how the structure is attached to the real world. It
is always best to pick the type of fixture that best represents the attachment to the real
world. The following type of fixtures are available in SolidWorks Simulation:

O Fixed Geometry
Fixes all degrees of freedom. Also known as a rigid support.

0 Roller/Slider
Specifies that a planar face can move freely in the plane, but is restrained normal to the plane.

O Fixed hinge
Can be applied to a cylindrical face and only allows movement about the axis of the
cylindrical face.

0 Advanced Fixtures

Allows for different types of restraints in various directions. Feel free to review the help menu
to investigate these types.

18 Apply fixture.

Right-click Fixtures in the Simulation Study tree
and select Fixed Geometry.

Select the face on the inner diameter of the rotor hub
where it would be mounted to a shaft.

Click v .

Note: We are applying a rigid restraint to the shaft mounting location. With this,
comes the assumption that the shaft will not deform under any applied loading
transferred through this mounting location. For this example, we are assuming
the shaft is much more rigid than the rotor hub. If we expect the shaft to deform,
we would need to include it in the analysis.
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19 Apply fixture.

Right-click Fixtures in the Simulation Study
tree and select Roller/Slider.

Select the split face on one side of the rotor where
the fixed brake pad will rub the rotor.

Click v .

Discussion

Typically, the brake calipers are designed such that one pad applies a load to the rotor to
push it into the other pad. With this restraint, we are simulating the stationary pad and
assuming that the pad will not deform under the loading. We will now apply the loading.

Loading

Like the fixtures, the loading in your structure should best represent the in-service loading
conditions. The following types of structural loading is available in SolidWorks
Simulation.

Q Force
Applies a force to an edge, face, or vertex in the direction defined by reference geometry.

a Torque
Applies a torque about a reference axis.

Q Pressure
Applies a pressure to a face.

O Gravity
Applies linear acceleration to parts or assemblies.

O Centrifugal Force
Applies an angular velocity and acceleration.

O Bearing Load
Defined between contacting cylindrical faces.
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20 Apply load. Pressure @
Right-click External Loads inthe Simulation Study tree Vo
and select Pressure.
Select the split face where the brake pad will push against the e ~
rotor R tts
Enter 1€6 N/m*2 as the Pressure Value. This value can be VY | et cation

known from experiments.

Pressure Value A

B [nmn2 -

WL 1e+008] - HimA2

D Reverse direction

Click +.

Braking Force

In addition to the load applied to the rotor through the brake pad, there is also a frictional
component of the braking force in the circumferential direction. If we know the normal
load applied to the bracket (1 MPa) and the friction coefficient between the rotor and pads
(0.6), the frictional force can be calculated using the area of the pad application.

Fy=u-Fy = (0.6)-(1><106—]i2 - 8.2781><10*4m2) — 497N
m

Note: The frictional coefficient between the pad and rotor can often vary depending
on the temperature. Using 0.6 as the friction coefficient is a simplification made
in this example.
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21 Apply load.

Right-click External Loads inthe Simulation Study tree

and select Force.

Select the two split faces on the rotor where the brake pads

make contact.

Select Selected Direction.
Select Axis1 ofthe Rotor Hat part as the reference.
Select the Circumferential direction and enter 497 N.

Click v .

Force/Torque @
v X .

Force/Torque L

Farce
% Tarque

@ Face=1=@Rotaor - CastIron-1
Face=2=@Raotar - CastIron-1

() Mormal

@) Selected direction

@ £xisL@Rotar Hat- 1@Brake Rotar £

@ Per item

) Total

Units ~
B [ -
Force ~
43| |1 N
g 47 .

|:|Re\u'erse direction

Note: When an axis is selected as a reference, the coordinate system changes to
cylindrical coordinates and our load can be applied circumferentially.

Thermal Loading
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Now that the structural loadings have been applied, we need to apply the thermal loading.
We want to apply the maximum amount of thermal loading seen during the braking. This
is obviously the temperature distribution at the end of the braking. The temperatures
solved for in the thermal study will then be transferred to the static study and the material
will be able to respond to the change in temperature. This will cause additional

displacement and thermal stresses to develop in the structure.
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22 Adjust study properties.

Right-click the study name at the top of the Simulation study tree and select
Properties.

Select the Flow/Thermal Effects tab.

Select Temperatures from thermal study and select Temperature Distribution,
Time step 30 as the Thermal study.

Enter 298 Kelvin as the Reference temperature at zero strain.

Static @

Options | Adaptive | FlowThermal Effects | Remark

Thermal options

Inputtempneratre

@ Temperatures from thermal study

Thermal study: | Temperature Distribe | Time step: | 30]

For each nonlinear time step, use temperature from

Ternperature from SOLIDWORKS Flow Simulation

SOUDWORKS model name
Configuration name
Temperature from time step @

Reference temperature at zero straint 203 Kelvin (K] - |

Fluid pressure option

Include fluid pressure effects from SOLIDWORKS Flow Simulation

SOLIDWORKS model name

Configuration name

Flowy iteration na.
Use reference pressure [offset] in fld file
Define reference pressure (offset] 1]

Rur as legacy study [exclude shear stress)

Canicel Apply Help

Click OK.
The Thermal load will appear in the External Loads folder.
23 Mesh the model.

Right-click Me sh in the Simulation Study tree and select
Create Mesh. Use Curvature based mesh and default
element size.

Click v .

24 Run the study.

Click Run from the Simulation drop-down menu.
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Post Processing

We will now learn about the various post processing options available for static studies.

25 Plot stress.

Activate the St ress1 plot by double-clicking it from the Results folder. It is a plot

of the von Mises stress in the model.

319.604.5

won Mises [Mfm~2)
413,556, 416.0
379,120,000.0
| 344,683,616.0
_ 310,247.232.0
_ 275,810,816.0
_ 241,374,400.0
206,938,000.0
| 172,501,600.0
| 138,065,200.0
_ 103,628,808.0
69,192,408.0

34,756,004,0

Editing Plots

To edit a plot, right click on the plot and select Edit Definition.

The Display dialog lets you specify a stress component and
units.

The Advanced Options lets you choose to plot either a Node
or Element value. For the nodal values, the stresses are
averaged and displayed at the nodes. For the elemental values,
the stresses in a given element are averaged and the element is
given this averaged stress and it is displayed.

The Show as tensor plot option allows you to plot the
orientation as well as the magnitude of the stresses.

The Deformed Shape dialog allows you to show the deformed
shape and to choose the scaling of the graphics window.

gStress plot
v X .

Definition | Chart Options | Settings

Display

@ [VON: wan Mises Stress

E [wme2

Advanced Options
|:| Showe as tensor plot

D Showe plot only on selected
entities

@ Mode Yalues

() Element Yalues

Average results across bounda
g e

for parts

[¥] Deformed shape
() Autamatic
DOm | 461312561
@) True scale

() User defined

Om |1
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Chart Options & Stress plot @ [ Stressplot ®

v X . v X ™

The chart options can be accessed by right-
clicking on the plot and selecting Chart Defian ] Crot Optcn [ Seings| _Beiisen |Gt Ogtions | s
Options or by double-clicking the legend. The . ...
chart options control the annotations as well as [ show min annstacion (continuous 7]
other options such as the color, type of units S“”""“““””““””
. . . Show plot details

(scientific, floating, etc), and number of

decimals shown in the legend.

|:| Show Min/Max range on shown

~ Fringe Options ~

Boundary Options

”~
[Model v

parts only Deformed Plot Options ~
. ﬁ:aoamatically defined maximum SR DGR
settlngs N ! Ddeformed shape
n 2T Translucent [Part colors)
The plot settings can be accessed by right- g Autsticly Sefned min i
clicking on the plOt and selecting Settings. A [124794671875 UHERLEREL ; -
They are used to control various display -
. Position/Format ~
OpthIlS. Predefined positions
[ |9 [
A n 2%
LIED =l
"D“ [Norma\ v]
1"‘11!121 [flaating v]
Rz 1 o

Use 1000 Separator [)

26 Display model maximum.
Right-click on the plot and select Chart Options.
Click Show max annotation.
Click .

won Mises [Mfm~2)
220,601,408.0

202,226,352.0

. 183,855,296.0
. 165,482,256.0
. 147,109,200.0
| 128,736,144.0
110,363,096.0
| 91,990,040.0
| 73,616,992.0
| 55,243,948.0

36,870,596.0

15,497,544.0

124.794.7
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Discussion

Notice that the maximum occurs in a sharp corner where the mesh is quite coarse. If
stresses are of interest in this location, significant mesh refinement would be required. In
addition, this may be an area of singular stress due to the boundary conditions and the
sharp corner. If this was the case, this stress value could be ignored.

27 Plot displacement.
Double-click the Displacement1 plot to show the displacement plot.

URES (mm)
5,249e-001
l 4.811e-001
| 4374e-001

. 3.936e-001

. 3499001

| 3.062e-001

L 2.624e-001

| 2.187e-001

| 1.750e-001

. l312e-001

§.748e-002
l 4.374e-002
1.000e-030

Conclusions
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In this lesson, we did an analysis of a brake rotor. We learned how to set up and run both a
thermal and static study. We also learned about some of the post processing options
available in SolidWorks Simulation.

In order to perform this analysis, some significant assumptions were made. First of all, the
convection was assumed a constant 90 W/m”2.K throughout the analysis. This is a bit of
an aggressive assumption due to the fact that as the car slows down, there will be less air
flow over the rotor, therefore less heat lost due to convection. As mentioned before,
SolidWorks Flow Simulation could be used to more accurately calculate the convection
around the rotor.

Another assumption made in this modeling is that the heat power is applied to the entire
rotor surface rather than simply the location the pad touches. In actuality, the heat power is
only generated where the pad touches, and as the car moves, this location rotates around
the entire surface of the rotor. By applying it to the entire rotor surface, we “smear” the
heat power evenly along the surface in what could be considered a conservative
assumption. Can you think of a way to apply the heat power to better match the real
model?

Additional assumptions were made in this model such as the friction coefficient, material
properties, and structural boundary conditions. Therefore, this analysis should serve as a
first-pass type of analysis where further testing or investigation could be done for more
conclusive results.
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Lesson 6: Frame Analysis

When you complete this lesson, you will be able to:
O Set up an analysis using beam elements.

O Create truss elements.

O Calculate the torsional rigidity of your frame.

O Post process results in cylindrical coordinates.

O Define beam shear and moment diagrams.

O Evaluate your frame design.
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Torsional Rigidity

The torsional rigidity is defined as the torsional response
(defined as some deflection angle) of a structure to an applied
torque loading. The image to the right shows the deformation
of a structure due to some applied torque loading. The
torsional rigidity would be mathematically formulated as
follows:

TorqueLoad
AngularDeflection

TorsionalRigidity =

With respect to frame design, the torsional rigidity is an important characteristic of the
vehicle for several reasons. As we will see, the general rule of thumb for torsional rigidity
is “the stiffer, the better.”

Imagine strapping wheels to a mattress and trying to drive the mattress through twists and
turns. A mattress car, as you can imagine, would not handle the lateral loading well and it
would be very difficult to keep the wheels of the car on the ground. Torsional stiffness
drastically affects the car’s handling.

The lateral loading on a vehicle is taken up in two places; the frame and the suspension.
Now, consider tuning the torsional stiffness of your car to drive on different road types.
The suspension can be adjusted, the frame cannot. Ideally then, your suspension will take
up much of the lateral loading. Adjusting the stiftness of your suspension will determine
how the car handles different types of loading. If the loading is taken by the frame, it will
be very difficult to tune the torsional stiffness of your car.

In this lesson, we will use SolidWorks Simulation to evaluate the torsional rigidity of our
frame design. Perhaps most importantly, we will also be able to evaluate how design
changes affect the torsional rigidity (i.e. is this design stiffer or more flexible than the
previous?).

Element Types

144

To this point, we have used SolidWorks Simulation to analyze the thermal and structural
characteristics of our brake rotor using solid elements. Solid elements worked well in the
analysis of the rotor because the structure was relatively thick and our computer had the

necessary resources to mesh and run the analysis.

In this lesson, we will be analyzing the frame structure that we modeled in a previous
lesson. We could use solid elements in this analysis, however we will see another element
type that will allow us to greatly simplify our calculations.
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Shell Elements

When the structure becomes thin in one direction, such as a sheet
metal part, SolidWorks Simulation can use shell elements to
significantly simplify the calculations. The shell element in
SolidWorks Simulation is a two dimensional triangular element.
Each node of the shell element features six degrees of freedom (3
translational, 3 rotational), giving the nodes the ability to transfer
moments. The thickness of the geometry is taken into account
automatically in the formulation of the element.

Shell elements can be created in SolidWorks Simulation the
following ways:

O Shell elements are automatically created in SolidWorks
Simulation when a sheet metal part is used.

Q If any surface geometry exists in your part, SolidWorks Simulation will automatically
recognize them as shell elements as well.

O To manually define shell elements, you can right-click the solid body from the Parts
folder of the Simulation Study tree and select Define Shell By Selected Faces.

Beam Elements

The beam element is another type of structural element available
in SolidWorks Simulation. It is a one dimensional element with
2 nodes. Like shells, each node of a beam element has six
degrees of freedom. The cross-sectional characteristics of the
beam are taken into account in the formulation of the element.
These characteristics are automatically computed in the
software, therefore greatly simplifying the model setup.

Beam elements can be created in SolidWorks Simulation in the
following ways:

O Beam elements are automatically created in SolidWorks
Simulation when a weldment part is used.

O Right-click the solid body in the Parts folder of the - @ Feme
Simulation Study tree and select Treat as Beam. N

+ [ Cut-List-tem1

@ SolidBody 51(Structural Memberl[l])|
) S 8= Apphy/Edit Material..

Apply Favorite Material

Create Mesh..,

| Treat as Beamn..,

Treat as Remote hMass..,
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Preparing for Analysis

As previously discussed, the first step in the analysis process is to simplify the model.
Care must be taken when simplifying the model such that we do not remove something
that could have a significant effect on our results.

1

Open Frame.
Click File, Open and select the part Frame. Click Open to open the part.

This is the Frame part that was created in the previous lesson. There are a couple of
modifications to the model in order to make it a bit more convenient for meshing.

Tip: The model used for finite element analysis is often simplified from its final production state.

Therefore, it is often beneficial to have multiple configurations of your models, one for
analysis and one for production.

2 Add a configuration. S E B @S
From the ConfigurationManager, right-click the part and %ﬁwcf:*ff Coetott s Mchineds)
select Add Configuration. * [0 ¥ Defoutchc Machined> | Frome ]
Part (Frame)
Type FEA as the Configuration name. Hidden Tree lrems »
. Renarne Part
Clle - @, Add to Library
The new configuration will be created and activated in (& Open Drawing
the ConfigurationManager. We can now suppress :m:r :
. ree Display
unwanted features in our part that are unnecessary for our [[Fe 28 ot I
analySIS UUcumentl—'rUpertliEs...

In addition, there may be features to unsuppress that are not part of the final model, but
are necessary to the analysis.

Note: In this model, we are doing an analysis on a part. If we were analyzing an

assembly, it would be necessary to create the alternate configurations at the part
level, then have these configurations active or inactive in the separate
configuration at the assembly level.

3 Suppress features.
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In the previous lesson, mounting locations were created for the suspension and the
engine. In the analysis, these will not have any affect on the torsional stiffness of the
vehicle.

Right-click on the Tabs folder and select Suppress.
Right-click on the EngineMount folder and select Suppress.
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Experimental Design

It is important when preparing a finite element model to consider the physical
representation of what you are trying to analyze. Loading and fixtures are going to be
applied to the model based on the most accurate representation of the physical model.
These boundary conditions will introduce assumptions into the model and it is critical that
the assumptions are understood and reasonable with respect to what the model is trying to
accomplish.

There are a number of techniques for experimentally measuring torsional rigidity. In the
simulation, we will try to most accurately represent the experiment in the analysis setup.
In the experiment, the front and rear wheels are mounted on beams and the suspension
components are assumed to be fixed so that all of the load applied is transferred to the
frame itself. The rear of the vehicle is held stationary (fixed) while a load is applied to the
beam with the front wheels to simulate the torque as shown in the figure below.

Force Force

Note: Our analysis will be setup with respect to this method for measuring torsional
rigidity. Other methods exist and you would want to design your analysis
according to the physical setup of the experiment in order to compare the results

properly.
4 Unsuppress features.

In this model, the suspension has not been included
in the analysis. We need a location to apply our
torque loading as well as a place to measure the
angular displacement for calculating the torsional
rigidity. For this, beam members have been created
to connect the frame to the location where the
wheel is mounted.

Right-click on the Rigid Support folder and
select Unsuppress.

We are now ready to begin the analysis. Make sure that the SolidWorks Simulation
Add-In is active from the Tools, Add-Ins menu.
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5 Create a study.
From the Simulation drop-down menu, select Study.
Select Static as the Type.
Enter Torsional Rigidity asthe Name.
Click .

Beam Meshing

As mentioned before, weldment features are v @ Frame
al}tomat}cally tregted as beam elemepts in SolidWorks ‘ ?Iﬁm‘
Simulation. If solid elements are desired for the analysis, T Soll B Apply/Eat Materia..
right-click the beam feature in the Simulation Study tree Wosoll  apply Favorite Mterial >
and select, Treat as Solid. y Eg{:l‘ Edit Definition..
] s

6 Examine the Frame folder. + @ Frame

The Frame folder should contain sub-folders that list ?

all the solid bodies that will be meshed as beams. You g z:zgz;g:m::ﬂiﬁ

can tell that bodies the will be beams because of the ~ B Cut-List-Trem2

beam icon [& next to the body name. LSBT S e D,

B solidBody 8(Structural Memberl[4])

Any Solid Bodies that will be meshed as solids should
be excluded from the analysis. To do this, right-click the solid body and select Exclude
from analysis.

Section Properties Section Properties ~
Far Tarsional Shear Stress Calculation:

We mentioned that all of the cross-sectional characteristics of

the beam are taken into account automatically by SolidWorks ~ [mm -
Simulation. For custom beam profiles, the section properties Tersional Constant

that are not computed automatically are constants for the LL2IBTR g mn*4
torsional shear and shear due to bending calculation. These
constants must be entered manually if this information is
required from the analysis. To enter the constants, right-click '~
the beam and select Edit Definition. The required contacts for 55507
torsional shear calculations are as follows: Shear Factor in direction 2

Distance for Max Shear Stress:
17.16065603 * mm

Far Shear Stress Calculation:

»

»

0429255257

Q Torsional Constant, K T
The value for the torsional constant can be calculated or et
obtained from literature.

O Distance for Maximum Shear
Distance from the center of the section to the point of maximum torsional shear.

Q Shear Factor in direction 1
Shear factor to account for non-uniform shear stress in direction 1 of the beam coordinate
system.

Q Shear Factor in direction 2
Shear factor to account for non-uniform shear stress in direction 2 of the beam coordinate
system.
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End Conditions

Apply/Edit Beam @
At the end of each beam falls a node that will connect to either vox
another beam joint or a boundary condition. As previously Type ~
mentioned, the nodes of beams have six degrees of freedom @ Besm
(three translational and three rotational). These degrees of Tr:t::ctural S——
freedom may be restrained or released to reflect various structural
connection configurations. To manually configure these degrees
of freedom, right-click the beam and select Edit Definition. The
graphics window will show the beam with two ends as shown in Show beam ditection
the ﬁgure. End1 Connection ~
@ © Rigid
Hinge
y S Side
Manual
End2 Connection Ea
= @ © Rigid

Hinge
Slide

tManual

The following options are allowed for beam end conditions:

O Rigid
All six degrees of freedom are tied to the joint. All translational forces and rotational moments
will be transferred from the beam element to the joint and vice versa.

O Hinge
Three translational degrees of freedom are tied to the joint. All translational forces will be
transferred from the beam element to the joint and vice versa. Rotational moments will not be
transferred.

a Slide
Three rotational degrees of freedom are tied to the joint. All rotational moments will be
transferred from the beam element to the joint and vice versa. Translational forces will not be
transferred.

QO Manual
A custom defined connection can be defined.
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Trusses

In the same location, the beam can be defined as a Truss & which can only resist axial
loading.

We want to apply the torsional loading to the location where the wheels would mount so
that we can best represent the experiment. Weldment features were created that defined
this location. We want the loading to be transferred directly to the joints of the frame
where the suspension mounts, however, we do not want any moments to transfer, only
forces. To only allow the transfer of forces, we will make these members trusses.

7 Define trusses.

Select one of the truss members in the graphics
window. It should highlight the member in the
Frame folder of the Simulation Study tree.

Right-click the member in the Simulation Study
tree and select Edit Definition.

Select Truss as the Type.

Repeat this procedure for the seven remaining
truss members that mount to the suspension
mounting points.

8 Apply material.
Right-click the Frame folder and select Apply Material to All Bodies.
Select Alloy Steel as the material. Click Apply, then Close.

Joint Group ¥ Torsional Rigidity (-FEA<As Machined
[ -
The beam mesh is made out of a series of one dimensional lines
that may be connected. The end points of these lines are called 5 onnecton:
joints. SolidWorks Simulation automatically detects the joint L4 Bxternal Loads
positions, however some joints can be very close and it could be G Mesh
desirable to merge them (or un-merge) them. In this case, the joint sl Optens
locations can be modified manually using the Joint Group. We will practice this in

this lesson.

The beam joints are shown as yellow or magenta spheres in the graphics window.
O e joints are connected to two or more beam members.

0O e joints are connected to a single member.
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9 Edit Joint Group.

When a beam is defined in SolidWorks Simulation a folder
called Joint Group is created in the Simulation Study tree.

Right-click the Joint Group folder and select Edit.

10 Examine joints.

Right-click a joint icon to examine the beams that are
connected by the joint.

To add or remove a beam member from the list, click the
beam in the graphics window.

To save the new joint, simply close the Select Joint
Members window.
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Edit Joints @
v X
Selected Beams Ea
@ Al
) Select
&+

)
Treat as joint for clearance
@ equal to zero [touching)
() less than
0.0142 = | ]

Keep modified joint on update
Calculate

Results Ca

Joint1 -
Joint 2 M
Joint 3 B
Joint 4
Joint 5
Joint &
Joint ¥ v

|:| Display neutral axis

|:| Display shear center

Select Joint Members =]
Mirrorl[14]

Structural Memberl0[1]
Structural Memberl0[3]
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11 Edit joint.
Examine the joints in the rear of the vehicle frame.

Notice that at one of the rear suspension mounting points, there may be two joints. This
location should only have one joint that connects all of the beams.

Right-click one of the joints and add the omitted beams.

Right-click the other joint and remove all of the beams. This will delete that joint since
it is redundant.

Click Calculate to recalculate the joints.

—Select Joint Members E <4
(|

Mirrorl[14] -
Structural Member8[3] [ |IF

Structural MemberS[1]

< Pdirrorl (41 S
<13

Note: This procedure may be repeated as necessary until the joints are calculated
properly. Additionally, this procedure may not be necessary if the joints are
initially calculated correctly.

Tip: Be sure to check your joints to insure that they have been computed accurately by the
software. It can be helpful to thoroughly examine the mesh after meshing.

Merging Joints Automatically

Selected Beams Ca
@ Al

The software automatically calculates joint locations based on the
ends of beams. At the joint end, a hypothetical sphere is drawn o)
with a diameter chosen automatically with respect to the model
geometry. If two joints fall within one sphere, the beam ends will
be merged forming one joint. It is possible to modify the diameter [ =eimtrerdearene

of this hypothetical sphere using Treat as joint for clearance © eaualto zere fouching
less than. Re-calculating the joints is necessary to get them to
merge.

) Select

() less than

0.0142 | |

Keep modified joint on update

Calculate
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Fixtures
SolidWorks Simulation has a number of different fixtures that Focture @
can be applied to beam joints: PR
O Fixed Geometry Example v
Fixes all six degrees of freedom (translational and rotational). Standard(Fixed Geometry) ~
Fixed Geometry

0 Immovable (No translation)
Fixes translational degrees of freedom only. Rotational degrees of
freedom are left unconstrained.

12; Irnmovable (Mo translation)
@ Use Reference Geometry

o2
0O Use Reference Geometry

The user can specify a reference and choose which degrees of
freedom are fixed (translational or rotational) with respect to that
reference.

It was mentioned that in the experiment, the rear wheels are held stationary. To measure
the torsional rigidity, the entirety of the load must be transferred directly to the frame.
Therefore any components attached to the frame that transfer the load must be assumed to
be rigid. If this is the case, it would make sense to fix the rear joints where the rear
suspension would attach.

12 Apply fixtures. Ficture @
Right-click Fixtures in the Simulation Study tree and v X -
select Fixed Geometry. Example v
Select the eight joints at the rear of the frame where the Standard(Fixed Geometry) ~
suspension would mount. ki i
Cl]ck v. 12; Irnmovable (Mo translation)

@ Use Reference Geometry

3£ || Joint=182, 1=
Joint=173, 1=
Joint=112, 1=
Joint<47, 1=
Joint=102. 1=

mf »

1

Note: You can tell which degrees of freedom are being

fixed by viewing the arrows. An arrow in a U 2 V 2

given direction means that the translation in that +
direction is restrained. If the arrow has a tail, the
rotation about that direction is restrained as well.  Fixed Geometry Immovable
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Loading

SolidWorks Simulation allows for the application of forces and
torques to beams or beam joints. The force is applied to the beam

@

Force/Torque

v X -
or joint and the direction is defined by choosing a reference. — .
As with our fixtures, we will assume that the loading from the ©
experiment is transferred directly to the frame beam joints at the
suspension mounting points. ¥
With the wheel structure assumed rigid, the load would be ol |
applied to the front axle axis and the frame would rotate about the = units S
center of the frame on the front axle axis. This is the location i o 7
where the angular displacement must be measured about. Force &
Q& 1 ]
Qf 1 M
Q)' 1 ]
Rotation Point Moment ~
Q\l 1 M.
Qf 1 H.m
Q)‘ 1 M.

To simplify the analysis, we have not included our suspension components, therefore we

must define representative loading condition that will simulate our experiment. The

application of our loading to our truss members will transfer the equivalent torque to the

frame through the suspension mounting points.

Note: The truss members are used only in the finite element model to directly transfer
the loading. They are not part of the actual frame design.
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13 Apply loading.

Force/Torque @
Right-click External Loads in the Simulation Study tree, v x
and select Force.

Select Joints under Selection.
Select the beam joint at the termination of the truss members.

Select the Front plane as the reference.

G
@ | |Fr0ntPIane |

Select Normal to Plane and enter 169.7 N. -~ -
Click ~. B [s =

Front_Axle_Axis

I:‘Re\terse direction

Moment Ca
é& 1 M.m
&

Repeat this procedure for the opposite side.

Make sure that the direction is reversed on the opposite side.

Note: The loading magnitude was calculated such that a 100 N-m torque is applied to
the frame.

100Nm
0.5892m

Force =

14 Mesh the model.
Right-click Me sh in the Simulation Study tree and select Create Mesh.

The beam mesh will automatically be created.
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Note: Truss members are meshed as a single element because they will not have
bending deformation since their nodes only transfer axial forces.

15 Run the study.

Click Run from the Simulation drop-down menu.

Post Processing

After the study is run, the Results folder in the Simulation Study tree will become
active and our results are accessible. In this lesson, we will investigate the different post

processing options available for beams.

The first result that we would like to compute is the
torsional rigidity. To do this, we must know the angular
deformation of the frame as a result of the torsional
loading.

Cylindrical Coordinates

By default, SolidWorks Simulation plots the results using a
Cartesian coordinate system. Knowing this, one could convert
the results to another, more desirable coordinate system.

SolidWorks Simulation also allows for the plotting of results in
cylindrical coordinate. We will use this method to measure the
angular deformation of the frame required to calculate torsional
rigidity.

To change to cylindrical coordinates, a reference axis must be
selected in the Advanced Options. When in cylindrical
coordinates, the following changes are made to the coordinates
with respect to the selected reference axis:

O X direction = Radial direction
Q Y direction = Circumferential direction

Q Z direction = Axial direction

i _4--

@ Displacement plot @
v X

Definition | Chart Options | Settings

Display

@ [U\‘:Tangential Displacement v]
E [on 7)
Advanced Options Ll
i I

Showe as wector plot

Render beam profile [slower]

Showe plot only on selected
entities

Deformed shape Ll
@ Automatic

O | 9174315643

() True scale

() User defined
Oo |1

Show colors

In addition, the cylindrical coordinate system appears at the bottom right of

the graphics window to inform you of your coordinate selection.
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Lesson 6: Frame Analysis

Right-click the Results folder and select Define Displacement Plot.

Select UY: Y Displacement as the Component.

Expand the Advanced Options and select Axis2 as the reference.

Select the Automatic scaling.
Click .

UY [mm]
0.000e+000
l -2.605e-001
L -5.61le-001
- -G.416e-001
- -1122e+000
L -ld403e+000
| -1.683e+000
L -1.96de+000
L -2.244e+000

. -2.525e+000

-2.505e+000
-3.086e+000
-3.366e+000

Note: The unit system of this plot is still in mm where we might expect it to have an
angular unit since it is a circumferential displacement. In actuality, the software
is taking the angular deformation about the axis and multiplying it by the
distance away from the axis. To compute the actual angular deformation, we

need to divide by its distance away from the axis.
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16 Probe. ~ [ Results
Right-click the Displacement plot in the Results g&: ;t:;(_:T:MM S
folder and select Probe. © ois
Select one of the ends of the trusses where the load is % id'_we:m't'm"'
apphed. nﬂ Chart Options...
G‘ Settings..,
LY (mm) ||f Probe I

0.000e+000

-2.805e-001
. -5.611e-001
_ -6.416e-001
- -L122e+000
L -1.403e+000
| -1E63e+000
L -1964e+000
L -2.2d4e+000

_ -2.525e+000

-2.805e+000
-3.086e+000
-3.366e+000

We now know the angular deformation of the end of the frame.

Mode: 313
XY, Z location: |-5.54e-005,589,260 mm
alug: -3.366e+000 mm

We must divide this by the distance away from the axis to measure the angle.

_ 3.366mm _
= 580 2mm 0.00571rad

Click .

Note: The angular deformation will always be calculated in radians, not degrees.
Torsional Rigidity

We can now calculate the torsional rigidity of the frame.

__100Nm __ Nm
T 000571 ad PP aa
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There are a number of different components of stress that develop in beams. Axial,
torsional, shear, and bending stresses are all components of stress seen by beams. In

SolidWorks Simulation, you can plot any of these.

By default, SolidWorks Simulation creates a stress plot called Upper bound axial and
bending which looks at each beam element and plots whichever component of stress is
the highest in the plot. This type of plot is useful in evaluating the maximum stress seen in

your beams.

17 Plot stress.

Activate the St ress1 plot that was created by default by SolidWorks Simulation.

40,706,236.000
37,314,048,000
| 33,921, 864.000
. 30,529,676.000
. 27,137,490.000
| 23,745,304,000
| 20,353,118.000
| 16,960,332,000
| 13,568,745.000
. 10,176,559,000
£,764,372.500
3,392,186,250

0.000

Upper bound axial and bending [Mim*2]

This is a plot of the highest stress (axial or bending) in each beam element.

We can view these stress components separately.
18 Plot axial stress.
Right-click the Results folder and select Define Stress Plot.
Select Axial and Automatic.
Click .

Axial Pét [~ 2)
3,419,283.500
2,849,95,000

| 2,260,506.000
. 1,711,117.500
_ 1,141,729.000
_ 572,340,500
| 2,351,750

| -566,437.000
| -1,135,825.500

| -1,705,214.125

-2,274,602.750
-2,843,991,500
-3,413,380.000

g Stress plot @
v X M

Definition | Chart Options | Settings
Display Lal

] Render beam profile slouer

E [wme2 -
¥ [ g

Deformed shape A

(@ Automatic

Op | s1.74315643
() True scale

() User defined
0o |1

Notice that some members are in tension and some members are in compression. You

can use this information in design change decisions.
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Cross Section Directions 1 and 2

To post process bending and shear stress, the beam directions 1 and 2 must be defined.

SolidWorks Simulation defines direction 1 to be along the longest side of the cross section
and direction 2 is it’s perpendicular.

19 Plot bending stress.

Right-click the Results folder and select Define Stress Plot.

Select Upper bound bending in DIR1 and Automatic.
Click ~.

Bending Ms/Ss [Mim"2]
33,534,792.000
27,945,580.000
L 22,356,384.000
_ 16,767 148,000
_ 11,177,332,000
_ 5,588,716.000
_ -500.000

| -5,589, 714,000
| -11,178,930,000
_ -16,768,146,000
-22,357,360.000
-27,946,576.000

-33,535,792,000

Note: If you probe on one of the truss members, you will see that it has zero bending
stress. This makes sense because the trusses do not transfer moments.

Similarly, the user can plot Torsional, Shear in DIR 1 and Shear in DIR 2 stresses.
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Shear and Bending Diagrams

SolidWorks Simulation also has the ability to plot shear and bending diagrams in the
different beam directions. These can be used to study how the internal bending moments
and shear forces vary along the length of the beam.

20 Plot bending moment.

Right-click the Results folder and select Define Beam
Diagrams.

Select Moment in Dir1.

Under Selected Beams, choose Select and select the
beam member shown at the front of the frame.

Click v .

Moment in Dirdl [M.m)
1.785e+001
1.467e+001
_ Li90e+001
_ B.823e+000
_ 5.948e+000
_ 2.974e+000

-6.160e-004
| -2.975e+000
_ -5.950e+000

L -B924e+000

-L150e+001
-L487e+001
-L785e+001

Right-click on the Results folder and select List Beam Forces.
Click ~.

A list of the forces in each beam element are listed. You can save this list to be used
later.

21 List beam forces.
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Conclusion

In this lesson, we evaluated the torsional rigidity of our frame design. We learned how to
set up an analysis using beam element. We also learned about the various post processing
options available when beams are used.

At this point, it could be advantageous to change the frame design and re-evaluate the
torsional rigidity. The most common goal for frame design is a torsionally stiff and light
frame. Design changes could include different beam lengths, cross sections, or material
properties.

It is important to note that the torsional rigidity was evaluated and set up with respect to
the experiment that would be performed once the frame is made. We can only compare
experiment to analysis if the boundary conditions are set up in the same manner.
Additionally, assumptions are made in the finite element model that might not reflect the
real world situation perfectly. Therefore, it is most advantageous to evaluate different
frame designs using the software to decide which is the stiffest, not one that matches the
experiment perfectly.
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7

Lesson 7: Intake Analysis

When you complete this lesson, you will be able to:
Q Set up and run a Flow Simulation.

O Post-process a Flow Simulation.
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Intake Manifold Design

The common goal of an intake manifold design is even
distribution of flow to the piston heads. This is to insure
optimum engine efficiency. In this lesson, SolidWorks Flow
Simulation will be used to investigate the design of our
intake manifold when the car is moving at 22 m/s (50 mph).

This lesson will introduce the complete set up of a
SolidWorks Flow Simulation project. We will prepare our model for analysis, set up
boundary conditions and engineering goals, run our project, and learn to post process our
results.

Model Preparations

In structural analysis, it is typically necessary to simplify the SolidWorks geometry to
allow the simulation to run. The same is true for flow analysis. A simplified model will
result in faster mesh and run times providing you with a quicker result. Part of model
preparation is deciding what type of model you will be running. SolidWorks Flow
Simulation categorizes flow analysis in terms of the flow being either internal or external.

External Flow Analysis

This type of analysis involves the study of flow around a region not necessarily bounded
by solid geometry. Typically, this is used for the study of flow over aircrafts, automobiles,
buildings, etc.

Internal Flow Analysis

Internal flow analysis deals with the study of flow inside a region bounded by solid
geometry. A typical example of an internal flow analysis would be the flow through an
HVAC system. In this type of analysis, flow enters the model through some inlet and
leaves the model through the outlet. Flow Simulation requires the model to be fully closed
to perform an internal analysis, therefore some geometry modifications may be necessary
prior to setting up the model. This will be the case in our analysis of the intake manifold.

1 Open Intake Assembly.
Click File, Open and select the part Intake Assembly. Click Open to open the part.
2 Start SolidWorks Flow Simulation. i =

Click Tools, Add-Ins. Select SolidWorks Flow Simulation. | =e [l
. 7] souDwORKS Simultion
Click OK. e s
(1% souworks utiies

IR Totsnatst

15

<15

OoEEEO

1 SOLIDWORKS Add-ins
[ Autobrace
SOLIDWORKS Camposer
[ 4 SOUDWORKS Electrical -
7T SOLIDWORKS Flow Simulation 2016 D |
7] SOUDWORKS Forum 2016 <1

[C188 SOLDWORKS nspection
[ SOUDWORKS Plastics

<15

S5 =0

OEE

ElOther Add-ins
[ SOUDWORKS IDEXPERIENCE Smarklink ]
[] SOUDWORKS Sodial 2016 ]

Gancel
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SolidWorks Flow Simulation Interface

SolidWorks Flow Simulation functions

Lesson 7: Intake Analysis

are accessed in the same way as SolidWorks.

When a simulation study is created, a Flow Simulation analysis tree appears as a tab next
to the FeatureManager design tree tab. Each new study that gets created is linked to a
specific configuration created in the ConfigurationManager. Like SolidWorks functions,
Flow Simulation functions can be accessed from the Flow Simulation toolbars,
CommandManager, or Flow Simulation drop-down menu. Additionally, functions can be
selected by right-clicking geometry or items in the Flow Simulation analysis tree.

DDSSOLJ'DWOF.’KS| File Edit View Inset Tools Simulation Window Heln A | ) -[%-F-& -9 - B B @ - mokeasse.. B search commands Q- ?--0x%
1
R REE R TR H S WP
f | | | (v PFIG R TR B KNS BO
Nwai B g, B om B, g & 2 E . B e
L Flow ' Flow Simulation Flow =
[ new = SG;&"‘:’;’; 02 simuiati, 9 Run tosgunioad B O il Foture P Simulati...
Clone Project | [@ = b - = - W | & o
Assembly | Layout | Sketch | Evaluate | SOLIDWORKS Add-dns | Simulation | SOLIDWORKS gy | Flow Simulation |
PERPREB O v & 0
5 Projects Command Manager
-8 Default
L.£5 Project1
Flow Simulation Main (=]
DB gBEPrPE | EHBE \
Flow Simulation Features B
BRARAE HSS O WY R ea \ @
=5 Project1 Flow Sirmulation Display =]
G Input Data 5 & £ A | —
) Computstional Damain
Fluid Subdamains
“Ffj Boundary Conditions Flow Simulation Results =] . .
% ol %G | ER Y YAk Flow Simulation
s
2-BF Results (Not loaded) Toolbars
HE Mesh Flows Simulation Results Features (=]
- Cut Plots DL EE ke A
> Surface Plots
& Tosurfaces
-£5 Flow Trajectories
¥ Particle Studies
A Point Parameters
£ Surface Parameters
A volume Parameters
by 30 Plots
e Goal Plots
] Report
D Export Results
Flow Simulation
analysis tree }‘K
T
TITII0 Model [ 3D Views | Motion Studyl |
SOLIDWORKS Education Edition - Instructional Use Only Fully Defined  Editing Assembly MMGS - &

Lids

As mentioned previously, internal analysis requires the geometry of the model to be fully
closed. In the intake manifold, there is an opening for the inlet flow and four ports for the
flow to the cylinders. We must close these openings with lids. We will then apply the
proper boundary conditions to the surface of these lids to tell Flow Simulation how the
fluid will be entering or leaving through the lid surface.
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3 Create lids.

@Create Lids @
From the Tools drop-down menu, select Flow Simulation, v x
Tools, Create Lids. Selection ~

Select the planar faces on the inlet and the four outlet ports that e e

Face<1> @runner-11

the lid will cover. Face<1> @rumner-1¢
Select Adjust Thickness and enter 1mm as the Thickness.
Click +.

You’ll notice nine new parts in the FeatureManager design tree. The lids are blind
extrusions from the selected planar faces into the openings with a distance that was
specified as the Thickness. The annular lids can be neglected as they would not come in
contact with the internal fluid.

Note: The thickness of the lid for an internal analysis is usually not important
however, the lid should not be so thick that the flow pattern is affected down
stream. For most cases, the lid thickness could be the same thickness used to
create the neighboring walls.

Tip: If the lid face is not planar, the lid tool cannot be used. In this case, simply create the lid
manually using a mid plane extrusion.

Check Geometry

166

SolidWorks Flow Simulation has a tool called Check Geometry that allows users to
check the solid geometry to make sure that it is ready for analysis. We know that the
geometry must be fully closed for an internal analysis.

Additionally, we need to make sure that no invalid
contacts exist in our model. An invalid contact will cause
the Check Geometry tool to report zero internal volume
and the Flow Simulation will fail to solve. Some examples
of invalid contact are shown in the figure.
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4 Check geometry.

Kﬂ'ﬁ Check Geometry @
From the menu choose: Tools, Flow Simulation, Tools, Check x
Geometry. state A

Select Internal under Analysis Type.

# %y intake conned

Click Check. 2 e omna
. W runner-11 E
The tool should calculate a fluid volume correctly and there # @ plenum-2
. . % restrictar-2
should be no invalid contacts. @@ intake conned

. . . . . % intake conned
If invalid contacts exist, you must correct them before beginning @ runner-14

. . . % runner-15
the flow simulation project. @ plenum back

IEEEEEEEEEEEE]E

Click Close when you are satisfied. = wort ;
Analysis Type Ll
@ Internal
) External
| IE - =/ x Options Ea
Results I:‘Create solid body assembly

Status: SUCCESSFUL. Geometry is QK
Analysis type: Intemal
Fluid volume: 0.00424189m™3

|:| Create fluid body assembly

Solid valume: 0.0483577 m™3
Zheck completed

Creating the Project

Now that our geometry has been properly modified, we can proceed with the Flow
Simulation project.

5 Create a project.

From the menu, choose: Tools, Flow Simulation, Project, Wizard.
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6 Create new project.
Under Configuration, click Create new to create a new configuration.

In the Configuration name box, enter Project 1.

Wizard - Project Mame @
Project »
Project name: Praject 1
Comments:

put Daka
@ Computational Domain
"8 Component Contral
3 Fluid Subdamains
Eﬁ Boundary Conditions Configuration: [Creale Mew -
[:]: Fans
‘}‘ Heat Sources
-8 Porous Media
@ Initial Conditions
R Goals
@ Local Initial Meshes
B- gﬁ Results
ﬁEF Mesh
3% Cut Plots
{) Surface Plots
-y Tsosurfaces
% Flow Trajectories 24

Configuration to add the project

Configuration name:  Project 1|

< Back [ Mext > J[ Cancel ][ Help

Click Next.

Note: SolidWorks Flow Simulation will create and activate a new configuration called
Project 1 when the wizard is finished. All data associated with running the
analysis will be stored in a separate folder in the model directory numbered
sequentially, i.e. “17, “2”, “3”... etc. based on how many projects are defined on
this model.

7 Select units.
Select SI (m-kg-s) as the Unit System for this project.

Wizard - Unit Systern IE'
Unit systen: »
System Path Comment
CGS [om-g-s) Pre-Defined CGS5 [cmgs)
FPS [ft-lb-5) Pre-Defined FFS [ft-b-5]
IPS [inb-g] Pre-Defined IFS [irlb-s)
MMM [mim-g-z) Pre-Defined Mk [mmeg-z)
Sl [m-kg-s) Fie-Defined 5 0-5|
LSA Pre-Defined Lsa
[ Create new Hame: 51 [m-kg-2] [madified]
= Decimals in results 1S8lunit -
Parameter Unit = o=
" display eguals to
Pressure & stress Pa A2 ‘
o Velocity m's 123 m
Mass kg 123
Length m 123
oo Temperature K A2
. Physical time -3 123
i+ HVAC il [N
< | 1 | » )
[ < Back ] [ Mext » J [ Cancel ] [ Help ]

Click Next.
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8 Select analysis type.
Select Internal under Analysis Type.

e s limalina =)

Analysiz bype Consider closed cavities @
@ Intemnal Exclude cavities without flow conditions
(71 External [ "] Exclude intemal space

Physical Features Valug

Heat conduction in solids

Radiation

Time-dependent

Gravity

Rotation

Reference anis: Dependency.. ®

[ < Back Il Mext > I[ Cancel I[ Help ]

Click Next.

9 Select fluid.
Expand the Gases tree and double-click Air to add it to the Project Fluids list.

Wizard - Defauit Fluid =)

Fluids Path - Mew...
= Gases
"B Pre-Defined
- Acetone Pre-Defined
- Ammenia Pre-Defined
- Argon Pre-Defined
Butane Pre-Defined
Carbon dioxide Pre-Defined
Chlorine Pre-Defined
i Ethane Pre-Defined
- Ethanal Pre-Defned = Add
Project Fluids Defautt Fluid Remove

Flow Characteristic Value -

Flow type Laminar and Turbulent E|E|

High Mach number flow

Humidity [l S )
< Back ] l Mest » I [ Cancel ] [ Help ]

Click Next.

SolidWorks SAE Design and Analysis Project 169



Lesson 7: Intake Analysis
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10 Select wall conditions.
Accept the default conditions and click Next.

Wizard - Wall Conditions [7]=]
Parameter Value ®
Default wall thermal condition Adiabatic wall [+]
Roughness 0 micrometer

Dependency. @

< Back ][ Mext » ][ Cancel ][ Help ]

11 Initial conditions.

Accept the default conditions and click Finish.

-

Wizard - Initial Conditions @
Parameter Walue @
Parameter Definition User Defined El

=l Thermodynamic Parameters

----- Parameters Pressure, temperature El

h Pressure 101323 Pa

e Tempersture 2932 K

= Velocity Parameters

; Parameter “elocty El
“elocity in X direction O miz
“elocity in Y direction 0 miz

ey “elocity in £ direction O mi=

Turbulence Parameters

(o] ®

[ < Back. ][ Finizh ][ Cancel ][ Help ]

12 Review Flow Simulation analysis tree.

SolidWorks Flow Simulation has created and
activated an additional configuration called Project 1.
In addition, the Flow Simulation analysis tree tab has
been created in the FeatureManager.

Select the Flow Simulation analysis tree tab =:.

£5 Projectl

=] a Input Data
Cu Cormputat]
@ Fluid Sube
Ef Boundary
F Goals
@ Mesh

...-% Results (Mot o

General Settings...
Units...

Cornpanent Control
Global Mesh..,

Calculation Control Options..,

Dizplay &ll Callouts
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If changes need to be made to the settings of the project, you can right click the ITnput
Data folder and select the appropriate option.

In the graphics window, the Computational
Domain is shown as a wireframe box
enveloping the model. This is the area where
the model will solve the flow simulation.
Because this is an internal analysis, the model
will be solved inside the solid geometry inside
the box.

13 Insert boundary condition.

In the Flow Simulation analysis tree, under Input
Data, right-click Boundary Conditions and
select Insert Boundary Condition.

Select Other
P Face@Imported1@(LID1<1x]

LS

[ Face@Thitkenl@([plenum<2>] |;|
ijlenum<2> |
E Face@Thickenl@[plenum=2=]

E Face@Center Guide Curve@[runr _

4 [ | +

B
Select the inside surface of the lid covering the inlet :
as shown in the figure.

To access the inner face, right click the outer face of
the lid and click Select Other. In the Select Other
window, cycle through the faces by moving the
pointer to highlight each face dynamically in the graphics window.

14 Set up boundary condition.

Ff Boundary Condition @
Under Type select Flow Openings. v %
Select Inlet Velocity. Sé«"on i
Face<1=@lID1-1
Under Flow Parameters, click Normal to Surface and enter 22
m/s.
.
Click ~.

}fvx Face Coordinate System
2

Reference axis:
Type S

BRI

Inlet Mass Flow -

Cutlet Mass Flow ‘
Cutlet Wolurme Flow
Cutlet Welocity mi

Flow Parameters Ca
Vo 22mis :

|:| Fully developed flow
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15 Insert boundary condition.

In the Flow Simulation analysis tree, under Input
Data, right-click Boundary Conditions and
select Insert Boundary Condition.

Select the inside face of one of the lids covering the
outlet ports as shown in the figure.

L runner<10= L
E Face@Straight Boot Section@ 1
E Face@Base@[intake connecticl
GJ intake connection boot=5=

|l

4 | i b

16 Set up boundary condition.

Ff Boundary Condition @
Under Type select Pressure Openings. v x
Select Environment Pressure. Selection A
Click + . T ==

T

}fvx Face Coordinate System
2

Reference axis:

Type ~

Static Pressure
Total Pressure

Thermodynamic Parameters Ll
B 101325Pa =
T 2932K z

17 Set up boundary condition.

Repeat this procedure to create Environment Pressure boundary conditions for the
remaining three outlet ports.
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Engineering Goals

SolidWorks Flow Simulation contains built in criteria to stop the solution process. In
addition, it is best to use your own criteria by using engineering goals. Engineering goals
are user specified parameters of interest which users can display while the solver is
running and obtain information about after convergence is reached. Goals can be set
throughout an entire domain (Global), in a selected area (Surface, Point), or within a
selected volume (Volume). Finally, mathematical expressions using other goals can be
written in an equation goal.

18 Surface goal. CIEEEE S

A
o]

8]

In the SolidWorks Flow Simulation analysis tree, right-click & project1
Goals, and select Insert Surface Goals. - Input Data

------ @ Computational Domain

To select the inlet surface for the Surface Goals, split the E_;: Do, Concitons

feature pane and in the upper portion click the boundary g el
condition Inlet Velocity 1 item in the Flow
Simulation analysis tree to input the face where the surface

Efi Ervironment Pressure 2
FEfi Ervironment Pressure 3
- Enwironment Pressure 4

goal is to be applied. % gorls
- es
In the Parameter list, locate Volume Flow Rate and check @ 88 Results (Not loade)
the box. SR — =
CliCk v, Y Surface Goals @
v X
Selection Ll

T [Face<1-@iD11

T
Parameters &
19 Rename goal. Parameter Mir & M: Bu Us =
. Static Pressure o o Y
Rename the goal so that it appears as Inlet Volume Totalpressure B EIEI O
Dyrnamic Pressure D D D D
Fl ow Rate Temperature (Fluic [£] [ [C] [
Total Temperature D D D D =
Mean Radiant Tem [ [C] [ [0 1
Operative Temperz D D D D
Draught Rate D D D D
Density (Fluie) ] [C][C] [0
Mass Flow Rate ]
Wolurme Flow Rate
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20 Surface goal. CIEEEE S

8]

1Y
=

Repeat the previous steps to apply a surface goal for the = Project

5@ Input Data
volume flow rate at the outlets. 7% O Computational Domain

When selecting the Environment Pressure boundary E_;: Do, Concitons
conditions, hold the control key and select all of the outlet

conditions.

Click Create a separate goal for each surface. This will
create a separate goal for each outlet.

m‘ Inlet Volurne Flow Rate

. @ hesh
Clle v, -5 Results (Not loaded)
Rename each goal to reflect the outlets. PropertyManager =
m‘ Surface Goals @
v X
Selection Ll

@ [Face<s-@im61
Face=< 2= @LIDE-1
Face< 4> @LID4-1

Face<3=@LID2-1

Create goal for each surface

21 Equation goal. Parameters ~
. . . Parameter Mir & M: Bu s =
Right-click Goals and select Insert Equation Goal. staticpressure [ [0 [
Total Pressure o o Y
Select the Outlet Volume Flow Rate 1 surface Dynamic pressure (][] ) [
A . . Temperature [Fluid] 0 EEE
goal that was defined in the previous step to add it to the Total Temperature [ (][] [ ]| _
. Mean Radiant Temp D D D D 3
EXpreSSIon bOX. Operative Temperat D D D D
. . . . Draught Rate o o Y
Click + in the Equation Goal window. Density (Fluig) L] [0 [0
. Mass Flow Rate [ | &
Repeat this procedure to sum all of the outlet goals. Volume Flow Rate
Click OK.
? B v | |Sum of Outlet Volume Flow Rates | [Volume flows rate '] v @ &) x
Expreszion
{0utlet Yolume Flow Rate 1+{0utlet Yolume Flow Rate 2+{0utlet Yolume Flow Rate 3-+{0utlet Yolume Flow Rate 4}
(2] L)
) B @
[o) (e ] an
Use for convergence control

22 Rename goal.

Rename the goal so that it appears as Sum of Outlet Volume Flow Rates.
23 Solve.

In the Flow Simulation analysis tree, right-click the project and select Run.

Make sure that Load Results is selected.

Click Run with the default settings.
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It could take up to an hour to run this study.

Post-Processing

We can begin to post-process the results once the solver is completed. In this part of the
lesson, we will learn about various post processing options available in SolidWorks Flow
Simulation. We first must change the transparency of the model so that we can view the
results.

24 Change transparency.
From the menu, select Tool, Flow Simulation, Results, Display, Transparency.

Move the slider to 0.75.

Note: The transparency can also be changed by right-click the parts in the
FeatureManager design tree.

25 Cut plot.
In the Flow Simulation analysis tree, right-click Cut Plots and select Insert.
Select the Top plane of the plenum assembly.
Click .

104351 .34
10340731
102463.28
101519.25
100575.22
9963119
9868716
4774313
9679910

95855.07
Pressure [Pa)

CutPlot1: contours
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Color Bar

In the Color Bar dialog box, you can specify a physical parameter for the display. You
also have control over various settings of the display. You can access the Color Bar
double-clicking on the legend in the plot.

26 Adjust view settings. [ color Bar z
Double-click the legend to bring up the Color Bar dialog. v R G

Change the Parameter to Velocity. oo 'T
Change the Number of colors to 110. RICETELTENE
Click OK. B Omis g 4

f# 110 =

i
T m-

24018
20108
16194
12282
8.370
4.457
0.545
-3.367
-7.279
-11.192
-15.104
-19.018
-22928
-26.841
-30.753
Welocity (<) [mis]
Global Coordinate Systern
CutPlot1: cantours

"5 Towen [ s [ 1

WL

Hide the Cut Plot when you are through.
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27 Flow trajectory.

In the Flow Simulation analysis tree, right-click Flow Trajectories and select
Insert.

Select the Inlet Velocity 1 boundary condition.
Enter 50 as the Number of Points. Click v.

2404
2001086
16.194
12282
8370
4.457
0.545
-3.387
-7.2748
-11.182
-15.104
-19.016
-21.92%
-26.841
-30.753

Yelocity (=) [m/fs]
Global Coordinate Systern

Cut Plot1: contours
Flow Trajectories 1

Hide the Flow Trajectories when you are through.
28 Surface plot.
In the Flow Simulation analysis tree, right-click Surface Plots and select Insert.
Select Use all faces.
Make sure Contours is selected and the Parameter is Pressure. Click v .

10435134
103744 46
10313768
102530.71
101923.84
10131696
100710.08
1n0103.21
99496 33
48889 45
98282458
97B75.70
9706882
Of461 95
9585507

Pressure [Pa]

Surface Plot 1: contours
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29 Goals plot.

In the Flow Simulation analysis tree, right click Goal Plots and select Insert.
Click All in the Goal Plots window and click Show.

A table will be automatically created containing information about the goals.

= Surmmary ¥ | BB

@ X

Goal Mame

Inlet Yaolume Flow Fate

Outlet Yolume Flow Rate 1

Outlet Yaolurme Flow Fate 2
Outlet Yaolurme Flow Fate 3

Outlet Yaolurme Flow Fate 4

Sum of Outlet Yolume Flow Fates

Uit

[m™345]
[m™345]
[m™345]
[m™345]
[m™345]
[m™345]

Walue
0.02e1
-0.0063
00163
-0.0037
-0.0025
-0.0283

Averaged Value
0.02e1

-0.0063

00163

-0.0038

-0.0025

-0.0283

Minirnurm % alue
0.02e1

-0.0063
-0.0164
-0.0033
-0.0025
-0.0283

I aximurn Y alue
0.02e1

-0.0063
00163
-0.0037
-0.0024
-0.0283

Progress [%]
100
100
100
100
100
100

Use In Convergence
es
es
es
es
es
es

Delta
2.8527e-007
£.3080e-005
3.7945e-0085
0.0001
0.0001
1.8263e-006

Criteria
4.2533e-005
E.4664e-005
0.0002
0.0001
0.0002
1.5196e-005

Discussion

As we can see from the goals plot, the inlet volume flow rate matches the outlet volume
flow rate. This is a good sanity check in that all the flow entering the model is leaving the
model. In addition, we notice the different volume flow rates exiting each outlet condition.
Much of the flow is leaving through one of the outlets in the center. This was also seen
with the flow trajectory plot. This could be because the outlet port is slightly off-set from
the center of the plenum, causing more flow to leave through one side. Re-design of the
plenum could better distribute the flow amongst the outlet ports.

In the real world, each piston would be firing at a different time as the engine is running.
To more accurately represent this situation, a transient study could be set up with the outlet
ports turning on and off with respect to when they would fire using time curves. To set this
up in SolidWorks Flow Simulation, Time Dependent would need to be selected in the
Analysis Type window of the Wizard. In addition, modifications to the outlet boundary
conditions would be needed to specify when they turn on (flow is allowed) and off (flow is

restricted).

Conclusions

In this lesson, we investigated the design of the intake manifold using SolidWorks Flow
Simulation. We learned how to setup and run a flow analysis. We also learned good post-
processing techniques for evaluating our designs. You are encouraged to continue you
investigations of the post-processing options available on your own. In addition, more
information in the form of tutorials and technical writings are available through the help

menus.
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	Making Changes
	29 Change dimension value.
	Return to the part by pressing Ctrl+Tab and clicking the part.
	Double-click the Engine_Mount sketch in the FeatureManager design tree and change the dimension to 50mm as shown. Click Rebuild .
	30 Return to the assembly.
	Press Ctrl+Tab and click the assembly. With the change in the sketch geometry, the engine has been pulled back to a better position within the frame as shown.


	Working With Sub-Assemblies
	Opening a Sub-assembly from the Assembly
	31 Open sub-assembly.
	Right-click the sub-assembly Rear Axle Assembly from the FeatureManager design tree and select Open Subassembly .

	Rigid vs. Flexible Sub-Assemblies
	Rigid
	Flexible
	1 Test component.
	The assembly is designed so that the Sprocket is free to move along the axis CL Rear Axle. Move it a small amount to test it.
	Close the sub-assembly without changes and return to the main assembly. Click Discard.
	2 Warning.
	To line up the Sprocket with the engine output, select the faces indicated and try to add a Coincident mate. A warning saying that the coincident mate cannot be added will appear. Click .

	Why Does the Warning Appear?
	3 Component properties.
	Right-click the Rear Axle Assembly and select Component Properties . Under Solve as, click Flexible and OK. Using the same procedure as in step 2, add the Coincident mate.



	Bracing Sketches
	4 Open part.
	Open the virtual part Frame.
	5 Pierce relation sketches.
	Create a new plane through the endpoint indicated and Parallel to Front plane. Use the plane to create two new sketches.
	In the each sketch, use one Coincident and one Pierce relation.
	Remaining Sketches
	Why is the Bracing One Sided?


	Weldment Structural Members
	A Quick Look at the Standard Profiles
	Weldment Cut List
	Creating Custom Profiles
	1 Open a new part.
	Open a new part with mm units.
	2 Sketch.
	Create a new sketch on the Front plane and sketch a 25.4mm circle and dimension as shown.
	Add an offset of 2.4mm as shown and exit the sketch.
	3 Save as library feature.
	Select the sketch Sketch1. Click File, Save As.
	Select the Save as type Lib Feat Part (*.sldlfp), type the file name 25.4mm Dia, and click Save.
	For Save in, navigate to the default weldment library folder located in the C:\Program Files\SolidWorks Corp\SolidWorks\lang\english\ weldment profiles folder.
	Library Feature Folders and Icons
	4 Close library feature.
	Close the library feature part.
	5 Create new Folders.
	Adding the weldment profile to the weldment profiles folder is not enough to make use of it.
	Create a new folder FSAE in the <Install Directory>\Program Files\SolidWorks Corp/ SolidWorks\lang\english\weldment profiles folder. Open that folder and create two folders named Square Tubes and Round Tubes.
	Move the 25.4mm Dia.SLDLFP file into the Round Tubes folder.
	6 Move existing file.
	Move the existing 25mm Sides.SLDLFP file into the Square Tubes folder.

	Why Do Some Profiles Contain Points?



	Adding Structural Members
	1 Move the rollback bar to a position after the sketch feature that you want to use for creating structural members.
	2 Select the geometry of inactive sketches to define the centerlines of the structural members.
	3 Add only structural members of the same type in the same feature.
	1 Rollback.
	In the Frame part, right-click the Bulkhead2 plane and select Rollback .
	This will place the Structural Member feature just after the Bulkhead1_Sketch sketch, near the related plane.
	2 Structural member.
	Click Insert, Weldments, Structural Member and the following options:
	Standard FSAE, Type Round Tubes and Size 25.4mm Dia.
	Select all the lines and arcs as shown and click .
	Rename the structural member feature to Structural Member_Bulkhead1.
	Corner Treatments
	3 Rollback.
	Drag the rollback bar to a position after the Bulkhead2_sketch.
	4 Structural member.
	Click Insert, Weldments, Structural Member and the following options:
	Standard FSAE, Type Square Tubes and Size 25mm Sides.
	Make sure Apply corner treatment and End Miter are clicked. In this example, all corner treatments will remain as end miters.
	Select all the lines of the sketch as shown and click .
	Using Groups
	5 Rollback.
	Drag the rollback bar to a position after the Main-> sketch.
	6 Structural member.
	Click Insert, Weldments, Structural Member and the following options:
	Standard FSAE, Type Square Tubes and Size 25mm Sides.
	These selections are added to Group1.
	7 Group.
	Click New Group and select the three remaining edges for Group2. Click .


	Using Trim/Extend
	1 Move the rollback bar to a position after the Structural Member feature that you want to trim.
	2 Add one trim/extend feature for each end of the structural member. In the simplest cases, the trim/extend feature may include both ends of the structural member.
	Trimming Boundary
	8 Trim.
	Drag the rollback bar to a position after the Structural Member_Bulkhead1 feature.
	Click Insert, Weldments, Trim/Extend and click End Trim .
	Select the Bodies to be Trimmed and Trimming Boundary Bodies as shown.
	Click Simple cut between bodies and .
	The Bodies to be Trimmed is shortened using the Trimming Boundary body.

	Using Folders
	9 Add folder.
	Shift+select the sequence of features as shown. Right-click and select Add to New Folder, naming the folder Bulkhead_1 Folder.
	If this procedure is used throughout the FeatureManager design tree it will significantly shorten the length of the tree.

	Map for Structural Member Types and Trim/Extend
	eDrawings File for Member Types and Trim/Extend

	Mirroring Structural Members
	10 Mirror bodies.
	Click Insert, Pattern/Mirror, Mirror and click the Top plane as the Mirror Face/Plane. Click Bodies to Mirror and select the bodies shown in blue. Click .


	Editing
	Editing the Corner Treatment
	11 Zoom in.
	Zoom in on the area as shown. This area shows a potential problem where the brace member connects to an open face of a square tube.
	12 Edit structural member feature.
	It is not necessary to know the name of the feature. Right-click on a face of any structural member of the feature and select Edit Feature .
	13 Corner treatment.
	Click the corner marker as shown. In the Corner Treatment dialog, set the Trim Order to 2 and click . Repeat the process for the other corner and click in the main dialog. This changes the selections to mitered corners.
	Editing the Trimming
	14 Edit trim feature.
	Right-click the face of the structural member shown and select Edit Feature . Under Trimming Boundary, click Face / Plane and select the face as shown. Click
	.

	Editing the Type of Structural Member
	15 Edit feature.
	Right-click the face of the structural member shown and select Edit Feature .
	Click FSAE, Type Square Tubes and Size 25mm Sides. Click .


	Using Locate Profile
	16 Find the parents.
	Right-click a face of the structural member as shown and select Parent/Child. The Parents and Children of the feature are listed. Click Close.
	17 Show sketch.
	Right-click the Lower_Frame_sketch in the dialog and select Show.
	18 New sketch.
	Right-click the top face of the structural member and select Sketch .
	19 Convert.
	Click Convert Entities and select the centerline of the visible sketch.
	Drag the endpoints outside the structural members and exit the sketch.
	Add relations to span the full width as shown.
	Close the sketch.
	20 Locate profile.
	Click Insert, Weldments, Structural Member and the following options: FSAE, Type Square Tubes and Size 25mm Sides. Select the line and click Locate Profile. Click the point at the lower center position on the profile and click .
	21 Measure.
	Click Tools, Evaluate, Measure and select the two faces shown.
	Repeat the measurement on the opposite side to ensure that the structural member is centered.
	22 Save.
	Save the part and close it. Return to the assembly and click Yes to rebuild the assembly.

	Using Instant 3D
	23 Change dimensions.
	Click Instant 3D and double-click the feature shown. Right-click the Frame part and select Edit Part . Double-click the feature and drag the handles on the dimensions to resize them to the values 80mm and 300mm as shown.
	Double-click the feature and change the dimensions to resize them to 350mm and 530mm as shown.

	Checking Clearances
	24 Edit the Assembly.
	Click confirmation corner to edit the assembly.
	25 Clearance.
	Click Tools, Evaluate, Clearance Verification .
	Click Selected Items and select the Sprocket and Frame.
	Type 0mm in Minimum Acceptable Clearance and click Calculate. The clearance is close to 18mm. Click
	.
	Fully Defining a Component
	26 Open the ENGINE.
	Right-click the ENGINE component and select Open Part .
	27 Add new plane.
	Click View, Hide/Show, Temporary Axes. Add a Parallel plane between the selected face and the temporary axis through the hole as shown.

	Filtering the FeatureManager Design Tree
	28 Filter.
	Return to the assembly. Click in the filter at the top of the
	FeatureManager design tree and type engine.
	Right-click Engine1_sketch and select Show.
	Click “x” to stop the filter.
	29 Mate.
	Add a Coincident mate between the plane and the line in the sketch.


	Interference Detection
	30 Interferences.
	Click Tools, Evaluate, Interference Detection .
	By default, the entire assembly is selected for interference detection, so right-click in the Selected Components field and select Clear Selections.
	Select the ENGINE and Frame components and click Calculate.
	A total of four interferences are found combined into two symmetrical sets. Click .
	31 Edit sketch.
	Click in the filter at the top of the FeatureManager design tree and as before type engine. Right-click the under defined (-) Engine_Mount and select Edit Sketch . Click “x” to stop the filter.
	32 Drag.
	Drag the open endpoint short of the ENGINE component.
	33 Dimension.
	Add a 5mm dimension between the edge of the ENGINE and the endpoint as shown.
	34 Edit assembly.
	Click Edit Component to exit the sketch and return to edit assembly mode.


	Mounting Plates
	Creating a Reusable Sketch
	1 New part.
	Open a new part with units mm. Create a new sketch on the Front plane.
	2 Geometry and dimensions.
	Create the geometry and dimensions using these guidelines:
	1 Create a centerline from the origin on a slight angle.
	2 Offset the centerline with the bi-directional option (add dimensions off) to create the sides.
	3 Add a tangent arc to close the upper end.
	4 Add a line between endpoints to close the lower end.
	5 Add a circle.
	6 Add dimensions.

	3 Drag.
	Drag the lower corner endpoint. The under defined sketch should rotate but maintain the shape.
	4 Save.
	Save the part as TAB_Sketch.
	Exit the sketch but do not close the part.
	5 Copy sketch.
	Select the Sketch1 feature in the FeatureManager design tree
	and Edit, Copy.

	Pasting the Sketch
	6 Edit part.
	Return to the assembly, right-click the Frame part and select Edit Part .
	7 Paste.
	Select the face of the structural member as indicated. Click Edit, Paste.
	8 Edit sketch.
	Right-click an edge of the sketch and select Edit Sketch .
	9 Temporary axes.
	Show the temporary axes by clicking View, Hide/Show, Temporary Axes. Select the centerline and the temporary axis and add a Parallel relation.
	10 Concentric.
	Select the circular edge and the circle and add a Concentric relation.
	11 Extrude.
	Extrude the sketch 3mm as shown.
	12 Repeat procedure.
	Select the bottom face and create a new sketch. Convert edges from the previous body to create the sketch and extrude the sketch 3mm as in the previous step.
	Repeat for the remaining tabs on the same side and mirror.
	13 Paste sketch.
	Show Engine1_sketch. Select the face, click Edit, Paste and edit the sketch. Add a Concentric relation between the arc and circular edge as shown.
	14 Point.
	Add a point on the centerline. Add a Coincident relation between the centerline and the point. Use the point to add a Pierce relation between the point and the inactive sketch line.
	15 Trim and extrude.
	Create the front edge of the structural member using Convert Entity. Trim the geometry leaving the centerline and point intact as shown.
	Extrude the sketch 3mm.
	16 Plane.
	Click Insert, Reference Geometry, Plane, select the faces and click Mid Plane. Rename the plane Centered.
	17 Mirror.
	Mirror the body using the in-context plane.



	Weldment Cut Lists
	18 Updating the folder.
	Open the part Frame. Right-click the Cut list folder and select Update to group similar structural members in folders.
	Cut List Properties
	Save as External File
	19 Edit the Assembly.
	Return to the assembly.
	Click confirmation corner to edit the assembly.
	20 Save external.
	Right-click the virtual part and select Save Part (in External File). Click Same As Assembly and OK.
	21 Save and close all files.



	4
	Lesson 4: Using Molds and Surfaces
	Molds and Surfaces
	1 Open assembly.
	Open the assembly Intake Assembly from the Mold folder.
	2 Open assembly.
	Open the assembly Frame&Suspension from the Lesson 3\Frame&Suspension folder. This is the assembly used in the previous lesson.
	Add the Intake Assembly assembly to the main assembly. Mate the sub-assembly using one concentric and two coincident mates.
	3 Open runner.
	Right-click one of the instances of the part runner and select Open Part .
	The runner part
	Features in the Part
	Anatomy of a Loft
	Profiles
	Guides

	Creating Mold Tooling
	Surface and Solid Bodies
	Description of the Bodies
	Mold Tools
	4 Configuration.
	Create a new configuration, Mold, to hold all the mold features. Make sure that Suppress features under Advanced Options is checked. The new features will be suppressed in the Default configuration.
	5 Add the Mold Tools Tab.
	Right-click an existing tab on the CommandManager and click Mold Tools. The Mold Tools tab is now displayed on the CommandManager.
	6 Draft analysis.
	Click Draft Analysis from the Mold Tools tab in the CommandManager and select the Right plane. Set the Draft Angle to 1deg and click .

	What Does This Mean?
	7 Display off.
	Click Draft Analysis .
	8 Undercut Analysis.
	Click Undercut Analysis and select the Right plane. Click . This confirms that the mold should be created in two pieces.
	9 Split line.
	Click Split Line and click Intersection. Select Right plane and the faces that intersect that plane. Click .
	10 Parting line.
	Click Parting Lines , Select Right plane and set the Draft Angle to 1deg.
	Click Draft Analysis.
	11 Edge selections.
	Select the starting edge as shown. n
	Click Select Next Edge (or type “n”) and then Add Selected Edge (or type “y”).
	Continue the selections using the selection tools.
	Continue selecting edges to complete the loop of selections as shown. Click .
	12 Parting surface.
	Click Parting Surfaces and select Perpendicular to pull. Set the Distance to 30mm and click Knit all surfaces. Click Sharp and click .

	Using Surfaces
	13 Extend edges.
	Click Extend Surface and select three edges as shown. Click Distance, set the value to 30mm and click .
	Repeat the process for five edges on the opposite end.
	14 Planes.
	Create planes offset 170mm from the Front and 60mm from the Top as shown.
	15 Trim.
	Click Trim Surface and select Standard. Select the Plane3, Keep selections and select inside the plane. Click . Repeat the process for the opposite end.
	16 Sketches.
	Click the parting surface and select Sketch . Using converted entities and lines, create the two sketches as shown. Exit both sketches.
	17 Planar surfaces.
	Click Planar Surface and select a sketch. Press Enter to repeat the command and repeat the procedure for the other planar surface.
	18 Knit surface.
	Click Knit Surface and select the three surfaces. Click Merge entities and click .
	19 Drag and drop.
	Drag and drop the Surface-Knit1 body into the Parting Surface Bodies folder as shown.
	20 Tooling split sketch.
	Click Mold Tools > Tooling Split and select the knitted surface as the sketch plane. Create the sketch and dimensions as shown.
	21 Tooling split sizing.
	Exit the sketch. Set the Depth In Direction1 and Depth In Direction2 to 50mm as shown. Click .
	22 Test measurements.
	Right-click the first (Parting Line1) solid body in the Solid Bodies folder and select Isolate. Click Tools, Evaluate, Measure and measure the distance between endpoints as shown. The key dimension is Dist 56.45mm as shown.
	23 Exit isolate.
	Click Exit Isolate on the Isolate dialog.
	24 Isolate cavity solid.
	Right-click the third solid body in the Solid Bodies folder and select Isolate. The key dimension is the again Dist 56.45mm as shown.



	Making Use of Symmetry
	25 Stock feature.
	Right-click the cavity surface body in the Surface Bodies folder of the FeatureManager design tree and click Insert into New Part. Use the name runner- Cav_1. A stock feature Stock-runner-1 is created.
	26 Mirror part.
	Select the back face of runner-Cav_1 as illustrated. Click Insert, Mirror Part... Click . Save the part as runner- Cav_2.
	27 Holes.
	Return to the runner-Cav_1 part. Select the outer face and click Insert, Features, Hole Wizard . Add 10mm through all holes placed as shown. Click .
	28 New assembly.
	Create a new assembly and add the runner-Cav_1 and runner-Cav_2 parts. The holes have been transferred to these parts using the external references.
	29 Save and close all files.


	Lesson 5: Brake Rotor Analysis
	Brake Rotor Design
	1 Open Brake Rotor Assembly.
	Click File, Open and select the assembly Brake Rotor Assembly. Click Open to open the assembly.
	Activate the configuration called Split Line. It contains the model with necessary changes so that we can run the analysis properly.
	2 Start SolidWorks Simulation.
	Click Tools, Add-Ins. Select SolidWorks Simulation.
	Click OK.
	SolidWorks Simulation Interface
	3 Create a study.
	From the Simulation drop-down menu, select Study.
	Select Thermal as the Type.
	Enter Temperature Distribution as the Name.
	Click .
	The FeatureManager design tree will split and a Simulation study tree will be created below the FeatureManager design tree.
	The setup of the study is done using the Simulation study tree.
	4 Adjust study properties.
	Right-click the study name at the top of the Simulation study tree and select Properties.
	Under Options, select Transient and enter 3 sec as the Total time.
	Click OK.


	Transient Thermal Analysis
	5 Apply material.
	Right-click the Parts folder and select Apply Material to All.
	Select Gray Cast Iron under Iron as the material. Click Apply, then Close.

	Thermal Boundary Conditions
	Convection
	6 Apply thermal load.
	Right-click Thermal Loads in the Simulation Study tree and select Convection.
	Select Select all exposed faces in the Convection PropertyManager. This will choose all of the exposed faces for the convection boundary condition.
	Enter 90 W/m^2.K as the Convection Coefficient.
	Enter 293 Kelvin as the Bulk Ambient Temperature.
	7 Edit Time Curve.
	Click Use Time Curve and select Edit.
	Column X denotes the time and column Y denotes the multiplication factor that will be applied to the convection coefficient that was entered.
	Enter (0, 1) and (3, 1) in the table. This will represent the convection always being turned ON.
	Click OK.
	Click .

	Heat Power
	8 Apply thermal load.
	Right-click Thermal Loads in the Simulation Study tree and select Heat Power.
	Select the four faces of the rotor that the brake pads touch.
	Enter 6660 W as the Heat Power.
	Select Total.
	9 Edit Time Curve.
	Click Use Time Curve and select Edit.
	Column X denotes the time and column Y denotes the multiplication factor that will be applied to the heat power that was entered.
	Enter (0, 1) and (3, 1) in the table. This will represent the heat power always being turned ON.
	Click OK.
	Click .
	10 Initial temperature.
	Right-click Thermal Loads in the Simulation Study tree and select Temperature.
	Select Initial temperature.
	Select the assembly from the fly-out FeatureManager design tree.
	Enter 25 C as the Temperature.
	Click .
	11 Mesh the model.
	Right-click Mesh in the Simulation Study tree and select Create Mesh. Use Curvature based mesh and default element size.
	Click .
	12 Run the study.
	Click Run from the Simulation drop-down menu.


	Post Processing
	13 Plot Temperature distribution.
	Right-click the Thermal1 plot of the temperature distribution and select Edit Definition.
	Change the Units to Celsius.
	Make sure the Plot Step is set as 30.
	Click .
	14 Probe.
	Right-click on the temperature plot in the Result folder and select Probe.
	Select any location on the brake rotor.
	Click the Response button under Report Options.
	A plot of temperature vs. time will appear.
	Click .
	15 Plot Resultant Heat Flux.
	Right-click Results in the Simulation Study tree and select Define Thermal Plot.
	Select HFLUXN: Resultant Heat Flux as the Component.
	Make sure the Plot Step is set as 30.
	Click .
	Static Study
	16 Create a study.
	From the Simulation drop-down menu, select Study.
	Select Static as the Type.
	Enter Thermal Stress as the Name.
	Click .
	17 Apply material.
	Right-click the Parts folder and select Apply Material to All.
	Select Gray Cast Iron under Iron as the material. Click Apply, then Close.
	Temperature Dependent Material Properties

	Fixtures
	18 Apply fixture.
	Right-click Fixtures in the Simulation Study tree and select Fixed Geometry.
	Select the face on the inner diameter of the rotor hub where it would be mounted to a shaft.
	Click .
	19 Apply fixture.
	Right-click Fixtures in the Simulation Study tree and select Roller/Slider.
	Select the split face on one side of the rotor where the fixed brake pad will rub the rotor.
	Click .
	Discussion

	Loading
	20 Apply load.
	Right-click External Loads in the Simulation Study tree and select Pressure.
	Select the split face where the brake pad will push against the rotor.
	Enter 1e6 N/m^2 as the Pressure Value. This value can be known from experiments.
	Click .

	Braking Force
	21 Apply load.
	Right-click External Loads in the Simulation Study tree and select Force.
	Select the two split faces on the rotor where the brake pads make contact.
	Select Selected Direction.
	Select Axis1 of the Rotor Hat part as the reference.
	Select the Circumferential direction and enter 497 N.
	Click .
	Thermal Loading
	22 Adjust study properties.
	Right-click the study name at the top of the Simulation study tree and select Properties.
	Select the Flow/Thermal Effects tab.
	Select Temperatures from thermal study and select Temperature Distribution, Time step 30 as the Thermal study.
	Enter 298 Kelvin as the Reference temperature at zero strain.
	Click OK.
	The Thermal load will appear in the External Loads folder.
	23 Mesh the model.
	Right-click Mesh in the Simulation Study tree and select Create Mesh. Use Curvature based mesh and default element size.
	Click .
	24 Run the study.
	Click Run from the Simulation drop-down menu.



	Post Processing
	25 Plot stress.
	Activate the Stress1 plot by double-clicking it from the Results folder. It is a plot of the von Mises stress in the model.
	Editing Plots
	Chart Options
	Settings
	26 Display model maximum.
	Right-click on the plot and select Chart Options.
	Click Show max annotation.
	Click .
	Discussion
	27 Plot displacement.
	Double-click the Displacement1 plot to show the displacement plot.


	Conclusions
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	Lesson 6: Frame Analysis
	Torsional Rigidity
	Element Types
	Shell Elements
	Beam Elements


	Preparing for Analysis
	1 Open Frame.
	Click File, Open and select the part Frame. Click Open to open the part.
	This is the Frame part that was created in the previous lesson. There are a couple of modifications to the model in order to make it a bit more convenient for meshing.
	2 Add a configuration.
	From the ConfigurationManager, right-click the part and select Add Configuration.
	Type FEA as the Configuration name.
	Click .
	The new configuration will be created and activated in the ConfigurationManager. We can now suppress unwanted features in our part that are unnecessary for our analysis.
	In addition, there may be features to unsuppress that are not part of the final model, but are necessary to the analysis.
	3 Suppress features.
	In the previous lesson, mounting locations were created for the suspension and the engine. In the analysis, these will not have any affect on the torsional stiffness of the vehicle.
	Right-click on the Tabs folder and select Suppress.
	Right-click on the EngineMount folder and select Suppress.

	Experimental Design
	4 Unsuppress features.
	In this model, the suspension has not been included in the analysis. We need a location to apply our torque loading as well as a place to measure the angular displacement for calculating the torsional rigidity. For this, beam members have been create...
	Right-click on the Rigid Support folder and select Unsuppress.
	We are now ready to begin the analysis. Make sure that the SolidWorks Simulation Add-In is active from the Tools, Add-Ins menu.
	5 Create a study.
	From the Simulation drop-down menu, select Study.
	Select Static as the Type.
	Enter Torsional Rigidity as the Name.
	Click .
	Beam Meshing
	6 Examine the Frame folder.
	The Frame folder should contain sub-folders that list all the solid bodies that will be meshed as beams. You can tell that bodies the will be beams because of the beam icon next to the body name.
	Any Solid Bodies that will be meshed as solids should be excluded from the analysis. To do this, right-click the solid body and select Exclude from analysis.
	Section Properties
	End Conditions
	Trusses
	7 Define trusses.
	Select one of the truss members in the graphics window. It should highlight the member in the Frame folder of the Simulation Study tree.
	Right-click the member in the Simulation Study tree and select Edit Definition.
	Select Truss as the Type.
	Repeat this procedure for the seven remaining truss members that mount to the suspension mounting points.
	8 Apply material.
	Right-click the Frame folder and select Apply Material to All Bodies.
	Select Alloy Steel as the material. Click Apply, then Close.

	Joint Group
	9 Edit Joint Group.
	When a beam is defined in SolidWorks Simulation a folder called Joint Group is created in the Simulation Study tree.
	Right-click the Joint Group folder and select Edit.
	10 Examine joints.
	Right-click a joint icon to examine the beams that are connected by the joint.
	To add or remove a beam member from the list, click the beam in the graphics window.
	To save the new joint, simply close the Select Joint Members window.
	11 Edit joint.
	Examine the joints in the rear of the vehicle frame.
	Notice that at one of the rear suspension mounting points, there may be two joints. This location should only have one joint that connects all of the beams.
	Right-click one of the joints and add the omitted beams.
	Right-click the other joint and remove all of the beams. This will delete that joint since it is redundant.
	Click Calculate to recalculate the joints.

	Merging Joints Automatically


	Fixtures
	12 Apply fixtures.
	Right-click Fixtures in the Simulation Study tree and select Fixed Geometry.
	Select the eight joints at the rear of the frame where the suspension would mount.
	Click .
	Loading
	13 Apply loading.
	Right-click External Loads in the Simulation Study tree, and select Force.
	Select Joints under Selection.
	Select the beam joint at the termination of the truss members.
	Select the Front plane as the reference.
	Select Normal to Plane and enter 169.7 N.
	Click .
	Repeat this procedure for the opposite side.
	Make sure that the direction is reversed on the opposite side.
	14 Mesh the model.
	Right-click Mesh in the Simulation Study tree and select Create Mesh.
	The beam mesh will automatically be created.
	15 Run the study.
	Click Run from the Simulation drop-down menu.

	Post Processing
	Cylindrical Coordinates
	16 Probe.
	Right-click the Displacement plot in the Results folder and select Probe.
	Select one of the ends of the trusses where the load is applied.
	We now know the angular deformation of the end of the frame.
	We must divide this by the distance away from the axis to measure the angle.
	Click .

	Torsional Rigidity
	Beam Stresses
	17 Plot stress.
	Activate the Stress1 plot that was created by default by SolidWorks Simulation.
	This is a plot of the highest stress (axial or bending) in each beam element.
	We can view these stress components separately.
	18 Plot axial stress.
	Right-click the Results folder and select Define Stress Plot.
	Select Axial and Automatic.
	Click .
	Notice that some members are in tension and some members are in compression. You can use this information in design change decisions.

	Cross Section Directions 1 and 2
	19 Plot bending stress.
	Right-click the Results folder and select Define Stress Plot.
	Select Upper bound bending in DIR1 and Automatic.
	Click .
	Similarly, the user can plot Torsional, Shear in DIR 1 and Shear in DIR 2 stresses.

	Shear and Bending Diagrams
	20 Plot bending moment.
	Right-click the Results folder and select Define Beam Diagrams.
	Select Moment in Dir1.
	Under Selected Beams, choose Select and select the beam member shown at the front of the frame.
	Click .
	21 List beam forces.
	Right-click on the Results folder and select List Beam Forces.
	Click .
	A list of the forces in each beam element are listed. You can save this list to be used later.
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	Lesson 7: Intake Analysis
	Intake Manifold Design
	Model Preparations
	External Flow Analysis
	Internal Flow Analysis
	1 Open Intake Assembly.
	Click File, Open and select the part Intake Assembly. Click Open to open the part.
	2 Start SolidWorks Flow Simulation.
	Click Tools, Add-Ins. Select SolidWorks Flow Simulation.
	Click OK.

	SolidWorks Flow Simulation Interface
	Lids
	3 Create lids.
	From the Tools drop-down menu, select Flow Simulation, Tools, Create Lids.
	Select the planar faces on the inlet and the four outlet ports that the lid will cover.
	Select Adjust Thickness and enter 1mm as the Thickness.
	Click .

	Check Geometry
	4 Check geometry.
	From the menu choose: Tools, Flow Simulation, Tools, Check Geometry.
	Select Internal under Analysis Type.
	Click Check.
	The tool should calculate a fluid volume correctly and there should be no invalid contacts.
	If invalid contacts exist, you must correct them before beginning the flow simulation project.
	Click Close when you are satisfied.


	Creating the Project
	5 Create a project.
	From the menu, choose: Tools, Flow Simulation, Project, Wizard.
	6 Create new project.
	Under Configuration, click Create new to create a new configuration.
	In the Configuration name box, enter Project 1.
	Click Next.
	7 Select units.
	Select SI (m-kg-s) as the Unit System for this project.
	Click Next.
	8 Select analysis type.
	Select Internal under Analysis Type.
	Click Next.
	9 Select fluid.
	Expand the Gases tree and double-click Air to add it to the Project Fluids list.
	Click Next.
	10 Select wall conditions.
	Accept the default conditions and click Next.
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